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انتي تديع ... يٍ حمهتني وهنا عهى وهٍ ...إلى يٍ جعهت الجنح تحت ألدايها - 

 (سهزج)أيً انغانٍح ...عٍنٍـــــــــها في انهماء فزحا  وانفزاق حشَا 

يٍ أعطى دوٌ يٍّ أو يهم ..انذي ٌزوي تعزله أحلاو انغد...إلى صاحة انمهة انكثير - 

 (عثد الحًٍد)واندي انعشٌش ...يٍ أجم رؤٌتي يتعهًا.

إلى انذٌٍ أحثهى كثيرا وأتدنى لذى دواو انتىفٍك ...إلى نجىو سمائً  وفزحً اندائى - 

هجيرج، أو الخير، ) وسوجاتذى رإخىتً كًال ، سٌاٌ ، أحمدلدين ، ألى ٌد...وانسعــــادج 

( محًد، َىراندٌٍ، أحمد)أخىاتً أرتٍحح، خديجـح، حثٍثح وأسواجهى ...وأولادهى (فتٍحح

 .وأولادهى

انتي ...صاحثح انمهة انفٍّاض.إلى يٍ ٌسكٍ لذا انفؤاد رفٍمح درتً، يهىَح انصعاب- 

 (فتٍحح)سوجتي الحثٍثح ..... أتخطى عهٍه وصىلا َيالييفزشت لي لهثها درتا لأحلاو

 .........فهذج أكثادي وَىر حٍاتً...إلى يٍ ٌعجش نساًَ تعثيرا عٍ حبي لذى- 

 محًد تٍ كٍحىل.د          (أٌىب ، يزوج ، صفا )                                  



 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 مقدمة الكتاب

يعد الإحصاء كتحميؿ المعطيات مف الأدكات الأساسية في البحث العممي، خاصة عند معالجة البيانات 
إف التطكر السريع في تقنيات . الميدانية كتحميميا لتكفير رؤل عممية دقيقة تساعد في اتخاذ القرارات المناسبة

جمع البيانات كتحميميا قد أتاح لمباحثيف الكصكؿ إلى أدكات كتقنيات متقدمة، تجعؿ مف عممية البحث أكثر 
ككاحد مف أقكل البرامج الإحصائية المستخدمة  SPSS كمف بيف ىذه الأدكات، يبرز برنامج. دقة ككفاءة

 .لتحميؿ البيانات، كذلؾ بفضؿ قدراتو المتنكعة كسيكلة استخدامو في معالجة البيانات الكمية

خطكات الجانب الميداني في إنجاز المذكرات أىـ  حكؿ مساعدفي ىذا الكتاب، نسعى إلى تقديـ دليؿ 
مجتمع الدراسة إلى طرؽ اختيار عينة الدراسة الاستطلاعية كالأساسية مع البحثية، بدءنا مف مرحمة تحديد 
 التحقؽ مف الخصائص السيككمترية لأدكات الدراسة كتحميؿ، كصكلان إلى الطرؽ أىـ أنكاع عينات الدراسة 

سيتـ التركيز بشكؿ خاص عمى العمميات الحسابية التي . البيانات باستخداـ الأساليب الإحصائية المناسبة
في إجراء التحميلات  SPSS تدعـ اتخاذ القرارات البحثية الدقيقة، مع تكضيح كيفية استخداـ برنامج

 .الإحصائية المختمفة
يعتبر الجانب الميداني في البحث العممي مف أىـ المراحؿ التي يتطمب فييا الباحث دقة كمكضكعية في 

كلضماف تحقيؽ نتائج مكثكقة، يجب عمى الباحث إتباع خطكات منيجية منظمة . جمع البيانات كتحميميا
تبدأ بتحديد أىداؼ البحث كتصميـ أدكات جمع البيانات مثؿ الاستبيانات، مركران بجمع البيانات مف العينة 

 .المستيدفة، كانتياءن بتحميؿ ىذه البيانات باستخداـ الأدكات الإحصائية المناسبة
ييدؼ ىذا الكتاب إلى تقديـ إرشادات كاضحة كمفصمة حكؿ كيفية تصميـ الدراسة الميدانية كتنفيذىا بطريقة 

سنستعرض الخطكات الأساسية في إعداد الجانب الميداني لممذكرة، مع التركيز عمى كيفية . عممية كمنظمة
سيتـ عرض طرؽ التعامؿ مع البيانات بدءان مف التنظيؼ . معالجة الفرضيات باستخداـ التحميؿ الإحصائي

كالتييئة، كصكلان إلى اختيار الاختبارات الإحصائية المناسبة لكؿ نكع مف البيانات كلطبيعة الفرضيات 
 .المطركحة

، SPSS سنقكـ أيضان بتقديـ شرح مفصؿ لأىـ العمميات الإحصائية التي يمكف إجراؤىا حسابينا كباستخداـ
، كتحميؿ التبايف، كالانحدار الخطي، كغيرىا مف الارتباط كالفركؽمثؿ التحميؿ الكصفي، كالاختبارات 

كما سيتـ تقديـ أمثمة عممية كتطبيقات عمى كيفية . الأساليب التي تساعد في استنتاج النتائج كتفسيرىا
 .، كمعالجة الأخطاء الشائعة، كتفسير المخرجات التي يكفرىا البرنامجSPSS إدخاؿ البيانات في

بفاعمية، مما يساعدىـ في  SPSS كييدؼ الكتاب أيضان إلى تزكيد الباحثيف بالأدكات الضركرية لاستخداـ
سكاء كنت طالبان يسعى لإتماـ . تعزيز فيميـ لمعمميات الإحصائية كتطبيقاتيا في المجالات البحثية المختمفة

مذكرة تخرج أك باحثان يرغب في تعزيز مياراتو الإحصائية، فإف ىذا الكتاب يقدـ لؾ المعرفة كالتكجيو 
 .اللازميف لإجراء التحميلات الميدانية بكفاءة كاحترافية



 

إف الغرض النيائي مف ىذا الكتاب ىك تقديـ مرجع شامؿ كمتكامؿ يمكف أف يعتمد عميو الباحثكف في إجراء 
دراساتيـ الميدانية بفعالية كدقة، كتحميؿ نتائجيـ بأسمكب عممي يساىـ في تقديـ إضافات معرفية ذات قيمة 

نأمؿ أف يككف ىذا الكتاب دليلان مكثكقان لؾ في رحمتؾ . في مجاؿ العمكـ الاجتماعية كغيرىا مف المجالات
 ترافيةالبحثية، كأف يساىـ في تعزيز قدراتؾ عمى تطبيؽ التحميؿ الإحصائي بمينية كاح
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 التعرف عمى مجتمع وعينة الدراسة: المرحمة الأولى
: المجتمع الإحصائي لمدراسة- 1

ذا كاف  مف بيف مراحؿ البحث العممي نجد أنو عمى الباحث تعريؼ المجتمع الإحصائي تعريفا دقيقا، كا 
المجتمع الإحصائي مككنا مف مجمكعة صغيرة مف الأفراد أك العناصر التي يمكف دراستيا كتناكليا جميعا 
بالبحث، عندىا يتـ مسح شامؿ لكافة عناصر المجتمع، كيشار لممجتمع الإحصائي قي ىذه الحالة بأنو 

مجتمع محدكد، كقد يككف المجتمع مككنا مف مجمكعة غير منتيية مف العناصر أك الأفراد، يتعذر لسبب أك 
لآخر إجراء عممية مسح شامؿ، عندىا تقتصر الدراسة عمى عينة مف ذلؾ المجتمع، كيصنؼ عندىا 

: كعميو يمكف التكصؿ إلى ما يمي. المجتمع عمى أنو مجتمع غير محدكد
مجمكعة جميع العناصر أك الأفراد الذيف تتناكليـ الدراسة المتعمقة بالمشكمة التي تـ : المجتمع الإحصائي- أ

. تحديدىا

 (19، ص،2007أبو زينة وآخرون، ).مجمكعة جزئية مف المجتمع الإحصائي: العينة- ب
 :طريقة اختيار عينة الدراسة- 2
: حساب حجم العينة-2-1

دائما ما يقع الباحثكف في إشكالية تحديد حجـ العينة المناسب لدراستيـ، كىناؾ كثير مف العكامؿ التي تؤثر 
. عمى كيفية اختيار عينة تمثؿ المجتمع تمثيلا صحيحا لتحقؽ أىداؼ الدراسة

حجـ المجتمع معمكـ : كمف أجؿ ذلؾ ىناؾ عدة معادلات إحصائية قد تساعدنا في ذلؾ، كىناؾ حالات ىما
. كحجـ المجتمع مجيكؿ

 

 



 

:  حجم العينة معموم2-1-1

ىناؾ عدة معادلات إحصائية كنكتفي بمعادلة كاحدة لأنيا كافية كبينيا كبيف باقي المعادلات اختلافات بسيطة 
: لذلؾ سنختار أشرىا كىي

 Steven.k.thompsonمعادلة ستيفن ثومبسون -أ

 
n : حجـ العينة
N : حجـ المجتمع
P : إذا تعذر الحصكؿ عمى %50تعتمد في الغالب عمى النسبة المتكسطة ) 0.50تمثؿ القيمة الاحتمالية 

 (النسبة الحقيقية لتكفر الخاصية في مجتمع الدراسة
d :تمثؿ نسبة الخطأ المقبكؿ في العينة كىي تساكم   :

 ( كالاجتماعيةالإنسانيةالأكثر استخداما في العمكـ ) 0.05 = %95       إذا كاف مستكل الثقة 
 0.01 = %99إذا كاف مستكل الثقة 

Z :تمثؿ الدرجة المعيارية المقابمة لمستكل الثقة :
 ( كالاجتماعيةالإنسانيةالأكثر استخداما في العمكـ ) 1.96 =%95إذا كاف مستكل الثقة 

 2.58 = %99       إذا كاف مستكل الثقة 
،  %95 كمستكل الثقة 1465إذا كانت لدينا حجـ مجتمع الدراسة يساكم :مثال

                            ما ىك حجـ العينة المناسب ؟ 
  ستيفف ثكمسكفلحساب حجـ العينة المناسب نستخدـ معادلة:الحل

 
 :لدينا
N = 1465 
n =  ؟
P = 0.50 
d = 95 % = 0.05 
Z = 95 % = 1.96كمنو  : 
 



 

 
يجب تقريب القيمة سكاء بالزيادة أك بالنقصاف بناء عمى  ) 305حجـ العينة المناسب ليذا المجتمع ىي 

ذا كاف اكبر مف 0.5قيمة الرقـ بعد الفاصمة إذا أقؿ مف   ( بالزيادة0.5 بالنقصاف كا 

𝒏معادلة ريتشارد جايغر                     - ب =
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𝒏:                          معادلة روبرت ماسون- ت =
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𝒏:                                 معادلة ىربرت أركن- ث =
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𝒏:      معادلة كيرجسي ومورجان- ج =
 𝑿𝟐×𝑵 ×𝒑 𝟏−𝑷 

 𝒅𝟐 𝑵−𝟏  + 𝑿𝟐×𝒑 𝟏−𝑷  
 

 التي تمثؿ القيمة الحرجة لاختبار كام تربيع لدرجة 𝑥2تختمؼ ىذه المعادلة عف باقي المعادلات في قيمة 
 3.84 = % 95إذا كاف مستكل الثقة :  حرية كاحدة حيث

ذا كاف مستكل الثقة   6.64 = % 99                          كا 
، حيث تكصلا Krejcie  & Morganكيمكف أيضا تحديد حجـ العينة باستخداـ جدكؿ كريجسي كمكرجاف*

.  إلى جدكؿ لتحديد حجـ العينة لمجمكعة سكانية معينة لتسييؿ الرجكع إليو1970عاـ 

 

 

 

 

 



 

حجم عينة البحث إذا كان مجتمع البحث متجانسا 
 

 حجم العينة حجم مجتمع البحث حجم العينة حجم مجتمع البحث حجم العينة حجم مجتمع البحث

10 10 220 140 1200 291 
15 14 230 144 1300 297 
20 19 240 148 1400 302 
25 24 250 152 1500 306 
30 28 260 155 1600 310 
35 32 270 159 1700 313 
40 36 280 162 1800 317 
45 40 290 165 1900 320 
50 44 300 169 2000 322 
55 48 320 175 2200 327 
60 52 340 181 2400 331 
65 56 360 186 2600 335 
70 59 380 191 2800 338 
75 63 400 196 3000 341 
80 66 420 201 3500 346 
85 70 440 205 4000 351 
90 73 460 210 4500 354 
95 76 480 214 5000 357 
100 80 500 217 6000 361 
110 86 550 226 7000 364 
120 92 600 234 8000 367 
130 97 650 242 9000 368 
140 103 700 248 10000 370 
150 108 750 254 15000 375 
160 113 800 260 20000 377 
170 118 850 265 30000 379 
180 123 900 269 40000 380 
190 127 950 274 50000 381 
200 132 1000 278 75000 382 
210 136 1100 285 100000 384 

Krejcie,R,V.,&Morgan,D.W.(1970). 

 

 



 

: حجم العينة مجيول- 2-1-2

  :المعادلة الأولى- أ

 

حجـ العينة  = n: حيث 
P =  0.50معامؿ الاختلاؼ بيف مفردات المجتمع كىي تساكم 
d = 0.05= %95إذا كاف مستكل الثقة :تمثؿ نسبة الخطأ المقبكؿ في العينة كىي تساكم 

ذا كاف مستكل الثقة   0.01= %99                                                        كا 
Z = 1.96= %95إذا كاف مستكل الثقة :   تمثؿ الدرجة المعيارية المقابمة لمستكل الثقة 

ذا كاف مستكل الثقة   2.58= %99                                                           كا 
 . %95لدينا مجتمع مجيكؿ كنريد سحب عينة دراسة عند مستكل الثقة :مثال

فما ىك حجـ العينة المناسب ؟ 
 :الحل

 
Z 1.96 = % 95 عند 
D 0.05 = % 95 عند 
P = 0.50نطبؽ المعادلة        : 

 
 فردا 384إذا حجـ العينة المناسب ىك 

: المعادلة الثانٌة- ب

 
n :  تمثؿ حجـ العينة

P :  تمثؿ نسبة تكفر الخاصية في المجتمع المرد دراستو، كالتي يمكف استخراجيا مف الدراسات السابقة أك
 كىك المستعمؿ غالبا لأنو %50غيرىا، كفي حالة عدـ معرفة تمؾ النسبة نستخدـ أكبر نسبة ممكنة كىي 

. مف المفركض تككف الدراسة حديثة

 



 

  لدينا مجتمع مجيكؿ نريد سحب عينة دراسة منو فما ىك حجـ العينة المناسب؟:مثال
 : الحل

 
.  فرد400إذا حجـ العينة المناسب ىك 

: أنواع عينات الدراسة- 3
إف اختيار العينة يجب أف يخضع إلى عدة اعتبارات معينة، مثلا أف يتجرد الاختيار مف التدخؿ الشخصي 

لمقائـ بالتجربة، كأف يككف الاختيار عشكائيا في طبيعتو أم أف لكؿ كحدة مف كحدات المجتمع ليا نفس 
الفرصة في اختيارىا في العينة، كما أنو لا تغالي في صغر عدد أفراد العينة مف أجؿ تكفير الماؿ 

 (158،ص،2000المجيد،  عبد).كالجيد

: (الاحتمالية)العينات العشوائية -3-1
: العينة العشوائية البسيطة-3-1-1

كفييا يختار أفراد العينة بشكؿ عشكائي بحيث يعطي لكؿ فرد في المجتمع نفس الفرصة في الظيكر التي 
: تعطى لغيره عند الاختيار، كىناؾ عدة طرؽ لاختيار العينة العشكائية البسيطة كمنيا

القرعة -  أ
بكضع قائمة في جدكؿ لكؿ أفراد المجتمع الأصمي كلكؿ مرة تقكـ بكضع : طريقة الجداكؿ العشكائية- ب

إصبعنا في مكاف مختمؼ عشكائيا كنبدأ منيا حتى ينتيي العمكد كنكمؿ بالعمكد الذم يميو كىكذا حتى 
. نحصؿ عمى عدد العينة المطمكب

  فرد100 فردا مف مجتمع أصمي قدره 30نريد حسب عينة مف : مثال
نقكـ بكضع قائمة المجتمع في جدكؿ بيذا الشكؿ 

، نبدأ نحسب منو كالانتقاؿ 37فميكف مثلا .. ثـ نقكـ بكضع الإصبع بطريقة عشكائية عمى عدد الأرقاـ
. 66لنصؿ إلى العدد .  المراد سحبو30لمصفكؼ المجاكرة حتى نصؿ لمعدد 



 

- ج
 ذكر اسـ الشخص كنمقي العممة مع تحديد كجو العممة المخصص لمقبكؿ كىذه :طريقة العممة النقدية

 .الطريقة تستخدـ في المجتمعات البحثية الصغيرة
 (2021عبان، العينات العشوائية، ) . مف خلاؿ استخداـ برامج إحصائية معينة:استعمال الحاسوب- د
 :العينة العشوائية المنتظمة- 3-1-2

كفي ىذه الحالة يتـ سحب العينة بعد تقسيـ المجتمع إلى فئات أك كحدات متساكية ثـ نختار أفرادا مف ىذه 
 فيككف أفراد 3الأقساـ عمى أبعاد متساكية منيا فإذا قسمنا المائة مثلا إلى عشرة أقساـ كاخترنا عشكائيا الرقـ 

كيحدد الباحث نسبة العينة كحجميا بعد . الخ....23، 13، 3العينة المنتظمة ىـ الذيف تمثميـ الأرقاـ 
تحديد المجتمع كتسجيمو في قكائـ تحمؿ أرقاما متسمسمة تسيؿ عميو اختيار عينة البحث دكف لبس أك 

 : فإف%5 شخص كنسبة العينة 4000غمكض أك تكرارا، فإذا كاف حجـ المجتمع عمى سبيؿ المثاؿ 
 :حجم العينة

 
 :طول المسافة

 
 مفردة كيككف اختيار المفردة الأكلى عشكائيا مف المجتمع فإذا كقع 20فيككف اختيار مفردة كاحدة مف كؿ 

، 4، أم يتـ اختيار 20 فإف الاختيار يككف كفؽ ثبات طكؿ المسافة المحددة كىي 4الاختيار عمى رقـ 



 

،ص، 2000عبدالمجيد، ).كىكذا إلى أف يتـ استعراض أسماء أك أرقاـ كؿ المجتمع. الخ.....84، 64، 44
162) 

 :العينة العشوائية الطبقية- 3-1-3
 :ىذا النكع العينات العشكائية يتعامؿ مع مجتمع غير متجانس كذلؾ كفؽ الخطكات التالية

 تحديد كتعريؼ المجتمع الأصمي -1
 تحديد حجـ العينة -2
 تحديد الطبقات الفرعية بناء عمى خصائص المجتمع الأصمي -3
 :اختيار عينة عشكائية بسيطة مف كؿ طبقة فرعية كفؽ طريقة التناسب التالية -4

 
:  طالب مكزعيف كالتالي680 مف أجؿ القياـ بدراسة عمة طمبة كمية العمكـ الاجتماعية البالغ عددىـ :مثال
 230طمبة عمـ النفس عددىـ - 

 270طمبة عمـ الاجتماع عددىـ         - 
 180طمبة عمكـ التربية عددىـ         - 

 .% 10 طالبا بنسبة 68تـ تحديد عينة الدراسة الممثمة لممجتمع الأصمي كالتي قدرت ب 
 :نقكـ بتحديد عينة الدراسة في كؿ طبقة باستخداـ طريقة التناسب كتككف كالتالي

 
 : عينة طبقة عمـ النفس- أ

 
 :عينة طبقة عمـ الاجتماع- ب

 
 :عينة طبقة عمكـ التربية- ت

 
 68 = 18 + 27 + 23: إذا حجـ عينة الدراسة ىي

 (2021عبان، العينات العشوائية، )
 



 

 :العينة العشوائية العنقودية- 3-1-4
إف كحدات بعض المجتمعات تككف عمى شكؿ تجمعات، كغالبا ما تككف متشابية إلى حد كبير بالنسبة 

فإف ىذه التجمعات عندىا تسمى عناقيد، إذ . كغيرىا...المدف، الكميات، : لمخاصية التي نقكـ بدراستيا مثؿ
يحكم كؿ عنقد منيا عدد مف عناصر المجتمع الأصمية، كالتي غالبا ما تككف متجانسة، كفي ىذه الحالة 

 :نمجأ إلى العينة العنقكدية التي تنقسـ إلى
 .عينة عنقكدية بمرحمة كاحدة -
 .عينة عنقكدية بمرحمتيف -
 .عينة عنقكدية متعددة المراحؿ -

إذا كاف باحث في أف يجرم دراسة دراستو عمى طمبة احدل الجامعات، كبإتباعو لأسمكب العينة : مثال
العشكائية العنقكدية فإنو سيقسـ الجامعة إلى كميات كالكميات إلى أقساـ كالأقساـ إلى شعب كالشعب إلى 
تخصصات كىكذا، عمى شكؿ عنقكد العنب كفي كؿ مرة سيأخذ عينة بشكؿ عشكائي، ابتداء مف أسفؿ 

 (2021عبان، العينات العشوائية، ) اليرـ الإدارم لمجامعة كىي التخصصات صعكدا إلى الجامعة

 :(الغير احتمالية)العينات الغير العشوائية -3-2
ىذا النكع يعتبر مف أقؿ أنكاع العينات دقة في تعميـ النتائج عكس العينات العشكائية كتبقى النتائج 

 :كمنيا نجد. المتحصؿ عمييا خاصة بالعينة محؿ الدراسة كلا يمكف تعميميا
 : العينة القصدية3-2-1

تستخدـ العينة القصدية في البحكث التي يككف فييا الباحث عمى معرفة بخصائص المجتمع كمدل تكافر 
صفة اك خاصية معينة في مفرداتو المتعمد اختيارىا أم مقصكدة، أم أف اختيار العينة يككف محدكدا عمى 

 .الأفراد الذيف يحممكف نفس الخاصية أك السمة المشتركة بينيـ

اختيار الباحث عينة مف الطمبة المعيديف لمسنة، ىنا تقتصر عمى الطمبة الذيف يشترككف في خاصية : مثال

 . الإعادة فقط فيـ المقصكديف بالدراسة
 : العينة الصدفية3-2-2

كىي العينة التي يتـ فييا اختيار مفردات الدراسة نتيجة لعامؿ الصدفة فقط كليس لأم عامؿ آخر، كالتي 
 .تتصؼ بسيكلة التطبيؽ كلا تتطمب أم إجراء مسبؽ

لقياس اتجاىات الرأم العاـ حكؿ قضية ما نقكـ بسؤاؿ مف نقابمو مصادفة في الشارع كتستخدـ في :مثال
 .البرامج الإعلامية كالتمفزيكنية



 

 :العينة الحصصية- 3-2-3
كعممية الاختيار في كؿ مجمكعة . تتطمب معرفة مسبقة لمجتمع الدراسة مف حيث تككيف المجمكعات داخمو

لا ترتبط بقكاعد معينة كلكف لقناعة الباحث بشرط أف تمثؿ كؿ مجمكعة في العينة حسب تمثيميا في مجتمع 
الدراسة، كتعتبر مف أفضؿ العينات الغير عشكائية لأف الباحث يختار العينة كفقا لخصائص محددة مسبقا 

 .لأفراد المجتمع
ثـ يختار عدد ثابت مف  (ابتدائي، متكسط، ثانكم، جامعي)يحدد الباحث فئات المجتمع المدركس : مثال

 . مف الجامعي10 مف الثانكم، 10 مف المتكسط، 10 مف الابتدائي، 10كؿ فئة، كأف يختار
 :عينة كرة الثمج- 3-2-4

فييا يتعرؼ الباحث عمى فرد مف المجتمع الأصمي يقكده لأفراد آخريف كىكذا يتسع نطاؽ معرفة الباحث 
 .بيذا المجتمع، كتسمى بالعينة المتضاعفة

يريد الباحث دراسة مجتمع المدمنيف في مدينة ما، فيقكـ بالتعرؼ عمى أحدىـ كتككيف علاقة معو : مثل
 .فسكؼ يقكده إلى مجمكعة مف الزملاء المدمنيف

  بعد تحديد نوع وحجم عينة الدراسة من المجتمع الكمي يجب أن نسحب منيا عينة
 .الدراسة الاستطلاعية

 الدراسة الاستطلاعية: المرحمة الثانية
بعد التعرؼ عمى مجتمع الدراسة كاختيار عينة الدراسة كنكعيا يتـ اختيار عينة مف أخرل كىي عينة 

 .الدراسة الاستطلاعية كالتي تستخدـ بغرض التأكد مف الخصائص السيككمترية لأداة الدراسة
 :الدراسة الاستطلاعية- 1

 وىناك نوعان من الدراسة الاستطلاعية ىما
كفييا يقكـ الباحث بزيارات إلى مختمؼ المكتبات، بغية إلقاء نظرة : الدراسة الاستطلاعية النظرية- أ

 .عمى المراجع الخاصة ببحثو النظرم، أك الخاصة ببعض المحاكر النظرية في بحثو

يقكـ فييا الباحث بتنظيـ زيارات إلى ميداف الدراسة، للاطلاع : الدراسة الاستطلاعية الميدانية- ب
 .عمى ميداف دراستو، إف كاف بحثو كمو ميداني

 .أك أف يطمع عمى الجانب الميداني الذم يخص بعض محاكر دراستو الميدانية
لأف لمدراسة الاستطلاعية الميدانية دكرا ىاما في تحديد كضبط عنكاف البحث، كما ليا دكرا في تحديد عينة 

  (19،ص، 2012زرواتي، ).البحث كضبطيا، كأيضا في تحديد منيج الدراسة كأدكات البحث



 

تقكـ الدراسة الاستطلاعية عمى مجتمع الدراسة بغرض تحديد المنيج المناسب لمدراسة كنكع المعاينة، كما 
تسمح لنا بالتعرؼ عمى الظركؼ التي سيتـ فييا إجراء البحث ككذا الصعكبات التي ربما تكاجينا في 

التطبيؽ النيائي لأدكات البحث عمى العينة، كيجب التأكد مف استعداد أفراد العينة كرضاىـ عمى الإجراءات 
الخاصة التي ستتبع معيـ في البحث، كما يتـ فييا بناء أدكات البحث إف لـ تكف متكفرة، كالتأكد مف 

أف عمى الباحث أف يكضح لأفراد العينة أىداؼ الدراسة  (2003)خصائصيا السيككمترية، كقد ذكر منسي
. (40،، ص2016غريب، ).لكي يساعدكه في تحقيقيا

 :  أىداف الدارسة الاستطلاعية- 2
 .بناء أدكات البحث التي تقيس متغيرات الدراسة - 
 . (الصدؽ، الثبات)التحقؽ مف الخصائص السيككمترية لممقاييس - 
صياغة البنكد،مستكيات الإجابة، ظركؼ ):  لمختمؼ جكانب مقياس كىيأفراد العينةالتأكد مف فيـ - 

بالإضافة إلى فيميـ لأىداؼ الدراسة كاستعدادىـ كرضاىـ عف إجراءات  (....التطبيؽ، طريقة التطبيؽ،
 .التطبيؽ

 . في الإجابة عمى عبارات المقياسأفراد العينةتحديد الفترة الزمنية التي يستغرقيا - 
التعرؼ عمى الظركؼ الملائمة التي سيتـ فييا إجراء البحث كالزماف كالمكاف المناسبيف لمتطبيؽ كطريقة - 

 كالتأكد مف كضكح لغة المقاييس (فردية أك جماعية )التطبيؽ 
 .التعرؼ عمى خصائص مجتمع الدراسة الأصمي- 
 .(41،، ص2016غريب، ) ..تحديد حجـ الدراسة الأساسية- 
 :عينة الدراسة الاستطلاعية- 3

يتـ اختيار عينة ممثمة لمدراسة الأساسية بطريقة عشكائية تسمى عينة الدراسة الاستطلاعية، كمف الأحسف 
كفي بعض البحكث . ، كيتـ إقصاء ىذه العينة المختارة مف عينة الدراسة الأساسية30تككف أكبر أك تساكم 

 . إذا كانت حجـ عينة الدراسة الأساسية كبير% 10يتـ اعتماد نسبة 
 
 
 
 
 
 



 

 Spssتوزيع وتفريغ الاستبيان في : المرحمة الثالثة
:  الاستبيان توزيع- 1

 نقكـ بتكزيع الاستبياف عمى عينة الدراسة الاستطلاعية بيدؼ التأكد مف صلاحيتو لمدراسة
: ليكف لدينا نمكذج الاستبياف التالي

: (البيانات الشخصية)خصائص العينة : المحور الأول
 (  )أنثى ،   (  )ذكر: الجنس - 
:................ السن- 
 (  )، جامعي (  )ثانوي ، (  )متوسط ، (  )ابتدائي ، (  )بدون مستوى : المستوى الدراسي - 
. ( ) سنة 15أكثر من ،  (  ) سنة 15 إلى 05من ، (  ) سنوات 5أقل من : الخبرة المينية - 

استبيان الثقافة التنظيمية - 1
 نادرا أحيانا دائما العبارات الرقـ الأبعاد

ماء
لانت
ـ ا
قي

 

    تسكد الثقة المتبادلة بيف الإدارة كالمكظفيف 01
    تسكد الثقة المتبادلة بيف المكظفيف فيما بينيـ 02
    تعمؿ إدارة المؤسسة عمى تييئة جك الرضا بيف المكظفيف 03
    مشتركة (لغة)أتخاطب مع زملائي في أمكر العمؿ بمفردات  04
    أشعر أف المؤسسة تركز عمى الجانب الإنساني 05
    غالبا ما يسمح لنا بالمشاركة في اتخاذ بعض القرارات 06
    يتناقؿ المكظفكف الحكايات كالركايات المشتركة حكؿ العمؿ 07
    أعتقد أف المكظفيف يتقيدكف بالمكائح كالنظـ الإدارية السائدة 08

كف
تعا
ـ ال

قي
 

    المساكاة ىي الأساس الذم تتعامؿ بو الإدارة العميا مع كؿ المكظفيف 09
    يسكد دكراف العمؿ في المؤسسة 10
    أفضؿ إنجاز العمؿ في حينو كعدـ تأجيمو 11
    أحترـ مكاعيد العمؿ 12
    بيف المكظفيف (المساكاة)تؤكد المؤسسة عمى العدالة  13

رية 
الح
يـ 
ق

    أعتقد أنو يكجد قدر كبير مف الثقة بيف المكظفيف 14
    أشعر بأىمية العمؿ الذم أقكـ بو 15
    أشعر أف عممي يمنحني مكانة اجتماعية 16
    أشعر أف المكظفيف يعاممكف بالمساكاة 17
    (العمؿ الجماعي)تشجع المؤسسة العمؿ بركح الفريؽ  18
    أعتقد أف العمؿ الجماعي سمة مميزة في عممنا 19

دالة
 الع

قيـ
 

    أحيانا يكمؼ المكظفكف في كحدة معينة بإنجاز أعماؿ تخص كحدات أخرل 20

    أعتقد أف ىناؾ تباعدا بيف المكظفيف 21

    أعتقد أف تحسيف كفاءة الأقساـ كالكحدات التنظيمية يتطمب مشاركة جميع الأعضاء 22

يتطمب مشاركة   (مختمؼ المكاتب)أعتقد أف ىناؾ تنسيؽ بيف الكحدات التنظيمية 23
 جميع الأعضاء

   

    أحاكؿ عدـ التأخر عف مكاعيد العمؿ 24



 

. ىذا الاستبياف يتككف مف جزأيف ىما 
ىذه ). يتعمؽ بخصائص العينة كىي الجنس، السف، المستكل الدراسي، كالخبرة المينية:الجزء الأول 

 (الخصائص تستخدم دائما لصياغة فرضيات الفروق
الثقافة )تمثؿ المتغير الأكؿ مف الدراسة  (البنكد)(العبارات)عبارة عف مجمكعة مف الأسئمة : الجزء الثاني
، باختيار بديؿ كاحد مف (دائما، أحيانا، نادرا)، يتـ الإجابة عمييا كفؽ طريقة ليكارت الثلاثي (التنظيمية

مككنة لممتغير الكمي  (محاكر) سؤاؿ مقسمة إلى أربعة أبعاد 24بدائؿ الإجابة، كيتككف ىذا الاستبياف مف 
: كىي كالتالي (الثقافة التنظيمية)

  08 إلى 01 تمثمو الأسئمة مف قيم الانتماء كىك بعد :01البعد 
  13 إلى 09 تمثمو الأسئمة مف قيم التعاون كىك بعد :02البعد 
  19 إلى 14 تمثمو الأسئمة مف قيم الحرية كىك بعد :03البعد 
  24 إلى 20 تمثمو الأسئمة مف قيم العدالة كىك بعد :04البعد 

ىذه الأبعاد تستخدـ عادة في صياغة الفرضيات الجزئية لممتغير كربطيا بالمتغير الثاني لأف درجاتيا 
 . مككنة أيضا لمدرجة لمكمية للاستبياف

 أحد البرامج الإحصائية التي لاقت شيكعان في استخداميا مف قبؿ SPSSيعتبر برنامج التحميؿ الإحصائي 
الباحثيف لقياـ بالتحميلات الإحصائية، كيستخدـ البرنامج في كثير مف المجالات العممية كالتي تشمؿ عمى 

ىي اختصار لممسمى الكامؿ   SPSSككممة .  سبيؿ المثاؿ، العمكـ الإدارية كالاجتماعية كاليندسية كالزراعية
 :لبرنامج كىي

Statistical Package for Social Sciences" "
 ".وم الاجتماعيةلالبرنامج الإحصائي لمع" كالتي تعني

 :Spssتشغيل برنامج - 2
يمكف تشغيؿ برنامج بكاسطة النقر المزدكج عمى أيقكنة البرنامج كالتي تظير عمى سطح المكتب أك عند 

   .طريؽ النقر المفرد عمى أيقكنة البرنامج مف قائمة البرامج المتكفرة عمى جياز الحاسب الآلي
:  نتبع الخطكات التالية Spssكلتفريغ ىذا الاستبياف في برنامج 

نقكـ في البداية بفتح البرنامج بالشكؿ التالي  



 

 

 
 في سطح المكتب أك في قائمة ابدأ نجد رمز البرنامج نقكـ بالضغط عميو مرتيف فتظير الشاشة الثانية :01
: بعد ظيكر شاشة البداية المكضحة في الشكؿ، نجد فييا عدة خيارات أىميا ما يمي.

 New Detasetذا أردنا فتح ممؼ جديد نضغط عمى خيار إ: 02
 كنختار اسـ الممؼ Recent Filesأما إذا أردنا فتح ممؼ قديـ تـ حفظو مسبقا نذىب إلى خانة : 03

. المحفكظ سابقا
.  لممكافقة كالتأكيد عمى الخيار السابؽOKثـ نضغط عمى : 04

 Spssعند اختيار ممف جديد تظير لنا الصفحة التالية وىي واجية برنامج                    

 

04 



 

 :تظير نوافذ البرنامج الذي يتكون من  
    Spssالمكتكب فيو شريط العنوان - 

  Help  كنياية بػ  File بداية مف (الأوامر)شريط القوائم - 

  Abc  كحتى   Open بداية مف شريط الأدوات- 

                                                                     (صفحة البيانات)  Data View: كفي الأسفؿ نجد الصفحتيف الرئيسيتيف -

 .(صفحة المتغيرات)  Variable Viewك                                                   

   (Data View)البيانات  (صفحة)عارض : الورقة الأولى

كتخدـ ىذه الكرقة ميمة إدخاؿ كتعديؿ كعرض البيانات لمباحث، كتمثؿ الأعمدة المتغيرات في حيف تمثؿ 
 . الصفكؼ الحالات محؿ الدراسة، كبذلؾ تمثؿ كؿ خمية مشاىدة المتغير لمحالة المقابمة

   (Variable View)المتغيرات  (صفحة)عارض : الورقة الثانية 

 كتخدـ ىذه الكرقة كظيفة التحكـ بخصائص المتغيرات، كالتي سنتطرؽ ليا بالتفصيؿ لاحقان  

 Outputعارض النتائج كيكجد كذلؾ شاشة أخرل لإظيار نتائج التحميؿ الإحصائي كتسمى  * 

Viewer إلا أف ىذه الكرقة لا تظير مباشرة عند تشغيؿ البرنامج كلكف تظير مباشرة عند طمب النتائج ،
 لأم عممية إحصائية  

   

  SPSSالقوائم الرئيسة لبرنامج - 3
 : (الأوامر)شريط القوائم - أ 

تعتمد جميع البرامج التي تعمؿ تحت نظاـ كيندكز عمى مجمكعة مف القكائـ كالتي يمكف مف خلاليا القياـ 
:   قكائـ رئيسية كىي10 عمى  SPSSكيحتكم في برنامج .  بجميع العمميات المطمكبة مف البرنامج



 

 
  

   File Menu قائمة الممف .1

إف اليدؼ الرئيس مف قائمة الممؼ ىك التحكـ بالممفات، كذلؾ عف طريؽ إنشاء ممؼ أك فتح ممؼ أك 
كذلؾ فإف قامة الممؼ تعرض قائمة بآخر الممفات التي تـ .  عرض معمكمات عف ممؼ أك طباعة ممؼ

 . استخداميا 
   Edit menu قائمة التحرير .2

كتستخدـ ىذه  القائمة لعمميات التعديؿ في البيانات مثؿ عمميات النسخ كالقص كالمصؽ كعمميات البحث 
 .عف متغيرات  

   View Menu قائمة العرض .3

خفاء شريط الأدكات كخطكط الشبكة في شاشة محرر  يمكف باستخداـ قائمة عرض الأدكات عرض  كا 
 . البيانات، كذلؾ يمكف تعديؿ الخطكط المستخدمة في البرنامج

   Data Menu قائمة البيانات .4

تحتكم قائمة البيانات عمى العديد مف الأدكات الميمة كالتي تستخدـ لتحديد المتغيرات كقيميا كترتيب 
 . المتغيرات كعمميات دمج كفصؿ الممفات 

  Transform Menu قائمة التحويل .5

تحتكم قائمة تحكيؿ البيانات عمى العديد مف الأكامر التي تستخدـ لعمميات التعديؿ في قيـ المتغيرات مثؿ 
عادة ترميز المتغيرات كعمميات إنشاء قيـ عشكائية  . حساب قيـ جديدة لممتغيرات كا 

 Analyze Menu  قائمة التحميل  .6

 كتعتبر قائمة التحميؿ أىـ قائمة لاحتكائيا عمى العديد مف الأكامر لتنفيذ التحميلات الإحصائية المختمفة  

   Graphs Menuقائمة الرسومات  .7

كتشمؿ قائمة الرسكمات عمى العديد مف الأكامر لتمثيؿ البيانات بيانيان، كالتي تعرض البيانات بعدة طرائؽ 
 . لتلائـ التحميؿ المطمكب

 Utilities Menu قائمة الخدمات .8

كتستخدـ قائمة الخدمات لمعرفة بعض المعمكمات عف المتغيرات كالممفات ككذلؾ تحديد مجمكعات جزئية 
 .  مف المتغيرات



 

 Windows Menu قائمة النوافذ  المساعدة  .9

 . كتستخدـ قائمة النكافذ للإبداؿ مف نافذة إلى أخرل أك تصغير النكافذ

 Help Menu قائمة المساعدة. 10

 .كتستخدـ قائمة المساعدة تكفر خدمة عرض المساعدة المحظية لممستخدـ

   Toolbarشريط الأدوات - ب 

يكفر شريط الأدكات مجمكعة مف الأيقكنات كالتي يمثؿ كؿ كاحد منيا أحد الأكامر مف إحدل القكائـ 
 . المذككرة سابقان، فعند النقر عمى إحدل الأيقكنات، ينفذ الأمر المرتبط بيذه الأيقكنة

 

كبالإشارة باستخداـ الفأرة عمى إحدل الأيقكنات، يمكف التعرؼ عمى العممية المرتبطة بيا، فعمى سبيؿ  
. المثاؿ عند الإشارة عمى أيقكنة فتح ممؼ، تظير التعميمات المرتبطة بالأيقكنة  

  
 الرمز  الميمة  الرمز  الميمة 

 البحث 
  

 فتح الممفات 
  

  (حالة جديدة)إضافة صؼ 
  

 الحفظ 
  

  (متغير جديد)إضافة عمكد 
  

 الطباعة 
  

 لتقسيـ كتجزئة ممؼ 
  

 إجراء تـ استخدامو  23استدعاء آخر 
  

 لتحديد أكزاف الحالات 
  

 تراجع عف آخر تغيير 
  

 لاختيار حالات 
  

جراء التغيير   تقدـ كا 
  

 إظيار معنى الأرقاـ المرمزة 
  

 (الصؼ)الذىاب إلى الحالة 
  

 لاختيار متغيرات معينة كالعمؿ عمييا 
  

  (العمكد)الذىاب إلى المتغير 
  

 إظيار كؿ المتغيرات 
  

 قائمة المتغيرات كالمعمكمات عنيا 
  

 إحصاءات سريعة    التدقيؽ الإملائي 
 



 

 Creating a new SPSS data file   إنشاء ممف بيانات جديد  - 4
تتـ عممية إدخاؿ البيانات بطريقة مشابية لإدخاؿ البيانات في برامج الجداكؿ الإلكتركنية أك في جداكؿ 

كيمكف إدخاؿ البيانات داخؿ أم خمية كذلؾ بالنقر عمى الخمية المناسبة ثـ . في برامج معالجة النصكص
كعند الرغبة في تعديؿ البيانات، يتـ تحديد الخمية المراد تعديؿ البيانات فييا ثـ . كتابة البيانات المطمكبة

، يتـ الانتقاؿ إلى Data Viewكلكف قبؿ إدخاؿ قيـ البيانات في كرقة .  كتابة التعديلات المطمكبة
.   عف طريؽ نقر عمى قابض الكرقة كذلؾ لتعريؼ خصائص المتغيرات Variable Viewكرقة

  بحيث يحدد كؿ عمكد إحدل خصائص المتغيرات أعمدة10 عمى Variable Viewورقة  كتشمؿ 

 

  : Variable Nameاسم المتغير : (1 

 
، كىك العمكد المخصص لكتابة Nameعمى العنكاف  Variable Viewيحمؿ العمكد  الأكؿ مف كرقة 

. أسماء المتغيرات
  :NAMEشروط كتابة اسم المتغير في خانة  

 حرفا، ككذا عدـ تكرار الاسـ في متغيرات أخرل، مع عدـ 75مف الميـ ألا يزيد اسـ المتغير عمى 
;، ككذا عدة الأسماء أك " ، ;، ككذا علامات الترقيـ مثؿ%*; #استخداـ الأقكاس أك الرمكز، مثؿ
 .OR ،WITH ،NOT ،AND ،NEW…;  مثؿSPSSالاختصارات المتعمقة ببرنامج 

 كبشرط أف يبدأ بحرؼ كأف لا يزيد طكؿ الاسـ عف ثمانية رمكز، كاف لا ينتيي بنقطة أك فاصمة، 
.  كأف لا يبدأ برقـ

   Variable Typeنوع المتغير : (2

، كيستخدـ ىذا العمكد لتحديد ما إذا كاف المتغير عددم أك غير Typeيحمؿ العمكد الثاني العنكاف 
 عددم 



 

 .   Data Viewككذلؾ طريقة عرض المتغيرات العددية في كرقة

 
 ;  في العمكد الثاني، يظير لنا صندكؽ الحكار التالي

 
كيمكف مف خلاؿ صندكؽ الحكار تحديد نكع المتغير إف كاف متغير عددم أك متغير يعبر عف التاريخ أك 

 .  الكقت أك متغير يمثؿ قيمة نقدية أك متغير رمزم 

  :  width عرض المتغير : (3

 
يستخدـ العمكد الثالث لتحديد عدد الخانات المستخدمة لعرض قيمة المتغير، كيمكف تحديد عرض 

المتغير بكاسطة صندكؽ الحكار السابؽ أك بالنقر عمى الأسيـ في الخمية المقابمة لممتغير في العمكد 
 الثالث   

  : Decimalsعدد الخانات العشرية  (4

 



 

يستخدـ العمكد الرابع لتحديد عدد الخانات العشرية المخصصة لمعدد العشرم في المتغيرات العددية 
، كيمكف زيادة أك إنقاص المراتب العشرية بكاسطة الأسيـ إلى الأعمى (تحديد عدد الأرقاـ بعد الفاصمة)

لى الأسفؿ  .    كا 

   Variable Labelوصف المتغير  (5

 
الخبرة المينية في : يستخدـ ىذا العمكد لكصؼ المتغير، فعمى سبيؿ المثاؿ فإنو يمكف استخداـ العبارة

 ، كيظير تأثير الكصؼ في مخرجات 256، كيمكف أف تصؿ عدد الرمكز إلى الخبرة  لكصؼ مكان العمل
 . SPSSبرنامج 

   Value Labelsوصف القيمة  (6

تبرز الحاجة لكصؼ القيـ المحدد في البيانات عندما يككف المتغير العددم متغير كصفي بعبارة تكضح 
، مثلا في الاستبياف المرفؽ SPSSمعنى ىذه القيـ كالتي تظير بدلان مف القيمة نفسيا في مخرجات برنامج 

 :نجد
 .أنثى " 2"كذكر  " 1" القيمة :الجنس 

 

 ذكر كاكتب label ثـ انقر المستطيؿ المجاكر لكممة 1 كاكتب الرقـ valueانقر المستطيؿ المجاكر لكممة 
 عند الانتياء OK لإضافة العنكاف، ثـ كرر العممية لجميع القيـ، كمف ثـ اضغط عمى  addثـ انقر الزر 
 . مف جميع القيـ



 

   Missing Valuesالقيم المفقودة : (7

أم أف ىذه القيـ مكجكدة أصلان كلكننا لا )عند رغبة الباحث في تحديد بعض القيـ عمى أنيا قيـ مفقكدة 
، فإنو يمكف استخداـ مربع الحكار التالي (نرغب إدخاليا في التحميؿ الإحصائي لأم سبب مف الأسباب

 .  Missingكالذم يظير عند النقر عمى الخمية التي تقع في العمكد الذم يحمؿ العنكاف 

 

كعندما تككف قيـ المتغير مفقكدة أصلان نتيجة لعدـ كجكد مشاىدات في البيانات، ففي ىذه الحالة فإف 

 .الخلايا تككف فارغة كتحكؿ تمقائيان إلى قيـ مفقكدة

  Column Widthعرض العمود : (8

 

يمثؿ عرض العمكد عدد الرمكز المخصصة لممتغير، كيجب أف يككف عرض العمكد أكبر مف أك يساكم 
عرض المتغير المضمف فيو، كيمكف تغيير عرض العمكد لأم متغير بكاسطة سحب حدكد العمكد في كرقة 

 .  عرض البيانات 



 

   Alignmentمحاذاة النص : (9

 
 كيستخدـ ىذا العمكد لضبط محاذاة النص داخؿ الخلايا لكؿ متغير

(Left .اليسار /Right . اليميف /Center .الكسط) 

. كيتـ ذلؾ بالنقر عمى الخمية التابعة لممتغير ثـ النقر عمى السيـ المتجو للأسفؿ لاختيار المحاذاة المناسبة
  Right).  .اليميف )مع العمـ بأف المحاذاة الافتراضية ىي 

    Measureالقياس : (10

 :كيستخدـ ىذا العمكد لتحديد نكعية البيانات لممتغير كالتي يمكف تصنيفيا عمى النحك التالي
 Scale  : أك لإعطاء دلالة عمى أف  (القابمة لمقياس الكمي)كيستخدـ ىذا التصنيؼ لمبيانات العددية

 . المتغير متغير متصؿ
 ordinal  : كيستخدـ ىذا التصنيؼ لقياس المتغيرات الترتيبية حيث يمكف ترتيب قيـ المتغير

بحيث تعطي دلالة عمى أنو يمكف ترتيب القيـ تصاعديان أك تنازليان كلكف لا يمكف تحديد الفركؽ 
    (ممتاز، جيد جدان، جيد، متكسط، مقبكؿ، ضعيؼ)بينيا بدقة مثلان تقدير طالب في امتحاف 

 nominal  : كيستخدـ ىذا التصنيؼ لقياس المتغيرات الاسمية كىي متغيرات ليا عدد مف الفئات
مثؿ تقسيـ المجتمع إلى  (لا يمكف ترتيبيا تصاعديان أك تنازليا)دكف أفضمية لإحداىا عمى الأخرل 

ناث أك مثؿ تقسيـ الطلاب حسب تخصصيـ  بعد  (عمـ النفس، عمـ اجتماع، عمكـ التربية)ذككر  كا 
 : كما يميvariable viewتظير شاشة تعريؼ المعمكمات لممتغيرات المذككرة في المثاؿ،  

 



 

  Spssتفريغ الاستبيان في برنامج - 5
 (عدد أفراد العينة) 76بعد الانتياء مف جمع الاستبيانات يقكـ الباحث بترقيـ كؿ استبانة مف الرقـ كاحد إلى 

 .Spssلتسييؿ الإدخاؿ في برنامج 
ما أنثى، كيمكف أف  .NOMINAL كذلؾ المتغير يتـ تعريفو كمتغير أسمي :الجنس*  كىك إما ذكر  كا 

. 2 كالأنثى بالرقـ 1نرمز لمذكر بالرقـ 
 SCALE متغير كمي :السن* 
:  ترتيبي، كيمكف أف نعبر عف الأقدمية في العمؿ كالتاليORDINAL كىك متغير :الأقدمية في العمل* 

. 3 سنة بالرقـ 15، أكثر مف 2 سنة بالرقـ 15 ك5، بيف 1 سنكات بالرقـ 5أقؿ مف 
بدكف :  ترتيبي، كيمكف أف نعبر عف مستكل التعميـ كالتاليORDINAL كىك متغير :المؤىل الدراسي* 

، المستكل 4، المستكل الثانكم بالرقـ 3، المستكل المتكسط 2، المستكل الابتدائي 1مستكل بالرقـ 
  .5الجامعي بالرقـ 

 " تسود الثقة المتبادلة بين الإدارة والموظفين" تبدأ بالعبارة الأكلى ;  جممة24 كتتمثؿ في :عبارات الاستبيان* 
، 3، ع 2، ع 1ع: ، كيمكف تسميتيا بالأرقاـ " أحاول عدم التأخر عن مواعيد العمل" كتنتيي بالعبارة الأخيرة 

    .(3)، نادرا (2)، أحيانا (1)دائما : ، كيمكف أف يتـ التعبير عنيا رقمينا كما يمي24، ع ......
 طريقة تفريغ الاستبيان* 

، كبعد ذلؾ يتـ Creating a New Spss Data File، ثـ اختيار Fileكذلؾ مف خلاؿ قائمة 
 .  أسفؿ صفحة البرنامجVariable Viewالانتقاؿ إلى نافذة 

  :تعريف الجنس 

 

1. Name :الجنس 
2. TYPE: Numeric المتغير رقمي 
3. Width :(8)  (بمعنى عدد الرمكز، أك الأرقاـ)عرض المتغير 

4. Decimals : ( 0أم الرقـ بعد الفاصمة كيتـ اختيار )الأرقاـ العشرية 

5. Label : (كيعني ذلؾ العنصر كصؼ المتغير )جنس المفحكص   



 

6. Values: ما أنثى  (1)قيمة المتغير، كىنا يتـ تعريؼ كترميز المتغير إما ذكر ، كذلؾ (2)،  كا 
ضافة الأرقاـ كالمسميات  .بالضغط عمى الخانة  كا 

7. Missing :None  (البيانات غير الكاضحة أك المفقكدة) 

8. Columns : العمكد كىك إما أف نضع بو قيمة مساكية أك أكبر مفWidth  
9. Align :Center ،سواء بمعنى المحاذاة Center أك Right أك Left  كيختار المستخدـ ما

 Right يناسبو عمما أف الحالة القياسية ىي 
10. Measure :Nominalلأف متغير الجنس متغير اسمي . 

  :تعريف السن 

 

1. Name :السف 
2. TYPE: Numeric المتغير رقمي 
3. Width :(8)  (بمعنى عدد الرمكز، أك الأرقاـ)عرض المتغير 

4. Decimals : ( 0أم الرقـ بعد الفاصمة كيتـ اختيار )الأرقاـ العشرية 

5. Label : (كيعني ذلؾ العنصر كصؼ المتغير )عمر المفحكصيف   

6. Values: None لا يكجد ترميز لأف البيانات أصلا رقمية ،. 

7. Missing :None  (البيانات غير الكاضحة أك المفقكدة) 

8. Columns : العمكد كىك إما أف نضع بو قيمة مساكية أك أكبر مفWidth  
9. Align :Center ،سواء بمعنى المحاذاة Center أك Right أك Left  كيختار المستخدـ ما

 Rightيناسبو عمما أف الحالة القياسية ىي 
10. Measure :Scaleلأف متغير السف متغير كمي  

 :تعريف متغير الأقدمية 

 



 

1. Name :الأقدمية 
2. Type: Numeric المتغير رقمي 
3. Width :(8)  (بمعنى عدد الرمكز، أك الأرقاـ)عرض المتغير 

4. Decimals : ( 0أم الرقـ بعد الفاصمة كيتـ اختيار )الأرقاـ العشرية 

5. Label : (كيعني ذلؾ العنصر كصؼ المتغير ) سنكات الأقدمية في العمؿ   

6. Values: :          قيمة المتغير، كىنا يتـ تعريؼ كترميز المتغير كتحكليو إلى أرقاـ لمدلالة عميو  إما    
ما بيف  (1) سنوات 5أقل من  ما أكثر مف (2)  سنة15 و5،  كا  ،  كذلؾ (3)  سنة15، كا 

ضافة الأرقاـ كالمسميات  بالضغط عمى الخانة  كا 
7. Missing: None  (البيانات غير الكاضحة أك المفقكدة) 
8. Align :Center ،سواء بمعنى المحاذاة Center أك Right أك Left  كيختار المستخدـ ما

 Right يناسبو عمما أف الحالة القياسية ىي 
9. Measure :Ordinalلأف متغير الأقدمية في العمؿ متغير رتبي . 

  :تعريف المؤىل الدراسي

 
1. Name :المؤىؿ 
2. Type: Numeric المتغير رقمي 
3. Width :(8)  (بمعنى عدد الرمكز، أك الأرقاـ)عرض المتغير 

4. Decimals : ( 0أم الرقـ بعد الفاصمة كيتـ اختيار )الأرقاـ العشرية 

5. Label :  (كيعني ذلؾ العنصر كصؼ المتغير ) المؤىؿ العممي   

6. Values: :          قيمة المتغير، كىنا يتـ تعريؼ كترميز المتغير كتحكليو إلى أرقاـ لمدلالة عميو  إما    
ما (2) ابتدائي،   (1)بدون سنة  ما ثانكم(3) متوسط، كا  ما جامعي(4)،  كا  ، كذلؾ (5)، كا 

ضافة الأرقاـ كالمسميات  .بالضغط عمى الخانة  كا 
7. Missing: None  (البيانات غير الكاضحة أك المفقكدة) 



 

8. Align :Center ،سواء بمعنى المحاذاة Center أك Right أك Left  كيختار المستخدـ ما
 Right يناسبو عمما أف الحالة القياسية ىي 

9. Measure :Ordinalلأف متغير المؤىؿ العممي متغير رتبي . 
 تعريف عبارات الاستبيان:  

، كجميعيا يتـ إدخاليا بذات الطريقة مع تغيير 24 حتى ع1 تبدأ مف ع24تأخذ كؿ عبارة مف العبارات 
 :فقط كما يمي Labelمسمى التكصيؼ 

 (وجميع العبارات تكون بنفس الطريقة):  بيذه الطريقة1يتم إدخال العبارة ع

 

1. Name :1ع 
2. Type: Numeric المتغير رقمي 
3. Width :(8)  (بمعنى عدد الرمكز، أك الأرقاـ)عرض المتغير 

4. Decimals : ( 0أم الرقـ بعد الفاصمة كيتـ اختيار )الأرقاـ العشرية 

5. Label : (كيعني ذلؾ العنصر كصؼ المتغير ) تسكد الثقة المتبادلة بيف الإدارة كالمكظفيف   
6. Values:         قيمة المتغير، كىنا يتـ تعريؼ كترميز المتغير كتحكليو إلى أرقاـ لمدلالة عميو  إما     

ما (2) أحيانا،  (1)نادرا  ضافة الأرقاـ كالمسميات(3) دائما، كا   ، كذلؾ بالضغط عمى الخانة  كا 
7. Missing: None  (البيانات غير الكاضحة أك المفقكدة) 
8. Align :Center ،سواء بمعنى المحاذاة Center أك Right أك Left  كيختار المستخدـ ما

 Right يناسبو عمما أف الحالة القياسية ىي 
9. Measure :Ordinalلأف متغير المؤىؿ العممي متغير رتبي . 

  بنفس الطريقة مع تغيير مسمى التوصيف 24وجميعيا يتم إدخال جميع العبارات حتى : ملاحظة
LABEL فقط 

 

 



 

 : كما يميVARIABLE VIEWلتصبح الييئة النيائية لشاشة المتغيرات 

 

  NAME WIDTH DECIMALS LABEL VALUES MISSING COLUMNS ALIGN MEASURE 

جنس  0 8 الجنس 1
 المفحكص

NONE NONE 8 CENTER NOMINAL 

عمر  0 8 العمر 2
 المفحكص

 (1ذكر،)
 (2أنثى،)

NONE 8 CENTER SCALE 

سنكات  0 8 الأقدمية 3
 الأقدمية

NONE NONE 8 CENTER ORDINAL 

 المؤىؿ 4

 

 المؤىؿ 0 8
 لمعممي

 (1دكف مستكل،)
 (2ابتدائي،)
 (3متكسط، )
 (4ثانكم، )
 (5جامعي، )

NONE 8 CENTER ORDINAL 

تسكد الثقة  0 8 1ع 5
المتبادلة 
بيف الإدارة 
 فمكالمكظؼ

 (1نادرا،)
 (2أحيانا،)
 (3دائما، )

 

NONE 8 CENTE
R 

ORDINAL 

فقط يحث يوضع فييا عبارة كل  LABELيتم إدخال جميع عبارات الاستبيان  بنفس الطريقة مع تغيير مسمى التوصيف  2ع 6
 سؤال



 

 كيتـ إدخاؿ كؿ استبانة في صؼ مف الصفكؼ، Data Viewينتقؿ الباحث بعد ذلؾ لنافذة المدخلات 
بناءا عمى إجابات المفحكصيف، كيمكف إجراء مختمؼ  (كؿ صؼ يمثؿ استبياف كاحد أم فرد ف العينة)

 .Analyzeالعمميات الإحصائية عبر قائمة 

 
 تحديد الأبعاد ودرجة المقياس ككل- 6

Transform → Compute variable 
ثـ نقكـ بتعريفو في خانة  (نتماءالا) Target variableفيظير لنا مربع حكارم نقكـ بتسمية البعد في 

Type & label لمخانة  ( عبارات8)، كنقكـ بعدىا بتحكيؿ بنكد أك عبارات البعد المككنة لوNumeric 
Expression بيف العبارات ثـ  (+) مع كضع علامة الجمعOk 

 Function Group في خانة All  مع تحديد
، فإن ( عبارات في ىذا المثال8)إذا كانت ىذه طريقة تحديد أبعاد المتغير بجمع عدد عباراتو : ملاحظة

 في مثالنا ىذا ، ويكون ذلك 24 إلى 1الدرجة الكمية لممتغير تعني جمع جميع عبارات الاستبيان من 
 (سيتم التطرق إلييا لاحقا)بنفس الطريقة 



 

 
 بيف (+) مع وضع علامة الجمع Numeric Expressioثـ تحكيؿ العبارات المككنة لمبعد إلى الخانة 

 Okالعبارات ثـ 

 
 : كما يميفيظير لنا البعد في صفحة المتغيرات كفي صفحة البيانات 



 

 

 
 بعد تفريغ الاستبيان وتحديد أبعاده والدرجة الكمية لو  يجب التأكد من الخصائص السيكومترية لو

 التأكد من الخصائص السيكومترية لأداة الدراسة: المرحمة الرابعة
 : الخصائص السيكومترية لأدوات الدراسة– 1
 :صدق الاختبار- 1-1

 :لا يككف الاختبار صادقا إلا إذا تكفر ما يمي
 "قادرا عمى قياس ما كضع لقياسوَ " أف يككف الاختبار               - 
 "قادرا عمى قياس ما كضع لقياسو فقط " أف يككف الاختبار         - 



 

 "قادرا عمى التمييز بيف طرفي الخاصية التي يقيسيا " أف يككف الاختبار         - 
 :أنواع الصدق- 1-2

 :تكجد في الحقيقة أنكاع عديدة مف الصدؽ نذكر منيا
  الصدؽ العاممي– صدؽ المحتكل – الصدؽ الذاتي – الصدؽ التمييزم –الصدؽ الظاىرم  -
 . الصدؽ التلازمي – صدؽ الاتساؽ الداخمي – الصدؽ التنبؤم–صدؽ التككيف الفرضي  -

 :كسنتناكؿ بعض أنكاع الصدؽ كأشيرىا كىي كالتالي
يطمؽ عمى ىذا النكع مف الصدؽ أحيانا اسـ الصدؽ المنطقي، أك الصدؽ : صدق المحتوى- 1-2-1

كىذا الاسـ الأخير . أك صدؽ العينة، أم عينة السمكؾ. بحكـ التعريؼ، أم المفيكـ أك المتغير محؿ القياس
 .ىك الأقرب إلى المعنى المقصكد

 :كىناؾ ىدفاف ينبغي الكصكؿ إلييما لتحقيؽ صدؽ المحتكل كىما
مثلا، ممثمة في مجمكعة مف البنكد بصكرة " الذكاء" أف تككف الخاصية المحددة بدقة : اليدؼ الأكؿ

 .مناسبة
 .ككذلؾ التكازف بيف ىذه المجالات. أف تمثؿ البنكد المجالات الفرعية لمخاصية أك أبعادىا: اليدؼ الثاني

 (132، ص،2007معمرية، )

 : بطريقتيف ىماتقدير صدق المحتوىيمكف 
كىي استشارة مجمكعة صدق المحكمين كيسمى أيضا :(الصدق الظاىري)طريقة استشارة الخبراء- أ

مف الخبراء المحكميف الذيف يككنكف مف ذكم الخبرة كالكفاءة في المادة أك في مضمكف المادة الدراسية التي 
تتضمف العمكد . كعمى مُعِد الاختبار أف يقدـ اختباره في استمارة تتضمف ثلاثة أعمدة. صمـ ليا الاختبار

كيتضمف العمكد الثالث مكانا فارغا . الأكؿ الأىداؼ كيتضمف العمكد الثاني الأسئمة التي تقيس كؿ ىدؼ
 .يضع فيو الخبراء ملاحظاتيـ

 لا يقيس يقيس الأسئمة الأىداف
أف يتعرؼ عمى مراحؿ اليندسة - 1

 الكراثية لتركيب الأنسكليف
  × أذكر مراحؿ اليندسة الكراثية لتركيب الأنسكليف؟- 1

......................... ................................. ....... ......... 

 (134، ص،2007معمرية، )



 

 :حساب صدق الظاىري يدويا- 1-أ

 :مثال

 (فقرات أك عبارات) بنكد 4ككؿ بعد يتككف مف  (محكريف) أبعاد 02قاـ باحث بتكزيع استبياف مككف مف 
مف التأكد مف كؿ بند يقيس البعد الذم يتشكؿ منو كأف ىذا الاستبياف صادؽ  (محكميف)خبراء  10عمى 

 :فيما يقيس حسب آراء المحكميف فكانت النتائج كالتالي
 

 لا يقيس يقيس (الأسئمة)البنود الرقـ الأبعاد الرقم
 

01 
 

قيم 
 الانتماء

 1 9 تسكد الثقة المتبادلة بيف الإدارة كالمكظفيف 01
 0 10 تسكد الثقة المتبادلة بيف المكظفيف فيما بينيـ 02
 1 9 تعمؿ إدارة المؤسسة عمى تييئة جك الرضا بيف المكظفيف 03
 1 9 مشتركة (لغة)أتخاطب مع زملائي في أمكر العمؿ بمفردات  04

 
02 

 
قيم 

 التعاون

المساكاة ىي الأساس الذم تتعامؿ بو الإدارة العميا مع كؿ  05
 المكظفيف

10 0 

 6 4 يسكد دكراف العمؿ في المؤسسة 06
 0 10 أفضؿ إنجاز العمؿ في حينو كعدـ تأجيمو 07
 4 6أحترـ مكاعيد العمؿ  08

 بيف آراء المحكميف حكؿ مدل α=0.05ىؿ تكجد فركؽ ذات دلالة إحصائية عند مستكل الدلالة :المطموب
 قياس البنكد لأبعاد الاستبياف؟

 :الحل
 نقكـ بحساب كاؼ تربيع مف خلاؿ القانكف  

 
 :  ىي التكرار المتكقع كتحسب كفؽ القانكف التاليEحيث أف 

 

 (تكرارات يقيس كلا يقيس) تمثؿ التكرار المشاىد  𝑂𝑖أما 



 

: ىي (1=1-2= 1 –عدد البدائؿ ) 1= كدرجة الحرية 0.05 المجدكلة عند مستكل الدلالة ²كاكلدينا 
3.84 

بػ  (3.84) المجدكؿ ²كاكلكي نتخذ القرار بكجكد الدلالة الإحصائية مف عدميا نقارف . كنقارنيا بالمحسكبة
المحسكبة، فإذا كانت المحسكبة أكبر مف المجدكلة نقكؿ بكجكد دلالة إحصائية بيف آراء المحكميف حكؿ ² كا

نقكؿ بعدـ  (3.84) المجدكلة ²كا المحسكبة أقؿ مف ²كامدل قياس ىذا البند لبعد الاستبياف، أما إذا كانت 
 .بكجكد دلالة إحصائية بيف آراء المحكميف حكؿ مدل قياس ىذا البند لبعد الاستبياف

 الدلالة الإحصائية  المحسوبة²كا  (O-E O-E)² البنود

01 9– 5 = 4 16 5 10 
10>3.84 

 دال
1–5 -= 4 16 5 

02 10– 5 =5 25 5 10 
10>3.84 

 دال
 0 – 5 -= 5 25 5 

03 9– 5 = 4 16 5 10 
10>3.84 

 دال
1–5 -= 4 16 5 

04 9–5 = 4 16 5 10 
10>3.84 

 دال
1–5 -= 4 16 5 

05 10–5 =5 25 5 10 
10>3.84 

 دال
0–5 -= 5 25 5 

06 4–5 -= 1 1 0.2 0.8 
0.8<3.84 

 غير دال
6–5 = 1 1 0.2 

07 10–5 =5 25 5 10 
10>3.84 

 دال
0–5 -= 5 25 5 

08 6–5 = 1 1 0.2 0.8 
0.2<3.84 

 غير دال
4–5 -= 1 1 0.2 

 8، 6 دالة إحصائيا بينما البنكد 7، 5، 4، 3، 2، 1مف خلاؿ الجدكؿ السابؽ نرل أف البنكد:- النتيجة
كبعدىا يمكف أف نقكؿ أنو ىناؾ فركؽ ذات ......غير دالة إحصائيا كجب حذفيما أك إعادة صياغتيما 

 بيف آراء المحكميف حكؿ مدل قياس البنكد لأبعاد الاستبياف α=0.05دلالة إحصائية عند مستكل الدلالة 
 .كبالتي نعتبر أف المقياس صادؽ فيما يقيس



 

 :spssحساب صدق الظاىري باستخدام - 2-أ
 Spssنقوم بفتح صفحة جديدة في 

 
 (دائما مع المثال السابق)نقوم بإدخال عبارات الاستبيان كل عمى حدى * 

 والموظفين الإدارة بين المتبادلة الثقة تسود : 01العبارة 
1. Name :1ع 
2. TYPE: Numeric المتغير رقمي 
3. Width :(8)  (بمعنى عدد الرمكز، أك الأرقاـ)عرض المتغير 

4. Decimals : ( 0أم الرقـ بعد الفاصمة كيتـ اختيار )الأرقاـ العشرية 

5. Label :(كيعني كصؼ المتغير) كالمكظفيف الإدارة بيف المتبادلة الثقة تسكد   

6. Values:  ما  (1)تقيس قيمة المتغير، كىنا يتـ تعريؼ كترميز المتغير إما ، (2)لا تقيس،  كا 
ضافة الأرقاـ كالمسميات  .كذلؾ بالضغط عمى الخانة  كا 

7. Missing :None  (البيانات غير الكاضحة أك المفقكدة) 

8. Columns : العمكد كىك إما أف نضع بو قيمة مساكية أك أكبر مفWidth  
9. Align :Center ،سواء بمعنى المحاذاة Center أك Right أك Left  كيختار المستخدـ ما

 Right يناسبو عمما أف الحالة القياسية ىي 
10. Measure :Nominal (يقيس لا يقيس) متغير اسمياؿ لأف. 

 :وتصبح الصف كما يمي

 



 

 كما VARIABLE VIEWلتصبح الييئة النيائية لشاشة المتغيرات كنكمؿ باقي العبارات بنفس الطريقة، 
: يمي

 
 مف أجؿ إدخاؿ البيانات لكؿ باحث حكؿ رأيو عف الاستبياف ىؿ Data Viewثـ ننتقؿ إلى صفحة * 

 (2رمزه )أك لا يقيس  (1رمزه )يقيس 

 
 Dataالبيانات لتصبح الييئة النيائية لشاشة  عبارات في الاستبياف 8 محكميف حكؿ 10بعد كضع آراء *

Viewكما يمي  :

 
 :لعبارات الاستبياف حتى نتأكد مف دلالتيا الإحصائية بيذه الطريقة (²كا)نقكـ بحساب كاؼ تربيع *



 

 
 

 
Analyze →Nonparametric teste →Legacy Dialogs →Chi-square 

 :ثعذ ُزٍ الخطْاد ٗظِش لٌب الوشثع الحْاسٕ الزبلٖ  *

Analyze 

1 

Nonparametric  tests 

2 
Legacy Dialogs 

3 

Chi-square 

4 



 

 

ليأخذ )Get from data ثـ نختار  Test Variable Listنقكـ بتحديد العبارات كنقميـ إلى خانة 
 Use specifledالمجمكعتيف المدرجتيف، أما إذا كانت أكثر مف مجكعتيف كأردنا أخذ بعضيا فقط نختار 

range)  ثـ نختارAll categories equal (لنأخذ التكرار المتكقع النظرم)  نضغطOption فيظير 
 :المربع الحكارم التالي

 
 Output فتظير النتائج التالية في صفحة Ok ثـ Continue ثـ Descriptiveنقكـ باختيار 

1 

4 

1 

2 

3 

2 3 



 

كىي عبارة عمى مجمكعة مف الجداكؿ ككؿ جدكؿ يعبر عمى عبارة مف عبارات الاستبياف كيكضح ىؿ دالة 
 :إحصائيا أك غير دالة ككجب حذفيما أك إعادة صياغتيما، كىي كالتالي

 

 : تفسير الجدول

 إذا ىناؾ فركؽ بيف آراء المحكميف 0.05 كىي أقؿ مف Sig = 0.01 نجد 01بالنسبة لمعبارة  -
 .حكؿ مدل قياس ىذا البند لبعد الاستبياف

 إذا ىناؾ فركؽ بيف آراء المحكميف 0.05 كىي أقؿ مف Sig = 0.01 نجد 03بالنسبة لمعبارة  -
 .+حكؿ مدل قياس ىذا البند لبعد الاستبياف

 إذا ىناؾ فركؽ بيف آراء المحكميف 0.05 كىي أقؿ مف Sig = 0.01 نجد 04بالنسبة لمعبارة  -
 .حكؿ مدل قياس ىذا البند لبعد الاستبياف

 إذا لا تكجد فركؽ بيف آراء المحكميف 0.05 كىي أكبر مف Sig = 0.52 نجد 06بالنسبة لمعبارة  -
 .حكؿ مدل قياس ىذا البند لبعد الاستبياف

 إذا لا تكجد فركؽ بيف آراء المحكميف 0.05 كىي أكبر مف Sig = 0.52 نجد 08بالنسبة لمعبارة  -
 .حكؿ مدل قياس ىذا البند لبعد الاستبياف

 . فلا يكجد محكـ قاؿ بأنيا لا تقيس فكميـ قالكا بأنيا تقيس07، 05، 02أما بالنسبة لمعبارة  -
 غير دالة إحصائيا كجب حذفيما أك إعادة صياغتيما أما 08 ك06 مما سبؽ انو ىناؾ العبارتيف نلاحظ

 . الباقي فإنيـ ذك دلالة إحصائية



 

 بيف آراء المحكميف α=0.05إذا يمكف أف نقكؿ أنو ىناؾ فركؽ ذات دلالة إحصائية عند مستكل الدلالة 
 .حكؿ مدل قياس البنكد لأبعاد الاستبياف كبالتي نعتبر أف المقياس صادؽ فيما يقيس

 كتعتمد ىذه الطريقة عمى حساب معاملات الارتباط بيف الدرجة عمى كؿ :طريقة الاتساق الداخمي- ب
 .كالدرجة الكمية للاختبار (محؾ داخمي)بند 
 :حساب صدق الاتساق الداخمي يدويا- 1-ب

 :مثال
 بندا، يتـ الإجابة عنيا 24لدينا استبياف لقياس الثقافة التنظيمية لدل العماؿ المينييف، يتككف الاستبياف مف 

 عمى الترتيب لتككف الدرجة الكمية 1، 2، 3دائما، أحيانا، نادرا تأخذ العلامات : ضمف ثلاثة بدائؿ ىي
  .72 ك24للاستبياف تتراكح بيف 

 10نقكـ باستخداـ معامؿ الارتباط بيرسكف لحساب الارتباط بيف كؿ بند كالدرجة الكمية للاستبياف لعشرة 
 ( كباقي البنكد تككف بنفس الطريقة01سنقكـ بحساب بند رقـ ).مفحكصيف كمثاؿ

 01درجات البند  المفحوصين
X 

الدرجة الكمية 
 Yللاختبار 

 
X² 

 
Y² 

 
X × Y 

1 2 47 4 2029 94 
2 1 58 1 3364 58 
3 3 63 9 3969 189 
4 3 54 9 2916 162 
5 2 68 4 4624 136 
6 1 42 1 1764 42 
7 2 59 4 3481 118 
8 2 61 4 3721 122 
9 1 58 1 3364 58 
10 3 49 9 2401 147 

 1126 31633 46 559 20 المجمكع
 وبتطبيق معادلة الارتباط بيرسون 

 
 r= 0.166:      نجد أن



 

مف خلاؿ ) r = 0.631 نجد أف القيمة المجدكلة0.05 كعند مستكل الدلالة 2-10 = 8عند درجة الحرية 
، إذا نستنج أف الاتساؽ ضعيؼ r = 0.166: كىي أكبر مف القيمة المحسكبة ( المجدكلةrالجدكؿ قيـ 

 .01كغير داؿ لمفقرة 
 :spssحساب صدق الاتساق الداخمي باستخدام - 2-ب
 إذا كاف المقياس مقسـ إلى أبعاد نقكـ بحساب الاتساؽ الداخمي لكؿ بعد عمى حدل* 
 ليتـ تكزيع الاستبياف التجريبي 30في الدراسات الاستطلاعية مف الأحسف أف لا يتجاكز عدد المبحكثيف * 

 .(الصدؽ كالثبات)لمتأكد مف خصائصو السيككمترية 
 يجب إنشاء الدرجة الكمية ليذا الاستبياف بالطريقة التالية: أكلا

Transform → Compute variable 

 
 :فيظير المربع الحكارم التالي

 
 (لا تقبؿ الفراغات)الكمية _الدرجة: مثال Target Variableنكتب عنكاف المتغير في  (1



 

 . الدرجة الكمية لممقياس:مثال Type & Labelنعرؼ العنكاف في خانة  (2
 Function group في خانة Allنختار  (3
 24ع......3ع+2ع+1ع:  مثاؿNumeric Expressionنقكـ بجمع العبارات في خانة  (4

 
 كصؼ لمدرجة الكمية في صفحة Data View فيظير عمكد لمدرجة الكمية في صفحة Okنختار  (5

Variable Viewبيذا الشكؿ . 

 
 :نقكـ بحساب العلاقة الارتباطية بيف العبارات كالدرجة الكمية لممقياس مف خلاؿ (6

 
Analyze → Correlate → Bivariate  



 

 :فيظير المربع الحكارم التالي

 
 كبعدىا نقكـ بإرساؿ جميع العبارات لنفس الخانة ثـ Variablesنقكـ بإرساؿ الدرجة الكمية إلى خانة 

 Ok ثـ Pearsonنؤشر عمى خانة 
 Outputفتظير النتائج في جدكؿ عمى شكؿ مصفكفة في صفحة 

 نأخذ جزء مف الجدكؿ لتفسير النتائج كباقي الجدكؿ تككف بنفس الطريقة

 
 ( مجمكع العبارات عمى طكؿ الصؼ24 إلى 1مف ) يمثلاف العبارات 2 ك1رقـ  -



 

حرؼ أ يمثؿ الدرجة الكمية لممقياس كخانة التقاطع بينيا كبيف خانات العبارات ىي نتائج العلاقة  -
 بيف الدرجة الكمية كىذه العبارة

 (تسكد الثقة بيف الإدارة كالمكظفيف) 01نلاحظ أف درجة الارتباط بيف الدرجة الكمية كالعبارة  -
r=0.88 كأف  Sig =0.00 0.05أنو تكجد علاقة ارتباطية قكية بينيما كأنيا دالة إحصائيا عند. 

 (تسكد الثقة المتبادلة بيف المكظفيف) 02نلاحظ أف درجة الارتباط بيف الدرجة الكمية كالعبارة  -
r=0.90 كأف  Sig =0.00 0.05أنو تكجد علاقة ارتباطية قكية بينيما كأنيا دالة إحصائيا عند .

 كىكذا نكاصؿ مع جميع العبارات
إذا كجدنا أف العلاقة الارتباطية بيف الدرجة الكمية كأحد العبارات ضعيفة ىذا يعني أنيو لا تكجد  -

 لمفقرة علاقة بالمقياس كيتكجب حذفيا
 0.05تعني أف ىذا الارتباط داؿ مستكل الدلالة  (نجمة كاحدة) * :ملاحظة -

 0.01تعني أف ىذا الارتباط داؿ مستكل الدلالة  (نجمتيف)          ** 
 :(الصدق التمييزي)صدق المقارنة الطرفية - 1-2-2

تقكـ ىذه الطريقة عمى أحد مفاىيـ الصدؽ، كىك قدرة الاستبياف عمى التمييز بيف طرفي الخاصية التي 
عمى مجمكعة مف  (كما في مثالنا)يقيسيا، كيقكـ الباحث بتطبيؽ استبياف يقيس الثقافة التنظيمية 

 فردا، ثـ يرتب الدرجات التي حصمكا عمييا تنازليا أك تصاعديا في التكزيع، ثـ 38المفحكصيف، كلتكف 
 10 مف المفحكصيف مف طرفي التكزيع، فتصير لو مجمكعتاف متطرفتاف تساكم كؿ منيما % 27يسحب 
لدلالة الفركؽ بيف متكسطيف " ت" ، فيقارف بينيما باستخداـ اختبار (10.26=27/100×38)أفراد 

 (158، ص،2007معمرية، ).حسابييف

 :يدويا (الصدق التمييزي)حساب صدق المقارنة الطرفية - أ

 كبدائؿ 8 أفراد كعدد الفقرات كانت 10قاـ باحث بتكزيع استبياف الثقافة التنظيمية عمى عينة حجميا : مثاؿ
 :فكانت درجاتيـ كالتالي عمى الترتيب 1، 2، 3دائما، أحيانا، نادرا تأخذ العلامات : ىيالإجابة 
 :    عمينا
 تفريغ الدرجات لكؿ فقرة في الجدكؿ- 
 إيجاد مجمكع درجات الأفراد في الاستبياف ككؿ- 
 ترتيب الدرجات مف أقؿ درجة إلى أعمى درجة- 
  أفراد3 ⋍ 2.7 = 27/100× 10 مف طرفي التكزيع  % 27تحديد - 



 

مجمكع  المحاكر 
درجات 
الأفراد في 
الاستبياف 
 ككؿ

ترتيب 
الدرجات 
مف الأقؿ 
إلى 
 الأعمى

 
  الأفراد

 
فقرة 
01 

 
 

فقرة 
02 

 
 

فقرة 
03 

 
 

فقرة 
04 

 
 

فقرة 
05 

 
 

فقرة 
06 

 
 

فقرة 
07 

 
 

فقرة 
08 

 

1 3 3 2 1 1 2 3 2 17 14  
العينة الدنيا 

 =3 
2 3 2 2 1 1 2 3 1 15 14 
3 2 1 2 3 2 1 2 1 14 15 
4 3 2 1 2 3 2 3 2 18 16  
5 1 2 3 3 2 3 1 2 17 17  
6 2 2 2 1 3 3 3 2 18 17  
7 3 2 3 2 1 1 2 3 17 17  
8 2 1 2 1 3 2 2 2 16 17  

يا عؿالعينة اؿ
 =3 

9 2 1 3 3 3 1 2 3 17 18 
10 1 1 1 3 3 3 1 1 14 18 

 (الدرجات المرتفعة) أفراد مف العينة العميا 03ك (الدرجات الضعيفة) أفراد مف العينة الدنيا 03نأخذ - 
 .α =0.05عند مستكل الدلالة .  لعينيف مستقمتيفT" ت" كنجرم مقارنة بينيما مف خلاؿ اختبار 

 :المحسكبة بالخطكات التالية" ت"نحسب - 
 Ʃ 3 2 1 الأفراد

 53 17 18 18 درجـــــة الأفــــــــراد المرتفعة
 0.34 0.34 0.66-   

 

 
0.115 0.155 0.435 0.705 

  3 2 1 الأفراد
 43 15 14 14 درجـــــة الأفــــــــراد المرتفعة

 0.33 -  0.33-  0.67  

 0.108 0.108 0.448 0.664 

:نحسب المتكسط الحسابي لمعينتيف كفؽ القانكف التالي : أولا  

 



 

( المتكسط الحسابي لمعينة الدنيا)  x 1 =
Ʃ 𝑥𝑖

n
=

53

3
= 17.66 

(المتكسط الحسابي لمعينة العميا)  x 2 =
Ʃ 𝑥𝑖

n
=

43

3
= 14.33 

:  نحسب التبايف لمعينتيف كفؽ القانكف التالي:ثانيا  

𝑆² =  
Ʃ (𝑥𝑖 − x )²

n − 1
 

( التبايف لمعينة الدنيا)  𝑆1² =  
Ʃ (𝑥𝑖−x1    )²

n−1
=  

𝟎.𝟕𝟎𝟓

3−1
= 0.352 

 ( التبايف لمعينة العميا )  𝑆2² =  
Ʃ (𝑥𝑖−x 2)²

n−1
=  

𝟎.𝟔𝟔𝟒

3−1
= 0.332 

:لعينتيف مستقمتيف كما يمي" ت"نقكـ بحساب قيمة : ثالثا  

𝑇 =
x 1 − x 2

 
 𝑛1−1 𝑆1²+ 𝑛2−1 𝑆2²

 n1+n2 −2
× (

1

𝑛1
+

1

𝑛2
)

 

𝑇 =
17.66 − 14.33

 
 3−1 0.352+ 3−1 0.332

 3+3 −2
× (

1

3
+

1

3
)

 

𝑇 =
17.66 − 14.33

 
 3−1 0.352+ 3−1 0.332

 3+3 −2
× (

1

3
+

1

3
)

=  
3.33

 
0.704+0.664

4
× 0.66

=  
3.33

 0.225
=   

3.33

0.474

= 7.02 
 .7.02= المحسكبة " ت"لدينا قيمة 

 كىي تساكم  0.05 كعند مستكل الدلالة df = (3+3)- 2 = 4الجدكلية عند درجة الحرية " ت" أما قيمة 
، كىي أقؿ مف القيمة المحسكبة، إذا نستنتج أنو تكجد فركؽ (مف خلاؿ الجدكؿ قيـ ت المجدكلة) 2.773

ذات دلالة إحصائية بيف الدرجات الضعيفة كالمرتفعة في الاستبياف، ما يؤكد أف الاستبياف صادؽ في ما 
 .(2020عبان، فيديو حساب الصدق التمييزي للاستبيان،) .يقيس كفي قدرتو عمى التمييز بيف درجات الأفراد

 :spssباستخدام  (الصدق التمييزي)حساب صدق المقارنة الطرفية - ب
 (تـ التطرؽ إلييا)يجب إيجاد الدرجة الكمية لممقياس : أولا
 مف خلاؿ الذىاب إلى عمكد الدرجة الكمية في صفحة (تصاعديا أك تنازليا)نقكـ بترتيب الدرجة الكمية : ثانيا

Data View إلى Sort Ascending.  



 

 

21 ) 20.52= 100÷ 27× 76) مف العينة ككؿ % 27ثـ نقكـ بتحديد نسبة  ، بإضافة عمكد جديد ≈
Var 2 ثـ نعكس الترتيب أك نبدأ مف الأسفؿ كنكتب 1 كنكتب. 

 Values ، ثـ مف خلاؿالمجموعات كنقكـ بتسمية العمكد إلى Variable Viewثـ نرجع إلى صفحة 
 .2، والعميا ىي 1الدنيا ىي نقكـ بترميز المجمكعات إلى 

 

 



 

 :فتصبح بيذا الشكؿ

 
 :نذىب إلى (الدنيا كالعميا)كلمتأكد مف كجكد فركؽ بيف ىاتيف المجمكعتيف 

Analyze → Compare Means → Independent-Samples T Test 

 

 :فيظير المربع الحكارم التالي
 Grouping ككضع المجمكعات في خانة Test Variableنقكـ فيو بكضع الدرجة الكمية في خانة 

Variable ثـ نقكـ بتعريؼ المجمكعات في خانة Define Groups ثـ نضغط 2 ك1 بكضع الرقميف 
Continue  ثـ Ok 

 



 

 Outputفتظير لنا عدة جداكؿ في صفحة 
  عدد العينة– الانحراؼ المعيارم – ىك الجدكؿ الكصفي لاختبار المتكسط الحسابي :الجدول الأول

 
 :الجدول الثاني

 
 : الأكلى إذا كانت Sigأكلا نشاىد قيمة 

Sig < 0.05 في ىذه الحالة نختار القيـ في الصؼ السفمي، أما إذا كانت  Sig > 0.05 نختار القيـ في 
 .الصؼ العمكم 

 ، إذا نختار القيـ في الصؼ السفمي مف 0.05 كىي أقؿ مف  Sig = 0.00في مثالنا ىذا نجد قيمة 
 :الجدكؿ فتجد مايمي 

t - = 17.58 ودرجة الحرية ، df = 20 وقيمة ، Sig (2.tailed) =0.00 (وىو ما ييمنا) 
 فإننا نرفض الفرض الصفرم كنقبؿ البديؿ 0.05 وىي أقل من Sig (2.tailed) =0.00بما أف قيمة - 

إذا المقياس يكجد  (العميا كالدنيا)كنقكؿ تكجد فركؽ ذات دلالة إحصائية لدل العينة بناءا عمى المجمكعات 
بو صدؽ تمييزم قادر عمى التمييز بيف الأشخاص الذيف يمتمككف السمة بشكؿ عالي كالذيف يمتمككف السمة 

 .بشكؿ منخفض أم تكجد أطراؼ لمسمة
 في ىذه الحالة نقبؿ الفرض الصفرم كنرفض الفرض البديؿ Sig (2.tailed) > 0.05أما لك كانت - 

إذا المقياس لا  (العميا كالدنيا)كنقكؿ لا تكجد فركؽ ذات دلالة إحصائية لدل العينة بناءا عمى المجمكعات 
يكجد بو صدؽ تمييزم كغير قادر عمى التمييز بيف الأشخاص الذيف يمتمككف السمة بشكؿ عالي كالذيف 

 .يمتمككف السمة بشكؿ منخفض أم لا تكجد أطراؼ لمسمة



 

 :(الصدق الذاتي)الصدق المستخرج من معامل الثبات - 1-2-3
كتعتمد .  Intrinsic Validityالصدؽ الذاتي: تشير بعض المراجع إلى نكع آخر مف الصدؽ تطمؽ عميو

تصبح درجات  (عند حساب الثبات)في ذلؾ عمى أف الدرجات التجريبية بعد تمخيصيا مف أخطاء القياس 
كذلؾ بحساب الجذر . حقيقية، كبما أنيا صارت حقيقية يمكف اعتبارىا محكا ينسب إليو صدؽ الاختبار

 :إلا أف ىذه الطريقة عمييا ملاحظتاف. التربيعي لمعامؿ الثبات بكصفو معاملا لمصدؽ
أنيا تتجاىؿ تماما المبدأ الأساسي الذم يربط بيف الصدؽ كالثبات  كىك أف كؿ اختبار صادؽ ثابت :الأولى

فمفيكـ الثبات أكسع مف مفيكـ الصدؽ، فيك يتضمف اختبارات صادقة . كليس كؿ اختبار ثابت صادؽ
 .كأخرل غير صادقة

أف معاملات الثبات ىي دائما عبارة عف كسر مف الكاحد الصحيح، كنتيجة لاستخراج جذرىا :الثانية
 (حيث أف جذر كسر عشرم أكبر منو)التربيعي، نحصؿ دائما عمى قيمة أكبر منيا 

 0.65= لدينا قيمة الثبات ألفا كركنباخ :مثال

 

 ما يدؿ عمى المقياس صادؽ 0.80بعد حساب الصدؽ الذاتي كىك الجذر التربيعي لمثبات كجدناه يساكم 

 .فيما يقيس

 :ثبات الاختبار- 1-3
 "ىك ضماف الحصكؿ عمى نفس النتائج تقريبا إذا أعيد تطبيؽ الاختبار عمى نفس الفرد أك نفس المجمكعة"

 :كلا يككف الاختبار ثابتا إلا إذا تحقؽ ما يمي
 .أف يعطي الاختبار نفس النتائج تقريبا إذا أعيد تطبيقو عمى نفس المجمكعة مف الأفراد- 
 .أف تككف ىناؾ علاقة قانكنية بيف بنكد الاختبار، مما يدؿ عمى التناسؽ في البناء الداخمي للاختبار- 
يعني ثبات الاختبار دلالة عمى الأداء الفعمي أك الأداء الحقيقي لمفرد الذم يعبر عنو بالدرجة الحقيقية - 

 (167، ص،2007معمرية، ).التي يحصؿ عمييا الفرد في اختبار ما
 :أنواع الثبات- 1-4

 :تكجد في الحقيقة أنكاع عديدة لحساب الثبات نذكر منيا



 

– طريقة الصكر المتكافئة – طريقة التناسؽ الداخمي– طريقة التجزئة النصفية –طريقة ألفا كركنباخ -
 . طريقة ثبات اختبار السرعة–طريقة إعادة تطبيؽ الاختبار 

 :كسنتناكؿ بعض أنكاع الثبات كأشيرىا كىي كالتالي

 :الثبات بألفا كرونباخ- 1-4-1
كمعامؿ ألفا يربط . كىك مف أىـ مقاييس الاتساؽ الداخمي للاختبار المككف مف درجات مركبة αيرمز لو ب 

ثبات الاختبار بثبات بنكده، فازدياد نسبة تباينات البنكد بالنسبة إلى التبايف الكمي يؤدم إلى انخفاض 
 :معامؿ الثبات، كصيغة معادلة معامؿ ألفا كركنباخ كما يمي

 (184، ص،2007معمرية، )

 

α : ألفا كركنباخ
K :  عدد الأسئمة

 𝛿 2
𝑥𝑖

𝐾
𝑖=1 :  مجمكع التباينات الجزئية

𝛿 2
𝑋

 التبايف الكمي: 
 :حساب معامل ألفا كرونباخ يدويا- أ

 :مثال
لتسيؿ ) 3 أفراد كعدد الفقرات كانت 05قاـ باحث بتكزيع استبياف الثقافة التنظيمية عمى عينة حجميا 

 فكانت  عمى الترتيب1، 2، 3دائما، أحيانا، نادرا تأخذ العلامات : ىي، كبدائؿ الإجابة (عممية الحساب
 :درجاتيـ كالتالي

 :لإيجاد معامؿ الثبات ألفا كركنباخ نتبع الخطكات التالية
 نحسب المتكسط الحسابي للأجكبة - 
 (التبايف الجزئي)نحسب التبايف لكؿ سؤاؿ - 
 
 
 
 
 



 

 العبارات 

 

 

 

 

 

 

 

²(
𝒙
𝟏

−
𝐱
𝟏

   
 

)
 

 

 

 

²(
𝒙
𝟐

−
𝐱
𝟐

   
 

)
 

 

²(
𝒙
𝟑

−
𝐱
𝟑

   
 

)
 

 X1 X2 X3 الأفراد

1 1 3 3 -0.2 1.2 1.2 0.04 1.44 1.44 
2 1 2 1 -0.2 0.2 -0.8 0.04 0.04 0.64 
3 2 1 2 0.8 -0.8 0.2 0.64 0.64 0.04 
4 1 1 1 -0.2 -0.8 -0.8 0.04 0.64 0.64 
5 1 2 2 -0.2 0.2 0.2 0.04 0.04 0.04 
Ʃ 6 9 9 0 0 0 0.8 2.8 2.8 

المتوسط 

 الحسابي

x  

 
1.2 

 
1.8 

 
1.8 

التباين    
الجزئي 

 01لمسؤال

التباين 
الجزئي 

 02لمسؤال

التباين 
الجزئي 

 03لمسؤال

نحسب مجمكع الأجكبة عمى كؿ سؤاؿ كنككف سمسمة جديدة نحسب متكسطيا الحسابي ثـ تباينيا - 
 :(التبايف الكمي)

 X1+X2+X3=X4 X4-x  ²(X4-x ) الأفراد
01 7 2.2 4.84 
02 4  -0.8 0.64 
03 5 0.2 0.04 
04 3  -1.8 3.24 
05 5 0.2 0.04 
Ʃ 24  8.8 

 لمتكسط الحسابيا

x =  
Ʃ 𝑥

n
 

24/5=4.8   

 αحساب ألفا كرونباخ  -

 

α : ألفا كركنباخ
K : 3= عدد الأسئمة 

 𝛿 2
𝑥𝑖

𝐾
𝑖=1 : 2.8 + 2.8 + 0.8= مجمكع التباينات الجزئية 

𝛿 2
𝑋

   كمنو نطبؽ في المعادلة  8.8= التبايف الكمي : 



 

 
 منو نستنتج أف الثبات ضعيؼ كلكي يككف الثبات قكم كقبكؿ قيجب أف يككف 𝛂 = 0.42 كجدنا قيمة إذا

  .(𝛂 ≥ 7  )7أكبر أك يساكم مف 
 :spssحساب معامل ألفا كرونباخ باستخدام - ب

 :التالية3يجب إتباع الخطوات 
Analyze → Scale → Reliability Analysis → items (نضع فييا المتغيرات) → 

Continue → Alpha → Ok 

 

 

Analyz

e 

Scale 2 

Reliability Analysis 3 



 

 

 
ذا كانت قيمة الثبات أكثر أك يساكم   فإف المقياس 0.70فيظير لنا جدكؿ يكضح لنا قيمة ألفا كركنباخ كا 

  إذا المقياس ثابت فيما يقيس0.94لدينا في المثاؿ ألفا كركنباخ تساكم . ثابت فيما يقيس

 
  . فإنو لا يعمؿ بو كيجب معالجتو0.70أما إذا كاف أقؿ مف 



 

 :لكف السؤاؿ المطركح كيؼ أعرؼ السؤاؿ الذم سبب المشكمة كأدل إلى انخفاض الثبات كذلؾ بالتكجو إلى
Analyze → Scale → Reliability Analysis → statistics → Scale if item deleted 

→ Continue → OK 

 

 
 :فيظير الجدكؿ التالي Ok ثـ continue ثـ Scale if item deleted نختار ثـ

 



 

 كركنباخ بعد حذؼ ىذه الفقرة، فنختار القيمة التي ألفاىذا الجدكؿ يحتكم العبارات ككؿ عبارة يقابميا معامؿ 
. نريدىا كنحذؼ العبارة المقابمة ليا

 : بالتجزئة النصفيةالثبات- 1-4-2
تعتمد ىذه الطريقة عمى تجزئة الاختبار إلى جزأيف فقط بحيث يتككف الجزء الأكؿ مف الدرجات الفردية 

كمف ثـ إيجاد معامؿ الارتباط بيف نصفي ىذا . للاختبار كالجزء الثاني مف الدرجات الزكجية للاختبار
 الاختبار بطريقة بيرسكف كبعد ذلؾ يتـ تصحيح معامؿ الارتباط بكاسطة سبيرماف براكف أك بمعادلة جيتماف 

 :حساب الثبات بالتجزئة النصفية يدويا- أ

 :مثال تطبيقي

لدينا درجات عشرة طلاب في اختبار تـ تقسيمو إلى ثماني أسئمة كما مكضح في الجدكؿ التالي، كالمطمكب 
  الفردية كالزكجية باستخداـ طريقة التجزئة النصفية؟ةحساب قيمة معامؿ الثبات لدرجات الأسئؿ

 
 الأفراد

 الأسئمة
1 2 3 4 5 6 7 8 

01 1 1 1 1 1 0 0 0 
02 1 1 1 0 1 1 0 0 
03 1 1 0 1 1 0 0 0 
04 1 1 1 0 1 1 1 1 
05 1 1 1 0 0 1 0 0 
06 1 1 1 1 0 0 1 1 
07 1 1 1 0 1 1 0 0 
08 1 1 1 1 1 1 1 0 
09 1 1 1 1 0 0 0 0 
10 1 1 1 1 1 1 1 1 

 :الحل
كدرجات الأسئمة الزكجية عمى حدل كنسمييا  " x" نقكـ بتجميع درجات الأسئمة الفردية عمى حدل كنسمييا 

 "y " لكؿ طالب منفردا كنضعيا في الجدكؿ التالي: 

 



 

X 
مجمكع الدرجات 

 الفردية

Y 
مجمكع الدرجات 

 الزكجية

X y 
 
 

X² Y² 

3 2 6 9 4 
3 3 9 9 9 
2 2 4 4 4 
4 3 12 16 9 
2 2 4 4 4 
3 3 9 9 9 
3 2 6 9 4 
4 3 12 16 9 
2 2 4 4 4 
4 4 16 16 16 

Ʃ 30 26 82 96 72 
 :الاختبار (نصفي ، جزئي )أكلا نقكـ بحساب معامؿ الارتباط بيرسكف *

 

 (الجزئي)ثانيا نقكـ بحساب معامؿ الارتباط المصحح، لأنو يجب تصحيح كتعديؿ الارتباط السابؽ *
 :  براكف كفؽ القانكف التالي–باستخداـ معادلة سبيرماف 

 
 معادلة سبيرماف براكف : 𝑟𝑆𝐵حيث 

𝑟 : معامؿ الارتباط بيرسكف بيف درجات النصؼ الفردم كالنصؼ الزكجي. 
 نستخدـ ىذه الطريقة إذا كاف النصفي الاختبار 0.7قكم لأف قيمتو أكبر مف منو نستنتج أف الثبات 

 بمعادلة جيتمانمتساكييف في التبايف أما إذا لـ يككنكا متساكييف نصححيا 



 

 :spssحساب الثبات بالتجزئة النصفية باستخدام - ب
  :يجب إتباع الخطوات التالية

Analyze → Scale → Reliability Analysis → items (ًضع فِ٘ب الوزغ٘شاد) → 

Continue → Split-hqlf (التجزئة النصفية) → Ok 

بدلا عف ألفا  (التجزئة النصفية)  Split-hqlfنفس خطكات حساب ألفا كركنباخ إلا أننا نختار ىذه المرة 
 كركنباخ

 
 :فيظير لنا عدة جداكؿ أىميا الجدكؿ الثاني الذم يحتكم عمى

 ثبات ألفا كركنباخ لمنصؼ الأكؿ كالنصؼ الثاني -
 الارتباط بيف النصفيف -
 قيمة سبيرماف براكف -
 قيمة معادلة جيتماف -



 

 
  بمعادلة جيتمانإذا كاف النصفي الاختبار متساكييف في التبايف أما إذا لـ يككنكا متساكييف نصححيا 

 :لدينا ىنا في ىذا المثاؿ معاؿ الثبات بأسمكب التجزئة النصفية 
معامل الارتباط بعد التصحيح  معامل الارتباط قبل التصحيح

 براون- بمعادلة سبيرمان 
Nعدد أفراد العينة  

في الدراسة الاستطلاعية مف )
 (30الأفضؿ أف تككف 

0.997 0.998 76 
  فيك قكم جدا كبالتالي فالثبات قكم جدا  0.99بما أف الارتباط ىنا يساكم 

 :(20-معادلة كيودر ورتشاردسون)الثبات بطريقة التناسق الداخمي- 1-4-3

 كيعتبر نظير كمعادؿ لمعامؿ الثبات 1937ىذا المعامؿ تـ استنتاجو مف طرؼ كيكدر كرتشاردسكف سنة 
ألفا كركنباخ أم يعتبر حالة خاصة مف معامؿ ألفا كركنباخ يعتمد فييا عمى الفقرات التي تحتمؿ إجابتيف 

 ثـ حساب معامؿ ألفا كركنباخ الذم يعبر عف معامؿ كيكدر كرتشاردسكف،  1 ك0فقط، أم إدخاؿ بالترميز 
أم تستخدـ ىذه الطريقة في حساب الثبات عندا تككف درجات مفردات أك أسئمة الاختبار أك الاستبياف 

كيتـ حساب معامؿ الثبات ألفا كركنباخ كفؽ ىذه ( صح، خطأ)أك ( نعـ ، لا)أك  (0،1)ثنائية فقط مثؿ  
 :المعادلة

 



 

 :حيث
 𝐾𝑅20 :20ريتشاردسكف - معادلة ككدر 

𝐾 :عدد فقرات الاستبياف أك أسئمة الاختبار 
 𝑆𝑖𝑡𝑒𝑚

 مجمكع تباينات فقرات الاستبياف أك أسئمة الاختبار: 2
𝑆𝑡𝑜𝑡𝑎𝑙

 (الدرجات الكمية للاختبار)تبايف الدرجات النيائية لممبحكثيف : 2

 :يدويا (20-معادلة كيودر ورتشاردسون)التناسق الداخميحساب الثبات بطريقة - أ
 :مثال تطبيقي

 عمى الترتيب، 1، 2تأخذ العلامات  (نعـ ، لا) بدائؿ للإجابة 02ك (فقرات) بنكد 3لدينا استبياف مككف مف 
 . أفراد5تـ تكزيعو عمى 

 ريشاردسكف؟-  حساب معامؿ الثبات كفؽ طريقة ككدر:المطموب 

 :الحل

 (2=، نعـ 1=لا )نفرغ استجابات الأفراد في الجدكؿ :- أكلا
 حساب مجمكع درجات الأفراد في الاستبياف ككؿ- 
 حساب مجمكع درجات الفقرات- 
 حساب متكسط درجات الفقرات - 

 
 الأفراد

مجموع درجات  البنود 
 4 3 2 1 المبحوثين

01 2 2 2 2 8 
02 2 2 1 2 7 
03 2 2 1 2 7 
04 2 2 2 2 8 
05 2 2 2 1 7 
06 2 2 2 2 8 
07 1 1 1 1 4 

 49 12 11 13 13 مجموع درجات الفقرات
  1.71 1.57 1.86 1.86 متوسط درجات الفقرات



 

𝑆item: نقكـ بحساب تباينات الاستبياف كفؽ القانكف التالي- ثانيا 
2 =

  x i−x  2

n
 

 العبارات 
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𝒙
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²(
𝒙
𝟑
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 X1 X2 X3 X4 الأفراد

01 2 2 2 2 0.14 0.14 0.43 0.29 0.196 0.196 0.184 0.084 

02 2 2 1 2 0.14 0.14 -
0.57 

0.29 0.196 0.196 0.324 0.084 

03 2 2 1 2 0.14 0.14 -
0.57 

0.29 0.196 0.196 0.324 0.084 

04 2 2 2 2 0.14 0.14 0.43 0.29 0.196 0.196 0.184 0.084 

05 2 2 2 1 0.14 0.14 0.43 -
0.71 

0.196 0.196 0.184 0.504 

06 2 2 2 2 0.14 0.14 0.43 0.29 0.196 0.196 0.184 0.084 

07 1 1 1 1 -0.86 -0.86 -
0.86 

-
0.71 

0.739 0.739 0.32 0.504 

Ʃ 13 13 11 12     0.857 0.857 1.714 1.424 

المتوسط 
 الحسابً

𝒙  

التباين         1.71 1.57 1.86 1.86
الجزئي 
لمسؤال
01 

التباين 
الجزئي 
لمسؤال
02 

التباين 
الجزئي 
لمسؤال
03 

التباين 
الجزئي 
لمسؤال
04 

 : لدينا 
𝑆1

2 =
0.857

7
= 0.12    𝑆2

2 =
0.857

7
= 0.12     𝑆3

2 =
1.714

7
= 0.24   𝑆4

2 =
2

5
= 0.20 

𝑆𝑇𝑜𝑡𝑎𝑙: نقكـ بحساب الدرجات النيائية لممبحكثيف كفؽ قانكف : ثالثا
2 =

  x i−x  2

n
 

 



 

 
 :(20-معادلة كيكدر كرتشاردسكف)التناسؽ الداخمي نقكـ بحساب : رابعا

 
  قوي فإف ثبات الاستبياف 0.70 كىي أكبر مف 0.80كيكدر كرتشاردسكف تساكم بما أف قيمة معامؿ 

 (2020 ،  وفق طرٌقة كودر رٌتشاردسونالاستبٌانمعامل ثبات عبان، )
 :spssباستخدام (20-معادلة كيودر ورتشاردسون)التناسق الداخميحساب الثبات بطريقة - ب

ثنائية فقط،  (بدائؿ الإجابة)كىك حساب معامؿ ألفا كركنباخ كبنفس الخطكات بشرط أف تككف الاستجابة 
 .فمعامؿ كيكدر كرتشاردسكف ما ىك إلا معامؿ ألفا كركنباخ في حالة بدائؿ إجابة ثنائية

 . 0 كخطأ 1لدينا بدائؿ الإجابة صح : مثاؿ

 
بنفس خطكات  (20-معادلة كيكدر كرتشاردسكف)التناسؽ الداخميالثبات بطريقة في ىذه الحالة نحسب 

 .كطريقة حساب ألفا كركنباخ
 :يجب إتباع الخطوات التالية

Analyze → Scale → Reliability Analysis → items (نضع فييا المتغيرات) → 

Continue → Alpha → Ok 



 

 

 

 

Analyz

e 

Scale 2 

Reliability Analysis 3 

إدخال العبارات 

 Itemلخانة 



 

 
ذا كانت قيمة الثبات أكثر أك يساكم   فإف المقياس 0.70فيظير لنا جدكؿ يكضح لنا قيمة ألفا كركنباخ كا 

 .إذا كجب معالجتو.  إذا المقياس غير ثابت 0.58لدينا في المثاؿ ألفا كركنباخ تساكم . ثابت فيما يقيس

 
 :لكف السؤاؿ المطركح كيؼ أعرؼ السؤاؿ الذم سبب المشكمة كأدل إلى انخفاض الثبات كذلؾ بالتكجو إلى

Analyze → Scale → Reliability Analysis → statistics → Scale if item deleted 

→ Continue → OK 



 

 

 
 :فيظير الجدكؿ التالي Ok ثـ continue ثـ Scale if item deleted نختار ثـ

 



 

نلاحظ أف كؿ  كركنباخ بعد حذؼ ىذه الفقرة، ألفاىذا الجدكؿ يحتكم العبارات ككؿ عبارة يقابميا معامؿ 
فيجب .  إذا نستنتج أف ىذا الاستبياف لا يكجد بو تناسؽ داخمي كغير صالح لمدراسة0.7القيـ أقؿ مف 

 .أعادة صياغتو أك تغييره
  بعد التأكد من الخصائص السيكومترية لأدوات الدراسة باستخدام عينة الدراسة الاستطلاعية،نقوم

عمى عينة الدراسة الأساسية حيث أن عينة الدراسة الأساسية  (الاستبيان)بتوزيع أدوات الدراسة 
 عينة الدراسة –(التي تم اختيارىا في البداية بإحدى الطرق سابقة الذكر)عينة الدراسة = 

 الاستطلاعية 
 معالجة خصائص عينة الدراسة، ومعالجة ).وبعدىا نقوم بالمعالجة الإحصائية لأدوات الدراسة

 (فرضيات الدراسة
 (التكرارات ، الإحصاءات الوصفية)وصف خصائص العينة : المرحمة الخامسة

 :دراسة الخصائص الديمغرافية لمعينة- 1
نقصد بيا مجمكعة المعمكمات حكؿ الأفراد المستيدفيف بالدراسة، بيدؼ تعميؽ معرفتنا لتسيؿ عمينا تحميؿ 

الجنس، : النتائج ككضع التقارير كتساعدنا أساسا في صياغة الفرضيات الفارقية لمدراسة كمف أمثمتيا نجد
 .إلخ.....الخبرة المينية، الحالة الاجتماعية، الحالة الاقتصادية، السف، المستكل التعميمي 

 :كيتـ التطرؽ لمخصائص الديمغرافية مف خلاؿ
 6 سنكات، مف 5أقؿ مف )، الخبرة المينية(ذكر، أنثى)الجنس: مثالتحديد فئات الخاصية : تحديد الفئات- 
 ( سنة15 سنة، أكثر مف 15إلى 
عدد الذككر كعدد : كىي عدد المرات التي تكررت فييا الفئة في الخاصية المدركس مثاؿ: التكرارات- 

 الإناث في خاصية الجنس 
 كىك تكرار تمؾ الفئة مقسكما عمى المجمكع الكمي لمتكرارات: التكرار النسبي- 
 100× النسبة التي تمثميا الفئة في الخاصية المدركسة كىي التكرار النسبي : النسب المئكية- 
 (الخ....دكائر نسبية، أعمدة بيانية)تمثيؿ فئات الخاصية في منحنى بياني - 
 :حساب الخصائص الديمغرافية لمعينة يدويا- أ

 :مثال
 فرد، ككانت كؿ استبانة تحتكم عمى 144قاـ الباحث بتكزيع مجمكعة مف الاستبيانات عمى عينة قدرىا 

 :التساؤلات التالية



 

 :البيانات الشخصية
 (  )أنثى ،   (  )ذكر: الجنس :    الجنس - 

 (  )، جامعي (  )ثانكم ، (  )متكسط ، (  )ابتدائي ، (  )بدكف مستكل : المستكل الدراسي 
. (  ) سنة 15أكثر مف ،  (  ) سنة 15 إلى 05مف ، (  ) سنكات 5أقؿ مف : الخبرة المينية - 

  حساب الخصائص الديمغرافية لمعينة:المطموب
 :الحل

 :بعد استرجاع الاستبيانات كالتحقؽ مف صلاحيتيا تـ إحصاء ما يمي
 نثى   أ21، ركؾ  ذ123: الجنس- 

 .جامعي 27ثانكم،  47، متكسط 32، ابتدائي 28، بدكف مستكل 10 : المستكل الدراسي 
.  سنة15كثر مف  أ24 ،  سنة15 إلى 05مف  81،  سنكات5أقؿ مف  39: الخبرة المينية - 
: توزيع أفراد العينة حسب الجنس- 

 التكرار النسبي التكرارات الجنس

 

النسبة المئوية 
 100× التكرار النسبي = 

.𝟎  123 ذككر 𝟖𝟓𝟒 =
𝟏𝟐𝟑

𝟏𝟒𝟒
 85.4% 

 %14.6 0.146 21 إناث
 % 100 1 144 المجموع

 توزيع أفراد العينة حسب الجنس

 



 

: توزيع أفراد العينة حسب المستوى الدراسي- 

 التكرار النسبي التكرارات المستوى الدراسي

 

النسبة المئوية 
 100× التكرار النسبي = 

 %6.9 0.069 10 دكف مستكل

 %19.4 0.194 28 ابتدائي
 %22.2 0.222 32 متكسط
 %32.6 0.326 47 ثانكم
 %18.8 0.188 27 جامعي
 % 100 1 144 المجموع

يوضح توزيع أفراد العينة حسب المستوى الدراسي 

 

 توزيع أفراد العينة حسب الخبرة المينية  

 التكرار النسبي التكرارات الفئات

 

النسبة المئوية 
 100× التكرار النسبي = 

 %27.1 0.271 39  سنكات5أقؿ مف 
 %56.3 0.563 81  سنة15 إلى 6مف 

 %16.7 0.167 24  سنة15أكثر مف 
 %100 1 144 المجموع



 

 توزيع أفراد العينة حسب الخبرة المينية

 

 :Spssحساب الخصائص الديمغرافية لمعينة باستخدام- ب
 :يجب إتباع الخطكات التالية

Analyze → Descriptive statistics  → Frequencies 

 
: فيظير المربع الحكارم التالي نقكـ فيو بتحديد الخصائص المراد دراستيا كحساب تكراراتيا مثؿ

 .بكاسطة السيـ Variableالجنس، العمر، الأقدمية، المؤىؿ مف خلاؿ تحديدىا كنقميا إلى خانة 



 

 
 

 
 
 
 
 
 

  لاختيار الإحصاءات التي أريدىا كالمتكسط الحسابي كالانحراؼ المعيارم كغيرىاStatisticsثـ نختار 

 
 نختار التمثيؿ البياني الذم أريده كالأعمدة البيانية أك الدائرة النسبية أك الرسكـ Chartsثـ مف خلاؿ خانة 

 Ok ثـ Continue كما ىي ثـ Frequenciesفي حيف تترؾ خانة . البيانية



 

 
فتظير لنا عدة جداكؿ تمخص العينة بالإضافة إلى مجمكعة مف الرسكـ البيانية التي تمثؿ تكزيع أفراد العينة 

 Outputفي صفحة 

 



 

 

 :إيجاد المتوسط الحسابي والانحراف المعياري- 2
:المتوسط الحسابي- 2-1  

يسمى في بعض الأحياف الكسط أك المتكسط أك المعدؿ الحسابي، كىك مف أىـ مقاييس النزعة المركزية 
عمى الإطلاؽ لما يمتاز بو مف سيكلة في استخراجو مف جية كلخضكعو لمعمميات الحسابية مف جية 

أخرل، لذا ينصح بحسابو مع الانحراؼ المعيارم  في بداية أم معالجة إحصائية لأنيما يعطياف نظرة عمى 
 .تكزيع قيـ أفراد العينة مما يساعد عمى عممية تحميؿ النتائج

  xكيعرؼ المتكسط الحسابي عمى أنو مجمكع القيـ مقسكـ عمى عددىا كيرمز لو بالرمز   
 : كيحسب عف طريؽ المعادلة التالية

 :حساب المتوسط الحسابي يدويا- أ
 :مثال تطبيقي

دائما، : ىي (غير مكافؽ-  محايد–مكافؽ ) بدائؿ للإجابة 03ك (فقرات) بنكد 8لدينا استبياف مككف مف 
 .  أفراد10 تـ تكزيعو عمى  عمى الترتيب،1، 2، 3أحيانا، نادرا، تأخذ العلامات 

 . حساب المتكسط الحسابي ليؤلاء الأفراد:المطموب
 
 



 

 
 الأفراد

مجمكع درجات  البنود
 8 7 6 5 4 3 2 1 الأفراد

01 3 1 1 1 1 0 1 2 10 
02 2 2 1 0 1 1 1 1 9 
03 0 1 0 1 1 0 3 1 7 
04 1 1 1 2 1 1 1 1 9 
05 0 1 1 0 0 1 0 1 4 
06 1 1 1 1 0 0 2 1 7 
07 0 1 2 0 1 1 0 1 6 
08 2 1 1 2 1 1 1 1 10 
09 0 1 1 1 0 0 3 1 7 
10 1 1 2 1 1 1 3 1 11 

 Ʃ 79المجمكع 
  xالمتوسط الحسابً

x =  
Ʃ 𝑥𝑖

n
=

هجوْعبلق٘ن الق٘ن

عذد 
=

79
10

= 7.9 

:نحراف المعياريالا- 2-2  

عند استخداـ التبايف كمقياس مف مقاييس التشتت، نجد أنو يعتمد عمى مجمكع مربعات الانحرافات، كمف ثـ 
لا يتمشى ىذا المقياس مع كحدات قياس المتغير محؿ الدراسة، فإذا كاف تبايف سنكات الخبرة في العينة 

 إلى ف سنة تربيع مثلا، لأف كحدات القياس المتغير ىك عدد السنكات، مف أجؿ ذلؾ لجأ الإحصائيي8.5
مقياس منطقي يأخذ في الاعتبار الجذر التربيعي لمتبايف، لكي يناسب كحدات قياس المتغير، كىذا المقياس 

 (63، ص،1999عوض، ).ىك الانحراؼ المعيارم
إذا الانحراؼ المعيارم، ىك الجذر التربيعي المكجب لمتبايف، كيمكف مف خلالو معرفة مدل تشتت القيـ عف 

 :كأف𝑆  متكسطيا الحسابي، فكمما قؿ الانحراؼ المعيارم قؿ التشتت كالعكس صحيح كيرمز لو بػ 

 
 تمثؿ قيـ درجات الأفراد: 𝑥𝑖حيث 



 

x  : تمثؿ المتكسط الحسابي لدرجات الأفراد 
𝑛 : عدد أفراد العينة 

 تفسير نتائج الانحراف المعياري المتحصل عمييا 
 فذلؾ يشير إلى أف القيـ في مجمكعة البيانات قريبة مف بعضيا :(قميل)الانحراف المعياري صغير 

 مف % 10البعض، كيمكف أف نقكؿ مجازا أنو صغير اذا كانت نسبة الانحراؼ المعيارم أقؿ مف 
 . متكسطيا الحسابي كأف التشتت بيف ىذه القيـ قميؿ كمقبكؿ

 يمكف أف نقكؿ مجازا بأنو متكسط اذا كانت نسبة الانحراؼ المعيارم :الانحراف المعياري متوسط 
 .  كىي تشير أف التشتت بيف ىذه القيـ معقكؿ%20  ك%10بيف 

 يمكف أف نقكؿ مجازا بأنو كبير اذا كانت نسبة الانحراؼ المعيارم أكبر :الانحراف المعياري كبير 
 .  كىي تشير أف التشتت بيف ىذه القيـ كبير كغير مقبكؿ%20مف 

  دج 1000 إذا كاف متكسط سعر كيس الدقيؽ المتعارؼ عميو مثلا :مثال توضيحي
 مف المتكسط الحسابي %7 دج كىي تمثؿ نسبة 70 دج بزيادة قدرىا 1070فكجدناه يباع في محؿ بسعر 

 . دج، تعتبر ىذه الزيادة في السعر قميمة كمقبكلة1000
 مف المتكسط % 15 دج كىي تمثؿ زيادة بنسبة 150 دج أم بزيادة قدرىا 1150أما إذا كجدناىا بسعر - 

 .دج، فتعتبر ىذه الزيادة في السعر متكسطة كمقبكلة1000الحسابي 
 مف % 25 دج كىي تمثؿ زيادة بنسبة 250 دج أم بزيادة قدرىا 1250أما إذا كجدناىا بسعر -  

 .دج، فتعتبر ىذه الزيادة في السعر كبيرة  كغير مقبكلة1000المتكسط الحسابي 

الٌسجخ الوئْٗخ: كتحسب نسبة الزيادة بالطريقة الثلاثية =
الاًحشاف الوع٘بسٕ

المتكسط الحسابي
 × 100 

 :حساب الانحراف المعياري يدويا- أ
 :مثال تطبيقي

دائما، : ىي (غير مكافؽ-  محايد–مكافؽ ) بدائؿ للإجابة 03ك (فقرات) بنكد 8لدينا استبياف مككف مف 
 .  أفراد10 تـ تكزيعو عمى  عمى الترتيب،1، 2، 3أحيانا، نادرا، تأخذ العلامات 

 (في المثاؿ السابؽ)قمنا بحساب المتكسط الحسابي . حساب المتكسط الحسابي ليؤلاء الأفراد: المطمكب
 .7.9ككاف يساكم 

 . حساب الانحراؼ المعيارم ليؤلاء الأفراد عف متكسطيـ الحسابي:المطموب



 

 
 الأفراد

مجموع درجات  البنود
 𝑥𝑖الأفراد 

 

 

 

 1 2 3 4 5 6 7 8 
01 3 1 1 1 1 0 1 2 10 2.1 4.41 
02 2 2 1 0 1 1 1 1 9 1.1 1.21 
03 0 1 0 1 1 0 3 1 7 -0.9 0.81 
04 1 1 1 2 1 1 1 1 9 1.1 1.21 
05 0 1 1 0 0 1 0 1 4 -3.7 13.69 
06 1 1 1 1 0 0 2 1 7 -0.9 0.81 
07 0 1 2 0 1 1 0 1 6 -1.9 3.61 
08 2 1 1 2 1 1 1 1 10 2.1 4.41 
09 0 1 1 1 0 0 3 1 7 -0.9 0.81 
10 1 1 2 1 1 1 3 1 11 3.1 9.61 

 Ʃ 79  40.58المجمكع 
المتوسط 
   xالحسابً

  

 : أكلا نطبؽ المعطيات لحساب التبايف  -

𝑠² =
Ʃ(𝑥𝑖−x )²

𝑛−1
=

4.58

10−1
=  معادلة التبايف= 0.50

 
 0.70إذا تنحرؼ قيـ الأفراد عف متكسطيا الحسابي بقيمة 

الٌسجخ الوئْٗخ: حساب نسبة الانحراؼ  =
0.70

7.9
 × 100 =8.86 % 

 % 10إذا نستنتج أف الانحراؼ القيـ عف كسطيا الحسابي كانت قميمة كمعقكلة لأنيا أقؿ مف 

 :Spssحساب المتوسط الحسابي والانحراف المعياري باستخدام- ب
 :يجب إتباع الخطكات التالية

Analyze → Descriptive statistics  → Frequencies 



 

 
فيظير المربع الحكارم التالي نقكـ فيو بتحديد المتغيرات المراد دراستيا كحساب متكسطيا الحسابي 

:  كنأخذ كمثاؿبكاسطة السيـ Variableكانحرافيا المعيارم، مف خلاؿ تحديدىا كنقميا إلى خانة 
 الدرجة الكمية لمتغير الثقافة التنظيمية كبعد الانتماء 

 

 



 

  لاختيار الإحصاءات التي أريدىا كالمتكسط الحسابي كالانحراؼ المعيارمStatisticsثـ نختار 

 
 لنا عدة جداكؿ تكضح المتكسطات الحسابية كالانحرافات المعيارية فزظِشOk  .   ثمContinue ثـ 

 .Outputلمتغير الثقافة التنظيمية كالانتماء التنظيمي في صفحة 

 
 يحتكم عمى المتكسط الحسابي كالانحراؼ المعيارم لممتغيريف : الجدول الأول
 يحتكم عمى بيانات كصفية كالتكرارات كالنسب المئكية لمتغير الانتماء: الجدول الثاني
 يحتكم عمى بيانات كصفية كالتكرارات كالنسب المئكية لمتغير الثقافة التنظيمية: الجدول الثالث



 

 المعالجة الإحصائية لفرضيات الدراسة: المرحمة السادسة
لكي نقكـ بمعالجة أم فرضية كانت أف يجب نختار الأسمكب الإحصائي مناسب ليا، كلكي نختار الأسمكب 

الإحصائي المناسب ليا يجب أف نتبع خطكات منيجية، يتـ مف خلاؿ ىذه الخطكات تحديد الأسمكب 
 .الإحصائي المناسب

 خطوات المعالجة الإحصائية- 1

تتعدد كتترتب كفؽ ترابط تسمسمي المراحؿ التي يتـ مف خلاليا إجراء تحميؿ إحصائي لمبيانات، كيتكجب 
عمى الباحث أف يتبع كافة المراحؿ بشكؿ تسمسمي كتتابعي، كتككف خطكات كمراحؿ إجراء تحميؿ إحصائي 

تماـ خطكات المعالجة المبتدئة كالتمييدية  .لمبيانات مف خلاؿ إجراء كا 

يتـ إجراء تحميؿ إحصائي لمبيانات مف خلاؿ إعداد التحميؿ الكصفي لمجمكعة البيانات مف خلاليا حساب 
 .مجمكعة مف المقاييس الإحصائية المتنكعة كالمختمفة

 اليدف من الدراسةتحذيذ : 01الخطوة 

، لأف كؿ دراسة لدييا الأسمكب أكؿ سؤاؿ يطرح ىك اليدؼ طبيعة الدراسة ىؿ الدراسة ارتباطية أك فرقية
 .الإحصائي الخاص بيا

  (.....علاقة، اثر، سبب، تنبؤيو)دراسة ارتباطية 
  (.....فركؽ، اختلاؼ، تشابو)دراسة فرقية 

  (..........مستكل)دراسة المستكل 
 تحديد مستوى القياس: 02الخطوة 

إلى دائما رقية ننظر ا، في الدراسات الؼ أك نسبيتحديد مستكل القياس ىؿ ىك اسمي أك رتبي أك فئكم
 . فننظر لممتغيريفيةالمتغير التابع أما في الدراسات الارتباط

 مستويات القياس: 

يمكف التعبير عف البيانات التي نجمعيا بالقياس أك الملاحظة بأحد المستكيات التالية، كيتكقؼ ذلؾ عمى 
طبيعة المتغير، فبعض المتغيرات لا يمكف أف تأخذ إلا قيمتيف، كىي بالتالي تصنؼ في مجمكعتيف كتقع 

 مف قيمو، كيعبر عنيا بأرقاـ فتقع في المستكل أكثربعض المتغيرات يمكنيا اخذ . في المستكل الاسمي
الرتبي أك النسبي أكثر مستكيات قياس دقة، كطكؿ القامة الذم يعبر عنو كميا أك بترتيب أفراد المجمكعة 

 :حسب الطكؿ، كمستكيات القياس مف الأبسط إلى الأكثر دقة كالتالي
  (نوعي)(تصنيفي)المستوى الاسمي   



 

يساعد عمى التمييز فقط كالجنس كلكف العينيف، في ىذا يعبر فيو عف المتغير بصفات فيك بالتالي نكعي ك
تستخدـ المستكل يمكف أف تعطى لمصفات أرقاـ، غير أف ىذه الأرقاـ لا تسمح بإجراء عمميات حسابية أم 

 . فقطالأشياءفيو الأعداد لتصنيؼ 

 أرقاـ الكلايات- أرقاـ السيارات- أرقاـ الشكارع - أنثي 2=ذكر =1: مثاؿ
 (الترتيبي)المستوى الرتبي 

، في ىذا المستكل تؤدم الأرقاـ كظيفة التمييز لكنيا أكثر دقة  فيو عف المتغير برتب تصاعديا أك تنازلياٗعجش
، أم أف الرقـ دكره ترتيب دمنيا في المستكل الاسمي، فيي تعطي فكرة عف مكقع الفرد بالنسبة إلى بقية الأفرا

 .الأشياء فقط

 ترتيب معدلات التلاميذ تصاعديا أك تنازليا:مثال

  (الكمي)(المسافات المتساوية)المستوى الفئوي 

كأغمب المتغيرات تقاس عند ىذا المستكل يعبر فيو عف المتغير بقيـ عددية كأف المسافات بيف ىذه القيـ متساكية 
  ثل ُْ افزشاضٖ، إٔ أًَ لا ٗعجش عي غ٘بة الظبُشح الصفر فيو غير حقيقيكما أف 

طالب متحصؿ عمى صفر في الإحصاء لا يعني اف ىذا الطالب ليس لو معمكمات في كحدة : 1مثال
 .الإحصاء

نما اصطلاحا تـ تسمية ىذه بالدرجة تعني انعداـ الحرارة درجة الحرارة صفر لا :2مثال   0 كا 

 المستوى النسبي   

كينطمؽ ىذا المستكل مف الصفر الحقيقي الذم يشير إلى الغياب الفعمي لمظاىرة كىك أدؽ مستكيات القياس 
 مع المستكل الذم سبقو كيمكف أف نستخدـ كفيو الصفر حقيقي كيستعمؿ جميع العمميات الحسابيةالمدركسة 

 .النسبة أيضا
، كانعداـ الطكؿ أك العمميات ( حقيقي0) أم لا يكجد حقيقة  مادة النيككتيف في دـ الرياضيانعداـ:مثال

 (17،ص،2011بوحفص،) .الحسابية الصفر فييا حقيقي

 تحديد نوع الإحصاء :03الخطوة 

، كيتـ تحديد نكع الإحصاء (اللامعممي)لابرامترمإحصاء  أك (المعممي)  برامترمالإحصاء ىك إحصاءىؿ 
مف خلاؿ مستكل القياس الذم تـ تحديده، كلكؿ إحصاء أساليب إحصائية خاصة بو، كنسعى دائما إلى 

لأنو الأدؽ، كنضطر إلى استخداـ الإحصاء اللابرامترم (المعممي)استخداـ الإحصاء البرامترم 
 (المعممي)كالذم يعتبر بديلا لو في حالة عدـ تتحقؽ شركط الإحصاء البرامترم(اللامعممي)



 

  (اللامعممي)لابرامترمفإف الإحصاء يككف رتبي  كأاسمي فإرا كبى هسزْٓ الق٘بس 
  (المعممي) برامترمفإف الإحصاء يككفالنسبي  كأالفئكم أهب إرا كبى هسزْٓ الق٘بس 
 اللابرامترمالتكزيع الطبيعي، أف  تككف البيانات كاضحة المعالـ كالشكؿ اعتدالي أم الإحصاء البرامترمفي 
 .يعتمد عمى التكزيع الطبيعي لا

 تحديد عدد المجموعات: 04الخطوة 

كـ مجمكعة يتككف منيا المتغير 
 مجمكعتيف 02 (ذكر، أنثى):ثالم

 مجمكعات 03 (أساتذة، إدارييف، عماؿ)

 تحديد طبيعة المجموعات: 05الخطوة 

 أك ذات تقسيـ غير حقيقيحقيقي مترابطة أك مستقمة كىؿ ىي ذات تقسيـ المجمكعات المككنة لممتغير ىؿ 

 :مثال

  نقكـ بقياس قبمي ثـ قياس بعدم بعد تطبيؽ برنامج معيف، ك نفس العينة تككف: مترابطةمجموعات
 .كمجمكعة الذككر كمجمكعة الإناث. أم أنيا نفس المجمكعة كلكؿ فرد درجتيف مف القياس

  في ىذه الحالة لا علاقة لممجمكعتيف ببعضيما البعض، ككؿ منيما مستقمة  :مستقمةمجموعات
 كمجمكعة الذككر .عف الأخرل، أم أنو لا تكجد إلا درجة كاحدة مف القياس لكؿ فرد في المجمكعة

 كمجمكعة الإناث

 التدخيف  (ذكر،أنثى) الجنسمثلىك التقسيـ الطبيعي الذم لا يتحكـ فيو الباحث :التقسيم حقيقي ،
، لا يمكف التحكـ في ىذا التقسيـ مف طرؼ الباحث حتى كلك أراد ذلؾ أم لا (يدخف ، لا يدخف)

 .يكجد احتماؿ آخر ليذا التقسيـ

 مثؿ .ىك التقسيـ الذم يتحكـ فيو الباحث كمف اختياره لتحقيؽ أىداؼ الدراسة:التقسيم غير حقيقي
إلخ ....، (ابتدائي ،متكسط ثانكم)أك  (جامعي، غير جامعي)المستكل التعميمي ممكف أف يدرس 

 .يتحكـ فييا كيختار ما يريد دراستو لتحقيؽ أىداؼ بحثو

 التحقق من شروط الإحصاء البرامتري - 2
الإحصاء البرامترم ىك الإحصاء الأكثر دقة، لذا نسعى دائما لاستخدامو في المعالجة الإحصائية 

ف اختؿ أحد ىذه الشركط فلا يمكف  لمفرضيات، كلكي نستخدمو يجب أف تتحقؽ مجمكعة مف الشركط كا 
 تطبيقو كنستخدـ الإحصاء البديؿ كىك الإحصاء اللابرامترم

 شروط الإحصاء البرامتري: 



 

 التي إف لـ تتحقؽ ترجع إلى الإحصاء اللابرامترم

 ّل٘سذ أعذاد إٔ الوزغ٘شاد كلِب كو٘خٗعجش عٌِب ثأسقبم :البياناث كميت- أ

ٗوكي رعو٘ن الٌزبئج ُّٖ أحسي طشٗقخ إٔ أى اخز٘بس العٌ٘خ ٗكْى ثبلطشٗقخ العشْائ٘خ لكٖ :العشوائيت- ب

 لزوث٘ل العٌ٘خ

 إٔ الج٘بًبد رزجع الزْصٗع الطج٘عٖ ّّاضحخ الوعبلن ّشكلِب اعزذالٖ علٔ شكل ًبقْس :التوزيع طبيعي- ث

 (قْسذ)

 .ّالسوبد فٖ الخصبئص هبثلالذ:أفراد العينتتجانس - ث

  بعد التأكد أن بيانات المتغيرات كمية وأن العينة عينة عشوائية وأن أفراد العينة متجانسون، يبقى
 . أن نتأكد بأن البيانات تتبع التوزيع الطبيعي

 اختبار التوزيع الطبيعي لمبيانات: 
اختبار -  اختبار شابيرك كيمؾ–اختبار ككلمكجركؼ سميرنكؼ: ىناؾ اختبارات لمتكزيع الطبيعي منيا 

 كيتـ استخدامو في حالة عينة كولموجروف سميرنوفسنستخدـ أشيرىـ كىك اختبار ......الالتكاء كالتفمطح
 :كاحدة كما يمي

 التكرار المتكقع المتجمع الصاعد النسبي- التكرار الملاحظ المتجمع الصاعد النسبي 
ثـ نقكـ باختيار القيمة المطمقة الأكبر ليذا الفرؽ كمقارنيا بالقيمة الحرجة لجدكؿ الدلالة الإحصائية 

لككلمكجركؼ سميرنكؼ، فإذا كانت المحسكبة أقؿ تماما مف القيمة الجدكلية فإننا نقبؿ الفرض الصفرم 
كالعكس . كنرفض البديؿ كنستنتج أف بيانات العينة تتبع التكزيع الطبيعي كيمكف استخداـ الإحصاء البرامترم

فإذا كانت المحسكبة أكبر تماما مف القيمة الجدكلية فإننا نرفض الفرض الصفرم كنقبؿ البديؿ .صحيح 
كنستنتج أف بيانات العينة لا تتبع التكزيع الطبيعي كلا يمكف استخداـ الإحصاء البرامترم كنستخدـ الإحصاء 

 .البديؿ كىك الإحصاء اللابرامترم
 :التأكد بأن البيانات تتبع التوزيع الطبيعي يدويا- أ

 :مثال تطبيقي
 بتطبيؽ اختبار 0.05لدينا البيانات التالية كنريد التأكد ىؿ تتبع التكزيع الطبيعي أك لا عند مستكل الدلالة 

 .لككلمكجركؼ سميرنكؼ كنستخدـ التكرارات



 

 
مف الفرؽ بيف التكرار الملاحظ المتجمع الصاعد  (أم نتخمص مف الإشارة السالبة)نأخذ أكبر قيمة مطمقة 

 (القيمة المحسكبة) 0.24كالتكرار المتكقع المتجمع الصاعد النسبي كىي 
 كحجـ العينة 0.05لاختبار ككلمكجركؼ سيمرنكؼ عند مستكل الدلالة  (الجدكلية)نستخرج القيمة الحرجة 

 > 0.24)نلاحظ القيمة المحسكبة أقؿ تماما مف القيمة الجدكلية . 0.318نجدىا تساكم . (التكرارات) 17
، فإننا نقبؿ الفرض الصفرم كنرفض البديؿ كنستنتج أف بيانات العينة تتبع التكزيع الطبيعي، (0.318

 .كبالتالي يمكننا استخداـ الإحصاء البرامترم
 ويمكن تمثيميا بيانيا بيذا الشكل

 
 :Spssالتأكد بأن البيانات تتبع التوزيع الطبيعي باستخدام - ب

 يجب أف نتبع الخطكات التالية. سميرنوف- كولموجروف لمتأكد مف التكزيع الطبيعي باستخداـ اختبار 
Analyze → Descriptive statistics  → Explore 



 

 

فيظير المربع الحكارم التالي نقكـ فيو بتحديد المتغير المراد دراستو كالتأكد مف التكزيع الطبيعي لبياناتو 
 فيظير مربع Plots، ثـ اختيار أمر Dependent Listكليكف متغير الثقافة التنظيمية مثلا إلى خانة 

 Ok  ثـ Continue  ثنNormality plots with test  حكارم آخر نؤشر فيو عمى  

 



 

 
 لنا عدة جداكؿ تكضح المتكسطات الحسابية كالانحرافات المعيارية لمتغير الثقافة التنظيمية كالانتماء فزظِش

 .Outputالتنظيمي في صفحة 

 

 
  يعطياف بعض المعمكمات كالخصائص الكصفية كالمتكسط الحسابي كغيرىا:الجدول الأول والثاني

 كبدرجة 0.241 كقيمتو ىنا  سميرنوف–كولموجروف  كىك الميـ كالذم يعطي اختبار :الجدول الثالث
 0.00 كمستكل دلالة الإحصائية مقدرة بػ 76حرية 



 

 كفي ىذه الحالة نرفض الفرض الصفرم كنقبؿ 0.05 أقؿ مف 0.00كنلاحظ أف مستكل الدلالة ىنا - 
 .البديؿ التي تقكؿ بأف البيانات لا تتبع التكزيع الطبيعي

الذم نستخدمو إذا كانت العينة أقؿ مف )Shapiro-Wilk كنلاحظ أيضا أف البرنامج أعطى لنا قيمة - 
30) 
 :كنلاحظ أيضا أف البرنامج أعطى لنا مجمكعة مف الرسكـ البيانية أىميا - 

كالعكس صحيح . التكزيع الطبيعي لمبكاقي كالذم تككف فيو النقاط بمحاذاة الخط في حالة التكزيع الطبيعي
 .كما في حالتنا

 

 
بعد التأكد بأن البيانات تتبع التوزيع الطبيعي يمكن معالجة الفرضيات إحصائيا باستخدام 

 (المعممي)الإحصاء البرامتري 



 

 :معالجة الفرضيات- 3
 كيفية المعالجة الإحصائية لمفرضيات العلائقية واختيار الأسموب الإحصائي المناسب-3-1

 : الحالة الأولى
 متغير تابع كمي+ متغير مستقل كمي + علاقة ارتباطية 

 (علاقة ارتباطية بيف متغيريف كمييف كجميع شركط الإحصاء البرامترم محققة)
 في ىذه الحالة نستخدم معامل الارتباط بيرسون

 :(r)معامل الارتباط بيرسون - 1
بيف الارتباطية  في الحياة الدراسية العممية لدراسة العلاقة كالإحصائييفكثيرا ما يحتاج الطمبة كالباحثكف 

ظاىرتيف أك بيف متغيريف لمعرفة درجة كنكع الارتباط بينيما، فقد يريد الباحث معرفو إذا كانت ىناؾ علاقة 
العلاقة بيف الذكاء كقكة الانتباه، أك بيف درجة التحصيؿ كدرجة التركيز كقد يسعى باحث : بيف متغيريف مثؿ

دراسة العلاقة بيف الذكاء كقكة الانتباه، : مثؿ. آخر إلى دراسة العلاقة بيف أكثر مف متغيريف في كقت كاحد
معامؿ الارتباط بيرسكف البسيط لدراسة العلاقة بيف متغيريف كمييف أك معامؿ كىذا ما يتطمب استعماؿ 

 مف الارتباط البسيط ا ىناؾ نكعيفذا.الارتباط بيرسكف المتعدد لدراسة العلاقة بيف أكثر مف متغيريف كمييف
 .كالمتعدد

 : الارتباط بيرسون البسيط- 2

 لدراسة العلاقة بيف متغيريف كمييف: مثال عن فرضية الارتباط بيرسون البسيط

 

 :أنواع العلاقة بين المتغيرات- 3  
 : اتجاه العلاقة- أ

ىناؾ علاقة مكجبة كىناؾ علاقة سالبة، فإذا تحصمنا عمى قيمة مكجبة لمعامؿ الارتباط دؿ ذلؾ عمى كجكد 
  كالعكس صحيحY تككف متبكعة بالزيادة في المتغيرXعلاقة طردية، أم أف الزيادة في المتغير 

 :قوة العلاقة- ب



 

، فإذا قيمة معامؿ الارتباط تساكم (1)+ك  (1-)في أغمب معاملات الارتباط تنحصر قيمة ىذا المعامؿ 
فمعنى ذلؾ أف الارتباط بيف المتغيريف طردم تاـ، كىك أقكل أنكاع الارتباط الطردم بيف المتغيريف،  (1+)

ذا كانت قيمة معامؿ الارتباط تساكم  فمعنى ذلؾ أف الارتباط بيف المتغيريف عكسي تاـ، كىك أقكل  (1-)كا 
 أف تككف القيمة صفرية; كذلؾ يؤدم إلى أنو لا يكجد علاقة مف كيمكف، أنكاع الارتباط العكسي

 ( 128،ص،2010فلاح وغرايبية،).الأساس

  المتحصؿ عمييا نعتمد  عمى ىذا التدريج 𝑟 لتفسير قيمة :𝑟لتفسير النتيجة

 
كىك أحد المؤشرات الإحصائية البرامترم لدراسة قكة كاتجاه العلاقة بيف  (r)يرمز ليذا المعامؿ بحرؼ 

 .أحدىما مستقؿ كالآخر تابع (Y.X)متغيريف كمييف 
 : كأسيؿ طريقة كالأكثر استخداما ىي طريقة الدرجات الخاـ كىي كالتالي

 
:  حيث أف

X :  درجات المتغير المستقؿ
Y : درجات المتغير التابع 
X²Ʃ :  مجمكع مربعات درجات المتغير المستقؿ
Y²Ʃ :  مجمكع مربعات درجات المتغير التابع
²(XƩ) :  مربع مجمكع درجات المتغير المستقؿ
²(YƩ) :  مربع مجمكع درجات المتغير التابع
n :  عدد أفراد العينة
 :حساب معامل بيرسون البسيط يدويا- 4

 :مثال تطبيقي
لدراسة العلاقة الارتباطية بيف الذكاء كقكة الانتباه قمنا بتكزيع كتصحيح الاستبيانيف عمى عينة متككنة مف 

 :  أفراد فكانت النتائج كالتالي10
 حساب معامؿ الارتباط بيف ىاذيف المتغيريف كتفسير النتيجة المتحصؿ عمييا : المطمكب



 

 :الحل
 Y قيـ متغير الذكاء ك Xنقكـ بتفريغ نتائج الاستبيانيف في الجدكؿ التالي حيث يمثؿ

  قيـ متغير قكة الانتباه
 X الأفراد

 الذكاء
Y 

 قكة الانتباه
X y 

 
X² Y² 

01 3 2 6 9 4 
02 3 3 9 9 9 
03 2 2 4 4 4 
04 4 3 12 16 9 
05 2 2 4 4 4 
06 3 3 9 9 9 
07 3 2 6 9 4 
08 4 3 12 16 9 
09 2 2 4 4 4 
10 4 4 16 16 16 
Ʃ 30 26 82 96 72 

:  نقكـ بحساب معامؿ الارتباط بيرسكف بيف المتغيريف مف خلاؿ تعكيض القيـ في معادلة الارتباط التالية*

 

 (بناءا عمى التدريج السابؽ) نستنتج أنو يكجد ارتباط طردم قكم 𝑟 مف خلاؿ قيمة :تفسير النتيجة

 :Spssحساب معامل بيرسون البسيط باستخدام- 5
 :لحساب معامؿ الارتباط بيرسكف نتبع الخطكات التالية

Analyze → Correlate →Bivarite 



 

المراد حساب ارتباطيا إلى  (بعد الانتماء، الثقافة التنظيمية)فيظير مربع حكارم نقكـ فيو بنقؿ المتغيريف 
 .Ok ثـ  Person ثـ نختار Variableخانة 

 

 

 .Output لنا جدكؿ يكضح قيمة معامؿ الارتباط كقيمة مستكل الدلالة الإحصائية في صفحة فزظِش



 

 
 :فتظير مجمكعة مف القيـ أىميا

Sig = 0.00 إذا ىذا الارتباط داؿ إحصائيا0.05 الدلالة الإحصائية لمعامؿ الارتباط كىي أقؿ مف  
R = 0.99قيمة معامؿ الارتباط كىك ارتباط طردم قكم جدا كشبو تاـ  

 ، أبحث عف اتجاه كقكة ىذا الارتباط(Sigمف خلاؿ قيمة )إذا كاف ىناؾ ارتباط ذك إحصائية 
  فيذا يدؿ عمى أف الارتباط داؿ إحصائياSig ≥ 0.05إذا كانت 
  فيذا يدؿ عمى أف الارتباط غير داؿ إحصائياSig > 0.05إذا كانت 

 : الحالة الثانية
 متغير تابع كمي+  كمي 2متغير مستقل+ كمي1متغير مستقل+ علاقة ارتباطية 

 (علاقة ارتباطية بيف أكثر مف متغيريف كمييف كجميع شركط الإحصاء البرامترم محققة)
  المتعددفي ىذه الحالة نستخدم معامل الارتباط بيرسون

 :الارتباط بيرسون المتعدد- 1
 كىك نفسو البسيط إلا أنو يستخدـ لدراسة العلاقة بيف أكثر مف متغيريف كمييف

 :مثال عن فرضية الارتباط المتعدد

 

 :حساب معامل بيرسون المتعدد يدويا- 2
ىك معامؿ يقيس العلاقة الارتباطية بيف أكثر مف متغيريف كمييف كلو نفس شركط معامؿ الارتباط 

 .(شركط الإحصاء البرامترم)البسيط 



 

:  يتـ حسابو مف خلاؿ  قانكف الارتباط المتعدد التالي

𝑟1.2.3 =  
 𝑟1.2 2+ 𝑟1.3 2−2×𝑟1.2×𝑟1.3×𝑟2.3

1−(𝑟2.3)²
 

𝑟1.2.3 :ارتباط جميع المتغيرات 
𝑟1.2 : 2 كالمتغير 1الارتباؾ بيف المتغير 
𝑟1.3 : 3 كالمتغير 1الارتباؾ بيف المتغير 
𝑟2.3 : 3 كالمتغير 2الارتباؾ بيف المتغير 

 :مثال تطبيقي
قمنا بتكزيع  ( 𝑥3)كالتحصيؿ الدراسي  ( 𝑥2)كقكة الانتباه  (𝑥1)لدراسة العلاقة الارتباطية بيف الذكاء 

 :  أفراد فكانت النتائج كالتالي10كتصحيح الاستبيانات عمى عينة متككنة مف 
 . حساب معامؿ الارتباط بيف ىاتو المتغيرات كتفسير النتيجة المتحصؿ عمييا:المطموب
 10 09 08 07 06 05 04 03 02 01 الأفراد

𝒙𝟏 3 3 2 4 2 3 3 4 2 4 
𝒙𝟐 2 3 2 3 2 3 3 3 2 4 
𝒙𝟑 3 3 2 3 3 4 2 4 3 3 

  أكلا نقكـ بحساب معامؿ الارتباط البسيط بيف𝑥1 الذكاء ك𝑥2قكة الانتباه بنفس الطريقة السابقة 
  الأفراد

 الذكاء
 

 قكة الانتباه
 𝑥1² 𝑥2² 

01 3 2 6 9 4 
02 3 3 9 9 9 
03 2 2 4 4 4 
04 4 3 12 16 9 
05 2 2 4 4 4 
06 3 3 9 9 9 
07 3 2 6 9 4 
08 4 3 12 16 9 
09 2 2 4 4 4 
10 4 4 16 16 16 



 

Ʃ 30 26 82 96 72 

 
  ثانيا نقكـ بحساب معامؿ الارتباط البسيط بيف𝑥1 الذكاء ك𝑥3  التحصيؿ الدراسي بنفس الطريقة 

 السابقة

 
  ثالثا نقكـ بحساب معامؿ الارتباط البسيط بيف𝑥2 قكة الانتباه ك 𝑥3 التحصيؿ الدراسي بنفس 

 الطريقة السابقة



 

 

 
 :إذا لدينا 

 

 (بناءا عمى التدريج السابؽ) نستنتج أنو يكجد ارتباط طردم متكسط 𝑟 مف خلاؿ قيمة :تفسير النتيجة

 :Spssحساب معامل بيرسون المتعدد باستخدام- 3
، ءقيـ الانتما)بيف المتغيريف المستقميف  (الارتباط بيف عدة متغيرات)لحساب معامؿ الارتباط بيرسكف المتعدد

 :نتبع الخطكات التالية( المكاطنة التنظيمية)كالمتغير التابع  (قيـ العدالة



 

Analyze → Regression →Linear 

 

إلى خانة  ( ، قيـ العدالةءقيـ الانتما)فيظير مربع حكارم نقكـ فيو بنقؿ المتغيريف المستقميف 
Independent كنقكـ بنقؿ المتغير التابع إلى خانة  Dependent ثـ Ok. 

 

 Output لنا جدكؿ يكضح قيمة معامؿ الارتباط المتعدد بيف متغيرات الدراسة في صفحة فزظِش



 

 

𝐑𝟏.𝟐.𝟑  نلاحظ مف خلاؿ الجدكؿ أف قيمة عامؿ الارتباط المتعدد  = 𝟎. 𝟎𝟕𝟏 
 كىذا يعني أنو تكجد علاقة ضعيفة جدا كشبو معدكمة بيف قيـ الانتماء كقيـ العدالة كمتغير المكاطنة 

 . مف المتغير التابع % 0.008كاف المتغيرات المستقمة تفسر ما قيمتو .التنظيمية
 الحالة الثالثة 

 متغير تابع كمي+ متغير مستقل كمي + علاقة تأثير 
 (علاقة تأثير بيف متغيريف كمييف كجميع شركط الإحصاء البرامترم محققة)

 في ىذه الحالة نستخدم معامل الانحدار البسيط
  :معامل الانحدار البسيط - 1

  الانحدار البسيط مثال عن فرضية

 
 متغير تأثيرالأسمكب الإحصائي المناسب لمعالجة ىذه الفرضية ىك معامؿ الانحدار البسيط، لأنو يقيس 

 (مع كجكب تحقؽ شركط الإحصاء البرامترم)مستقؿ عمى متغير تابع 
يستخدم معامل الانحدار البسيط أو المتعدد إذا وجدت كممة أثر أو تأثير أو ما يدل عمييا : ملاحظة

 .الخ، بين المتغيرات مع تحقق شروط الإحصاء البرامتري...دور ، تنبؤ:مثل
رغبة ؿكىك معامؿ يقيس درجة التنبؤ بالمتغير التابع بناءا عمى درجات المتغير المستقؿ، كندرس الانحدار 
الباحث في عدـ دراسة قكة الارتباط بيف المتغيريف فقط بؿ الحصكؿ عمى صكرة رياضية لمعلاقة بيف 



 

 تفسر مدل تأثير المتغير المستقؿ عمى التابع y=a + bxالمتغيريف عمى شكؿ معادلة مف الدرجة الأكلى 
 .كالتي يمكف مف خلاليا التنبؤ بقيمة المتغير التابع بناءا عمى قيمة المتغير المستقؿ

 كانت ىناؾ xإذا كانت قيمة معامؿ الانحدار مكجبة ىذا يعني أنو كمما كانت زيادة في المتغير المستقؿ - 
 .b بقيمة yنقصاف في المتغير التابع 

 عمى المتغير xأما إذا كانت قيمة معامؿ الانحدار معدكمة فيذا يعني أنو لا يكجد تأثير لممتغير المستقؿ - 
 .yالتابع 

 :كيمكف تقسيـ الانحدار حسب عدد المتغيرات الداخمة فيو إلى نكعيف

 كىذا يناسب الحالات التي يرتبط فييا متغيرات بعلاقة خطية، حيث يتـ التنبؤ :الانحدار الخطي البسيط
 .بأحدىما مف معرفة الآخر كبالاستفادة مف معادلة الخط المستقيـ

 y=a + bx: كيسحب مف خلاؿ المعادلة التالية
y : تمثؿ قيـ المتغير التابع 
x : تمثؿ قيـ المتغير المستقؿ 
a :تمثؿ ثابت الانحدار كىي قيمةy عندما x=0كيمكف حسابيا عف طريؽ المعادلة التالية  : 

 
𝑦  :  ،ىك المتكسط الحسابي لممتغير التابع𝑥  :ىك المتكسط الحسابي لممتغير المستقؿ 

b : تمثؿ ميؿ الانحدار كتدؿ عمى مقدار التغير في القيـ المقدرة لممتغيرy كيمكف حسابيا عف طريؽ 

𝑏: المعادلة التالية =
 𝑥𝑦−𝑛𝑥 𝑦 

 𝑥
2
−𝑛 𝑥  ²

 

 :حساب معامل الانحدار البسيط يدويا- 2
 :مثال تطبيقي

 أفراد 10لدراسة أثر الذكاء عمى قكة الانتباه قمنا بتكزيع كتصحيح الاستبيانيف عمى عينة متككنة مف 
 : فكانت النتائج كالتالي

 حساب معامؿ الانحدار بيف ىاذيف المتغيريف كتفسير النتيجة المتحصؿ عمييا : المطمكب
 :الحل

 Y قيـ متغير الذكاء ك Xنقكـ بتفريغ نتائج الاستبيانيف في الجدكؿ التالي حيث يمثؿ 
  قيـ متغير قكة الانتباه

 X Y X y X² الأفراد



 

  قكة الانتباه الذكاء
01 3 2 6 9 
02 3 3 9 9 
03 2 2 4 4 
04 4 3 12 16 
05 2 2 4 4 
06 3 3 9 9 
07 3 2 6 9 
08 4 3 12 16 
09 2 2 4 4 
10 4 4 16 16 
Ʃ 30 26 82 96 

المتوسط 

 الحسابي
𝒙 =30÷10=3 𝒚 =26÷10=2.6   

 y=a + bx:  نقكـ بحساب معامؿ الانحدار مف خلاؿ المعادلة التالية

:  بالمعادلة التالية كبتعكيض المعطيات المكجكدة في الجدكؿbأكلا نقكـ بحساب قيمة 

𝑏 =
 𝑥𝑦−𝑛𝑥 𝑦 

 𝑥
2
−𝑛 𝑥  ²

=
82−10×3×2.6

96−10×3²
=

4

6
= 0.66 

 :بالمعادلة التالية كبتعكيض المعطيات المكجكدة في الجدكؿ𝑎 ثانيا نقكـ بحساب قيمة 

 
 y=0.62 + 0.66 x:  : إذا معادلة الانحدار تككف كالتالي

 x لدينا قيمة معامؿ الانحدار مكجبة ىذا يعني أنو كمما كانت زيادة في المتغير المستقؿ :تفسير النتيجة
 .0.66 بقيمة yكانت ىناؾ زيادة  في المتغير التابع 

 :Spssحساب معامل الانحدار البسيط باستخدام - 3
عمى متغير  (الثقافة التنظيمية)لحساب معامؿ الانحدار الخطي البسيط لدراسة مدل تأثير متغير مستقؿ 

 :نتبع الخطكات التالية (المكاطنة التنظيمية)تابع 
 ننشأ لكحة الانتشار عف طريؽ : أولا 

Graphs → Legacy Dialog →Scatter/Dot → Simple Scatter 



 

 Xنضع المتغير المستقؿ في 
 Ok ثـ نضغط Yكنضع المتغير التابع في 

 ثـ at total  Fit Lineثن  Elementsتظير لنا لكحة الانتشار ثـ ننقر نقر مزدكج ثـ نضغط 
Okفيظير الخط المائؿ كىك خط الانحدار بالإضافة إلى معادلة الانحدار ، 

 

 

 
 
 



 

 
 
 
 
 

 
 
 
 
 
 

 
 : لمتحميؿ نقكـ بما يمي:ثانيا

Analyze → Regression →Linear 

 

 Independentإلى خانة  (الثقافة التنظيمية)فيظير مربع حكارم نقكـ فيو بنقؿ المتغير المستقؿ 
 .Ok ثـ Dependent إلى خانة  (المكاطنة التنظيمية)كنقكـ بنقؿ المتغير التابع 



 

 
 Descriptives لٌخزبس ثعض الإحصبءاد الْصف٘خ الزٖ ًحزبجِب فٌخزبس Statisticsثن ًضغظ علٔ 

  Continueثن  (هعبهل الاًحذاس الوقذس) Estimatesثن ًخزبس 

 

 

 Y ًٌّقلِب لخبًخ ZRESID ، ًّخزبس X ًٌّقلِب لخبًخ ZPRED ًّخزبس Plotsثن ًزُت إلٔ 

 Ok ثن Continue ثن Normal probability plotثن ًخزبس أُن شٖء 



 

 

 Output لنا عدة جداكؿ في صفحة فزظِش
 يكضح المتكسط الحسابي كالانحراؼ المعيارم: الجدول الأول

 

 Sigيكضح معامؿ الارتباط بيرسكف بيف المتغيريف ك قيمة الدلالة الإحصائية : الجدول الثاني
  كىذا يدؿ عمى كجكد ارتباط طردم قكم جداR=0.94نلاحظ مف خلاؿ الجدكؿ أف معامؿ بيرسكف 

 . مما يدؿ عمى أنو داؿ إحصائيا0.05 كىي أقؿ مف Sig = 0.00كأف قيمة 

 



 

 : يحتكم عمى Model Summaryجدكؿ : الجدول الثالث
R :معامؿ الارتباط 

R Square : مربع معامؿ الارتباط لمعرفة نسبة تبايف المتغير التابع لمتنبؤ بالمتغير المستقؿ كفي ىذه
%  90الحالة لدينا نسبة 

Adjusted R Square :المربع المعدؿ 
Std . Error of the Estimate :الخطأ في التقدير 

 

 Anova جدكؿ :الجدول الرابع
 نرفض الفرض الصفرم كنقبؿ البديؿ Sig < 0.05 إذا كانت Sigفي ىذا الجدكؿ نلاحظ مباشرة قيمة 

 فإننا نقبؿ الفرض الصفرم كنرفض البديؿ ، كفي مثالنا ىذا نلاحظ Sig > 0.05أما إذا كانت قيمة 
الثقافة ) كبالتالي فإننا نؤكد عمى كجكد أثر لممتغير المستقؿ 0.05 كىي أقؿ مف Sig =0.00أف 

 (المكاطنة التنظيمية)عمى المتغير التابع  (التنظيمية

 

 Coefficientsجدكؿ : الجدول الخامس
𝑦يحتكم ىذا الجدكؿ عمى معامؿ خط الانحدار  = 𝑎 + 𝑏𝑥 

 : السفمية  كمنو فإف معادلة خط الانحدار في ىذا المثاؿ تككف كالتاليb العمكية كقيمة aنشاىد قيمة 

 



 

 
 : الحالة الرابعة

 متغير كمي+ متغير كمي + متغير كمي + علاقة تأثير 
 (علاقة تأثير بيف أكثر مف متغيريف كمييف كجميع شركط الإحصاء البرامترم محققة)

 في ىذه الحالة نستخدم معامل الانحدار المتعدد
  :معامل الانحدار المتعدد- 1

 الانحدار المتعدد مثال عن فرضية

 
بيف تأثير الأسمكب الإحصائي المناسب لمعالجة ىذه الفرضية ىك معامؿ الانحدار المتعدد، لأنو يقيس 

 (مع كجكب تحقؽ شركط الإحصاء البرامترم)أكثر مف متغيريف 
 كىذا يناسب الحالات التي يرتبط فييا أكثر مف متغيريف، كىنا يتـ التنبؤ بأحد المتغيرات :الانحدار المتعدد

 (180، ص،2007أبو زينة وآخرون، ). مف خلاؿ المتغيرات الأخرل

𝑦:  كيحسب مف خلاؿ المعادلة التالية = 𝑎 + 𝑏1𝑥1 + 𝑏2𝑥2 
 :حيث

 
𝑏1 : تمثؿ ميؿ الانحدار عمى المتغير المستقؿ الأكؿ 
𝑏2 : تمثؿ ميؿ الانحدار عمى المتغير المستقؿ الثاني 



 

𝑥1    :تمثؿ المتكسط الحسابي لممتغير الأكؿ 
𝑥2    :تمثؿ المتكسط الحسابي لممتغير الثاني 
𝑠𝑦 :تمثؿ الانحراؼ المعيارم لممتغير التابع 
𝑠𝑥1

 تمثؿ الانحراؼ المعيارم لممتغير المستقؿ الأكؿ : 
𝑠𝑥2

 تمثؿ الانحراؼ المعيارم لممتغير المستقؿ الثاني : 
𝑟𝑦𝑥 1

 تمثؿ قيمة الارتباط بيف المتغير المستقؿ الأكؿ كالمتغير التابع: 
𝑟𝑦𝑥 2

 تمثؿ قيمة الارتباط بيف المتغير المستقؿ الثاني كالمتغير التابع : 
𝑟𝑥1𝑥2

 تمثؿ قيمة الارتباط بيف المتغير المستقؿ الأكؿ كالمتغير المستقؿ الثاني : 
شارة ميؿ خط الانحدار ىي نفسيا  كيعتبر الانحدار امتداد لدراسة الارتباط، فيما يسيراف في نفس الاتجاه كا 

ذا كانت عكسية فإشارتيا سالبة  .إشارة معامؿ الارتباط، فإذا كانت طردية فإشارتيا مكجبة كا 
 أم أنيما مترافقاف في ف كيكمف الفرؽ بيف الارتباط كالانحدار أف الارتباط يدرس قكة العلاقة بيف متغيرم

، أنو (2018)، فيقكؿ الأستاذ الدكتكر سمير صافي y عمى متغير xالتغير كلا يمكف الجزـ بأثر متغير 
ليس مف الضركرم تحديد كمعرفة المتغير المستقؿ كالمتغير التابع في الدراسات الارتباطية فيي تدرس قكة 
العلاقة بيف ىاذيف المتغيريف فقط، فإذا كانت العلاقة طردية مثلا فإف زيادة قيمة أحد المتغيريف يصاحبو 

في حيف أف الانحدار ىك دراسة التنبؤ بقيمة متغير بناءا عمى . زيادة في المتغير الآخر كالعكس صحيح
 . قيمة كأثر متغير آخر، أم يجب التمييز بيف المستقؿ كالتابع

ليس إلزاما أن علاقة التأثير تكون في الدراسات التجريبية كما يعتقد البعض، فقد تكون في : ملاحظة
دراسة أثر متغير مستقل أو أكثر عمى متغير : الدراسات الوصفية من خلال تحميل الانحدار فالانحدار ىو

 .تابع أو أكثر ويستخدم في المنيج الوصفي
 :حساب معامل الانحدار المتعدد يدويا- 2

 :مثال تطبيقي
لدراسة أثر الذكاء كقكة الانتباه عمى التحصيؿ الدراسي قمنا بتكزيع كتصحيح الاستبيانات عمى عينة متككنة 

 :  أفراد فكانت النتائج كالتالي10مف 
 حساب معامؿ الانحدار بيف ىاذيف المتغيريف كتفسير النتيجة المتحصؿ عمييا : المطمكب

 :الحل
  قيـ متغير قكة الانتباهY قيـ متغير الذكاء ك Xنقكـ بتفريغ نتائج الاستبيانيف في الجدكؿ التالي حيث يمثؿ 



 

فراد
الأ

 

𝑥1 
 الذكاء
𝑥2 

قكة 
 الانتباه

Y 
التحصيل 
 الدراسي

 

 

 

 

 

 

 

 

 

 

 

 

01 3 2 5 9 4 25 15 10 6 
02 3 3 8 9 9 64 24 24 9 
03 2 2 4 4 4 16 8 8 4 
04 4 3 7 16 9 49 28 21 12 
05 2 2 2 4 4 4 4 4 4 
06 3 3 7 9 9 49 21 21 9 
07 3 2 6 9 4 36 18 12 6 
08 4 3 5 16 9 25 20 15 12 
09 2 2 3 4 4 9 6 6 4 
10 4 4 4 16 16 16 16 16 16 
Ʃ 30 26 53 96 72 293 160 137 82 

ي
اب

س
ح

ال
ط 

س
و
مت

ال
 

𝒙
𝟏

   
 

=
30÷

10=3 

𝒙
𝟐

   
 

=
26÷

10=
2.

6
 

𝒚 =
53÷

10=
5.

3
 

      

𝑦:  نقكـ بحساب معامؿ الانحدار مف خلاؿ المعادلة التالية = 𝑎 + 𝑏1𝑥1 + 𝑏2𝑥2 
 : حيث 

 
أنظر المثاؿ السابؽ لحساب الارتباط بيرسكف ) نقكـ بحساب معاملات الارتباط البسيط بيف المتغيرات :أولا

 :  فكجدنا النتائج التالية(البسيط



 

 
 (أنظر المثاؿ السابؽ لحساب الانحراؼ المعيار)نقكـ بحساب الانحرافات المعيارية لممتغيرات السابقة : ثانيا

 :فكجدنا النتائج التالية 

 

 
𝑎نقكـ بتعكيض النتائج في المعادلات السابقة لإيجاد قيمة  : ثالثا ∙  𝑏1 ∙  𝑏2 



 

 
𝒚: إذا المعادلة الانحدار المتعدد تككف كالتالي = 𝟑. 𝟎𝟏 + 𝟎. 𝟓𝟗𝒙𝟏 + 𝟎. 𝟐𝟎𝒙𝟐 

 :تفسير النتيجة
 : يمكف اعتبار المعادلة عمى النحك التالي

 قكة الانتباه × 0.20+ الذكاء ×0.59+ 3.01= التحصيؿ الدراسي
 0.59مف خلاؿ ىذه المعادلة نستنتج أنو كمما زاد معدؿ الذكاء بدرجة كاحدة زاد التحصيؿ الدراسي بمعدؿ 

عمى اعتبار أف قكة الانتباه ثابتة، ككمما زاد معدؿ قكة الانتباه بدرجة كاحدة زاد التحصيؿ الدراسي بمعدؿ 
 . عمى اعتبار أف الذكاء ثابت0.20

 :Spssحساب معامل الانحدار المتعدد باستخدام - 3
قيـ الانتماء، قيـ )لحساب معامؿ الانحدار الخطي المتعدد لدراسة مدل تأثير عدة متغيرات مستقمة مثلا 

 :نتبع الخطكات التالية( المكاطنة التنظيمية)عمى متغير تابع  (التعاكف، قيـ الاحتراـ، قيـ العدالة
Analyze → Regression →Linear 

 

قيـ الانتماء، قيـ التعاكف، قيـ الاحتراـ، قيـ )فيظير مربع حكارم نقكـ فيو بنقؿ المتغيرات المستقمة 
 إلى خانة  (المكاطنة التنظيمية) كنقكـ بنقؿ المتغير التابع Independentإلى خانة  (العدالة

Dependent ثـ مف خلاؿ أمر Method إذا كنا نريد الانحدار المتعدد القياسي نختار Enter ( لا



 

، أما إذا كنا نريد الانحدار المتعدد التدريجي  مف أجؿ أف يستبعد (يستبعد المتغيرات التي ليس ليا أثر
  Stepwiseلنا المتغيرات التي ليس ليا أثر عمى المتغيرات المستقمة نختار 

 
 Descriptives لٌخزبس ثعض الإحصبءاد الْصف٘خ الزٖ ًحزبجِب فٌخزبس Statisticsثن ًضغظ علٔ 

ثن  (هعبهل الاًحذاس الوقذس) Estimates ًخزبس ثنPart and partial correla0tion ّ ًخزبس 

 Continue ثن   Casewise diagnostics ًخزبس 

 

 Y ًٌّقلِب لخبًخ ZRESID ، ًّخزبس X ًٌّقلِب لخبًخ ZPRED ًّخزبس Plotsثن ًزُت إلٔ 

 Ok ثن Continue ثن Histogram ًّخزبس أٗضب Normal probability plotثن ًخزبس أُن شٖء 



 

 

  الخبصخ ثبلق٘ن الوزطشفخ Mahalanobis ًّخزبس   Saveثن ًخزبس 

 

 Ok ثـ Entry في 0.05 كنضع Removal في 0.1 نضع Optionsثـ نذىب إلى 



 

 

 Output لنا عدة جداكؿ في صفحة فزظِش
 يكضح الإحصاءات الكصفية كالمتكسط الحسابي كالانحراؼ المعيارم لممتغيرات التي :الجدول الأول

 أدخمت في معادلة الانحدار 

 

  Correlations جدكؿ: الجدول الثاني
  لكؿ ارتباط Sigيكضح مصفكفة الارتباطات بيف المتغيرات الأربعة كقيـ الدلالة الإحصائية 



 

 
 Variables Entered/Removedجدكؿ : الجدول الثالث

 

، يكضح أسماء المتغيرات التي دخمت في معادلة الانحدار كطريقة استبعاد المتغيرات بالطريقة التدريجية

 نلاحظ أنو تـ استبعاد متغير قيـ العدالة لأنيا غير دالة إحصائيا

 

 Model Summary جدكؿ :الجدول الرابع

R :قيـ الانتماء ، قيـ التعاكف، قيـ الاحتراـ  : معامؿ الارتباط بيف المتغير التابع كالمتغيرات المستقمة
 . عمى الترتيب مع غياب متغير قي العدالة0.98 ك 0.97 ك 0.89كىي 



 

R Square : مربع معامؿ الارتباط لمعرفة نسبة تبايف المتغير التابع لمتنبؤ بالمتغيرات المستقمة كفي
 لممتغيرات قيـ الانتماء ، قيـ التعاكف، قيـ الاحتراـ  % 96 ك %93 ك % 79ىذه الحالة لدينا نسبة 

 .عمى التكالي
Adjusted R Square :المربع المعدؿ 

Std . Error of the Estimate :الخطأ في التقدير 

 

 Sig كقيمة F كيعتبر مف أىـ الجداكؿ كما ييمني فيو قيمة Anova جدكؿ: الجدكؿ الخامس

 

 Sig لاختبار معنكية الانحدار كنلاحظ  أف قيمة Anova نتائج تحميؿ التبايف 5يكضح الجدكؿ 
 ، كبالتالي فإننا نرفض الفرض الصفرم كنقبؿ الفرض 0.05 ككميا أقؿ مف 0.00لممتغيرات تساكم 



 

، كبالتالي تكجد علاقة تأثير بيف المتغير التابع 0البديؿ كىذا يعني أف الانحدار معنكم كلا يساكم
كالمتغيرات المستقمة 

لكننا لا تعرؼ تحديدا أم مف المتغيرات المستقمة ىك الذم أضاؼ تفسيرا جكىريا لمتبايف في المتغير 
. التابع، كىذا ما سيكضحو جدكؿ تفصيؿ معاملات الانحدار ليتضح لنا ذلؾ

 Coefficients: الجدول السادس

 
 معاملات نمكذج الانحدار التي تساعد في الحصكؿ عمى معادلة خط الانحدار 6يكضح لنا ىذا الجدكؿ 

𝑦بيف المتغيرات المستقمة كالمتغير التابع   = 𝑎 + 𝑏1𝑥1 + 𝑏2𝑥2 + 𝑏3𝑥3 
𝒚:  كىي كالتالي = 𝟕. 𝟕𝟏 + 𝟏. 𝟏𝟓𝒙𝟏 + 𝟏. 𝟎𝟖𝒙𝟐 + 𝟎. 𝟑𝟗𝒙𝟑 

  Excluded Variablesجدكؿ  : الجدول السابع

 



 

 أسماء المتغيرات التي تـ استبعادىا بالطريقة التدريجية كىك متغير قيـ العدالة حيث 7يكضح الجدكؿ 
 تساكم Sig أنو ضعيؼ جدا كغير داؿ إحصائيا لاف قيمة 0.04يكضح الارتباط الجزئي الذم يساكم 

 0.05 كىي أكبر مف 0.78

 Residuals Statisticsجدكؿ : الجدكؿ الثامف 

 
 إحصاءات البكاقي كىي الفركؽ بيف القيـ المشاىدة كخط الانحدار المقدر كتتضح 8يكضح الجدكؿ 

القيمة العظػػػػػػمى    كمقارنتيا بالقيمة الحرجة لكاؼ تربيع فإذا كانت  Mahaبالمقارنة بيف القيمة العظمى لػ 
أقؿ مف القيمة الحرجة لكاؼ تربيع فإنو لا تكجد قيـ متطرفة متعددة المتغيرات كىك شرط مف  Mahaلػ 

 .شركط تطبيؽ تحميؿ الانحدار المتعدد
 :الرسوم البيانية
 يتضح مف رسـ المدرج التكرارم أف البيانات تتبع التكزيع الطبيعي: المدرج التكراري

 



 

 
 :plot p pالرسم البياني 

 تتكزع Residualsيتضح مف الرسـ البياني أف البيانات تجتمع حكؿ الخط المستقيـ كبالتالي فإف البكاقي 
 حسب التكزيع الطبيعي كىك مف شركط الانحدار

 
 :شكل الانتشار لمبواقي

 يتضح عدـ كجكد نمط معيف لمنقاط في الشكؿ كىذا يتفؽ مع شرط الخطية المطمكب لاختبار الانحدار



 

 
الفرق بين الانحدار المتعدد التدريجي والانحدار المتعدد القياسي أن الأول يستبعد المتغيرات : ملاحظة

 .التي ليس ليا أثر وىذا شيء ميم ، بينما الآخر لا يستبعدىا
 : الحالة الخامسة 

 متغير رتبي + متغير رتبي + علاقة ارتباط 
 (الإحصاء لا برامترم)علاقة ارتباط بيف متغيريف رتبييف 

 في ىذه الحالة نستخدم معامل الارتباط الرتبي سبيرمان
 متغير كمي + متغير كمي +             أو       علاقة ارتباط 

 (كأحد شركط الإحصاء البرامترم غير محققة)علاقة ارتباط بيف متغيريف كمييف 
 في ىذه الحالة أيضا نستخدم معامل الارتباط الرتبي سبيرمان

أذا لـ تتحقؽ أحد شركط الإحصاء البرامترم ننتقؿ إلى الإحصاء البديؿ كىك الإحصاء اللابرامترم كىك 
مجمكعة مف المعاملات التي لا تتطمب شركط معينة لاستخدامو كلكنيا أقؿ دقة مف معاملات الإحصاء 

 البرامترم كدكرىا أيضا دراسة العلاقة الارتباطية المتغيرات كالفركؽ بيف المجمكعات 

إذا اختل شرط واحد فقط من شروط الإحصاء البرامتري فإنو لا يمكن استخدامو ونمجأ إلى : ملاحظة
 .الإحصاء البديل وىو الإحصاء اللابرامتري

:  معامل سبيرمان-1
 لدراسة العلاقة بيف متغيريف رتبييف: عن فرضية الارتباط سبيرمان: 1مثال



 

 
نلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف رتبييف، في ىذه الحالة نستخدـ معامؿ سبيرماف 

 . لمرتب

لدراسة العلاقة بيف متغيريف كمييف كلكف أحد شركط الإحصاء : عن فرضية الارتباط سبيرمان: 2مثال
نما ىي عينة قصدية  البرامترم غير محققة كىي أف العينة غير عشكائية كا 

 

ذكم الإعاقة )نلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف كمييف، كلكف العينة قصدية 
كبالتالي لـ يتحقؽ شرط العشكائية في اختيار العينة، كبالتالي لا يمكف استخداـ معامؿ بيرسكف  (البصرية

 .كنستخدـ بديمو معامؿ سبيرماف
 لدراسة العلاقة بيف متغيريف أحدىما رتبي كالآخر كمي: عن فرضية الارتباط سبيرمان: 3مثال

 
، في ىذه الحالة أحدىما رتبي كالآخر كمينلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف 

 . نستخدـ معامؿ سبيرماف لمرتب
، منيا أف (شركط الإحصاء البرامترم )  معامؿ الارتباط بيرسكف يمكف تطبيقو تحت جممة مف الشركطإف 

البيانات تتبع التكزيع الطبيعي ، كأف مستكل القياس فئكم أم البيانات كمية، فإذا لـ يتحقؽ أم شرط مف 
الشركط لا يمكف استخدامو، كنمجأ إلى المعامؿ البديؿ كىك معامؿ الارتباط سبيرماف لمرتب خصكصا أف 

أبو زينة وآخرون، ):إذا يمكف استخدامو في حالتيف ىما. ىذا المعامؿ لا يضع شركطا صعبة حكؿ المتغيرات
 (170،ص،2007



 

يستخدـ لإيجاد العلاقة بيف Spearman Correlation Coefficient معامؿ ارتباط سبيرماف لمرتب
ف خلافنا لمعامؿ ارتباط بيرسكف، فلا يشترط ترتيب معيف، فيتـ استخداـ معامؿ ارتباط ممتغيريف رتبي

أكافؽ، أكافؽ في الغالب، محايد ، لا أكافؽ في )،(مقبكؿ، جيد، جيد جدنا، ممتاز):سبيرماف لمقيـ الترتيبية مثؿ
، كفي ىذه الحالة يتـ ترتيب القيـ المرتبة لكؿ متغير بدلان مف القيـ الفعمية لممتغيرات، أم (الغالب ، لا أكافؽ

 .; حتى يتـ حساب معامؿ الارتباط أم إلى أرقاـأنو يتـ تحكيؿ القيـ الأصمية إلى ترتيباتيا
 هشروط: 

متغيريف رتبييف    -
مستكل القياس رتبي   - 
 لابرامترم إحصاء  - 
 1+ ك 1- قيمتو تتراكح بيف  - 
 .30مف الأحسف أف تككف العينة أقؿ مف   - 
 يشترؾ مع معامؿ بيرسكف في اتجاه كقكة العلاقة:أنواع العلاقة بين المتغيرات . 

:  اتجاه العلاقة- أ
ىناؾ علاقة مكجبة كىناؾ علاقة سالبة، فإذا تحصمنا عمى قيمة مكجبة لمعامؿ الارتباط دؿ ذلؾ عمى كجكد 

 كالعكس صحيح Y تككف متبكعة بالزيادة في المتغيرXعلاقة طردية، أم أف الزيادة في المتغير 
: قوة العلاقة- ب

، فإذا قيمة معامؿ الارتباط تساكم (1)+ك  (1-)في أغمب معاملات الارتباط تنحصر قيمة ىذا المعامؿ 
فمعنى ذلؾ أف الارتباط بيف المتغيريف طردم تاـ، كىك أقكل أنكاع الارتباط الطردم بيف المتغيريف،  (1+)

ذا كانت قيمة معامؿ الارتباط تساكم  فمعنى ذلؾ أف الارتباط بيف المتغيريف عكسي تاـ، كىك أقكل  (1-)كا 
. أنكاع الارتباط العكسي، كيمكف أف تككف القيمة صفرية; كذلؾ يؤدم إلى أنو لا يكجد علاقة مف الأساس

 ( 128، ص،2010فلاح وغرايبية،)

𝒓𝒔:          ويمكن حسابو بالمعادلة التالية = 𝟏 −
𝟔 𝑫²

𝑵 𝑵²−𝟏 
 

  قيـ ثابتة6 ك 1: حيث 
D : الفرؽ بيف رتب نفس الفرد في المتغيرX ك المتغير Y 
D² : مربع الفرؽ بيف رتب نفس الفرد في المتغيرX ك المتغير Y 
N :حجـ العينة 



 

 المحسكبة عند مستكل 𝒓𝒔 كمقارنتيا مع Nحجم العينة  = (df) درجة الحرية الجدكلية عند 𝒓𝒔إيجاد ثـ 
 .0.05الدلالة 
 خطوات حسابو: 

 نرتب قيـ المتغيريف مف أصغر إلى أكبر قيمة- 1
  لمقيمة الأقؿ كنتصاعد إلى القيمة الأعمى01نعطي رتبا لمقيـ بعد ترتيبيا، حيث نعطي الرتبة - 2
في حالة تساكم قيمتيف أك أكثر، نقكـ بحساب المتكسط الحسابي لمرتب، كبعدىا نعطي ىذه القيمة - 3

 .المتحصؿ عمييا لكؿ القيـ المتساكية
 N  حجم العينة  = (df) درجة الحرية الجدكلية عند 𝒓𝒔إيجاد  ثـ ،𝒓𝒔تطبيؽ المعادلة كحساب قيمة - 4

 .0.05 المحسكبة عند مستكل الدلالة 𝒓𝒔كمقارنتيا مع 

 :حساب معامل الارتباط سبيرمان يدويا- 2
 :مثال تطبيقي

 Y كالرياضياتX طمبة في مادتي الإحصاء 7لدينا البيانات الرتبية التالية لتقديرات 
 جيد مقبكؿ جيد جدا جيد ممتاز مقبكؿ جيد Xالإحصاء 
 ممتاز جيد جيد جيد جيد جدا مقبكؿ جيد جدا Yالرياضيات 

 :المطموب
 ىؿ ىناؾ علاقة ارتباطية بيف ترتيب الطمبة في مادة الإحصاء كترتيبيـ في مادة الرياضيات

 : الحل
 نرتب قيـ المتغيريف مف أصغر إلى أكبر قيمة- 1

 Yرتبة  Yالرياضيات  Xرتبة  Xالإحصاء 
 5 جيد جدا 3 جيد
 1 مقبكؿ 2 مقبكؿ
 6 جيد جدا 7 ممتاز
 2 جيد 4 جيد

 3 جيد 6 جيد جدا
 4 جيد 1 مقبكؿ
 7 ممتاز 5 جيد

 نلاحظ Xنلاحظ أف ىناؾ تقديرات مكررة ، فنضع ليا قيـ جديدة ىي متكسط ىاتو الرتب في تقديرات - 2
 :أف



 

= تقديرات جيد، نحسب متكسطيـ الحسابي 3           
مجمكعالقيـ القيـ

عدد 
= 4 = 3+4+5

3
  

= تقديرات مقبكؿ، نحسب متكسطيـ الحسابي 2 
1+2

2
=

مجمكعالقيـ القيـ
عدد 

= 1.5  

 : نلاحظ أفYفي تقديرات 

مجمكعالقيـ القيـ=  تقديرات جيد، نحسب متكسطيـ الحسابي 3           
عدد 

   = = 2+3+4

3
 3 

مجمكعالقيـ القيـ=  تقديرات جيد جدا، نحسب متكسطيـ الحسابي 2 
عدد 

 = = 5+6

2
 5.5 

 :فيصبح الترتيب عمى الشكل التالي

 Y D D²رتبة  Yالرياضيات  Xرتبة  Xالإحصاء 
 2.25 1.5- 5.5 جيد جدا 4 جيد
 0.25 0.5 1 مقبكؿ 1.5 مقبكؿ
 2.25 1.5 5.5 جيد جدا 7 ممتاز
 1 1 3 جيد 4 جيد

 9 3 3 جيد 6 جيد جدا
 2.25 1.5- 3 جيد 1.5 مقبكؿ
 9 3 7 ممتاز 4 جيد
Ʃ     26 

، كنحسب D² ثـ نحسب Y ك المتغير X كىك الفرؽ بيف رتب نفس الفرد في المتغير Dنقكـ بحساب - 3
 D²مجمكع 

𝒓𝒔:حساب الارتباط سبيرماف بالمعادلة التالية- 4 = 𝟏 −
𝟔 𝑫²

𝑵 𝑵²−𝟏 
 

 
عند مستكل الدلالة N =7حجم العينة  = (df) درجة الحريةعند 0.786 الجدكلية تساكم 𝒓𝒔لدينا- 5

 ..فإننا نقبل الفرض الصفري ونقبل البديل .0.53 المحسكبة 𝒓𝒔 كىي أكبر مف0.05
لا تكجد علاقة ارتباطية ذات دلالة إحصائية بيف ترتيب الطمبة في مادة الإحصاء كترتيبيـ في :  النتيجة

 .، وغير دال إحصائيامادة الرياضيات



 

 :Spssحساب معامل الارتباط سبيرمان باستخدام  -4
 :لحساب معامؿ الارتباط سبيرماف نتبع الخطكات التالية

Analyze → Correlate →Bivarite 

المراد حساب  (بعد الانتماء، الثقافة التنظيمية)فيظير مربع حكارم نقكـ فيو بنقؿ المتغيريف 
 .Ok ثـ  Spearman ثـ نختار Variableارتباطيا إلى خانة 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 لنا جدكؿ يكضح قيمة معامؿ الارتباط سبيرماف كقيمة مستكل الدلالة الإحصائية في صفحة فزظِش

Output. 

 
 :فتظير مجمكعة مف القيـ أىميا

Sig = 0.00 إذا .  إذا ىذا الارتباط داؿ إحصائيا0.05 الدلالة الإحصائية لمعامؿ الارتباط كىي أقؿ مف
 Rمف خلاؿ قيمة . ،أبحث عف اتجاه كقكة ىذا الارتباط(Sigمف خلاؿ قيمة )كاف ىناؾ ارتباط ذك إحصائية

R = 0.84قيمة معامؿ الارتباط كىك ارتباط طردم قكم . 
  فيذا يدؿ عمى أف الارتباط داؿ إحصائياSig ≥ 0.05إذا كانت 
  فيذا يدؿ عمى أف الارتباط غير داؿ إحصائياSig > 0.05إذا كانت 

 : الحالة السادسة
  (تقسيمو ثنائي)متغير اسمي  + (تقسيمو ثنائي)متغير اسمي + علاقة ارتباط 

حصاء لا برامترم4)علاقة ارتباط بيف متغيريف اسمييف تقسيميما ثنائي   ( مجمكعات كا 
 𝛗في ىذه الحالة نستخدم معامل الارتباط فاي 

: 𝛗فاي معامل - 1

 لدراسة العلاقة بيف متغيريف اسمييف ليما تقسيـ ثنائي: عن فرضية الارتباط فاي: 1مثال

 



 

ذكر، )نلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف اسمييف، الأكؿ الجنس لو تقسيـ ثنائي 
في ىذه الحالة نستخدـ معامؿ الارتباط ( يدخف ، لا يدخف)كالثاني التدخيف لو أيضا تقسيـ ثنائي  (أنثى
 . فام
 (ناجح، راسب)والنجاح   (حاضر، غائب)توجد علاقة ارتباطية بين الحضور لمدروس: - 2مثال

نلاحظ أيضا في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف اسمييف، الأكؿ الحضكر لمدركس لو 
في ىذه الحالة أيضا  (ناجح، راسب)كالثاني النجاح لو أيضا تقسيـ ثنائي  (حاضر، غائب)تقسيـ ثنائي 

 .نستخدـ معامؿ الارتباط فام
كىك معامؿ يستخدـ لقياس الارتباط بيف متغيريف اسمييف، كىاذيف المتغيريف تقسيميما ثنائي أم أف المتغير 
المستقؿ اسمي ينقسـ إلى فئتيف فقط، كالمتغير التابع اسمي كينقسـ إلى فئتيف فقط، كىذا معناه أف المتغيريف 

  كأف البيانات مف النكع الاسمي عمى شكؿ 2×2منفصميف انفصاؿ ثنائي أم عبارة عف أربع مجمكعات 
 .φكيرمز لو بالرمز . تكرارات
 :ه شروط

 اسمييفمتغيريف   -
 ليما تقسيـ ثنائي كلكؿ كاحد منيما خياريف - 
  لابرامترمإحصاء -
 1+ ك 0 قيمتو تتراكح بيف  -

𝒓𝝋:          ويمكن حسابو بالمعادلة التالية =
𝒂𝒅−𝒃𝒄

  𝒂+𝒃  𝒄+𝒅  𝒂+𝒄  𝒃+𝒅 
 

 a b c dإيجاد قيـ  -1

 
a : 01 مع الفئة 01تكرارات الفئة 
b : 01 مع الفئة 02تكرارات الفئة 
c : 02 مع الفئة 01تكرارات الفئة 
d : 02 مع الفئة 02تكرارات الفئة 



 

 الجدكلية حيث Zكمقارنتيا مع  (القيمة المعيارية) Zإيجاد الدلالة الإحصائية مف خلاؿ حساب قيمة - 2
𝑍 = 𝜑 𝑛 حيث ،φ  معامؿ فام ك nعدد أفراد العينة . 

 المحسكبة فإننا نقبؿ الفرض الصفرم كنرفض البديؿ أم عدـ كجكد Z الجدكلية أكبر مف Zإذا كانت - 
 علاقة ارتباطية أم أف الارتباط غير داؿ إحصائيا

 المحسكبة فإننا نرفض الفرض الصفرم كنقبؿ الفرض البديؿ أم Z الجدكلية أصغر مف Zإذا كانت - 
 .كجكد علاقة ارتباطية بيف المتغيريف  أم أف الارتباط داؿ إحصائيا

 : يدويا𝛗حساب معامل الارتباط فاي - 2
 :مثال تطبيقي

 شخصا، انطمؽ الباحث مف فرضية تقكؿ لا تكجد علاقة بيف الجنس كالميؿ إلى 31في دراسة أجريت عمى 
 :التدخيف كلمتأكد مف صحة ىذه الفرضية جمع بياناتو كنظميا في الجدكؿ التالي

              الجنس
 التدخين

 ∑ أنثى ذكر

 a 5 b 14 9 يدخن
 c 13 d 17 4 لا يدخن

∑ 13 18 31 
  حساب معامؿ الارتباط بيف المتغيريف؟:المطموب

 : مف خلاؿ المعادلة التالية: φ حساب معامؿ الارتباط فام :أولا

 
  نلاحظ أف الارتباط ضعيؼ كلكف ىؿ ىك داؿ إحصائيا أك لا ؟𝒓𝝋 = 0.41مف خلاؿ قيمة 

  الجدكلية Zكمقارنتيا مع  (القيمة المعيارية) Zحساب قيمة : ثانيا

 
 :Zإيجاد قيمة 

 0.475 = 2 /0.95= تصبح  %  95 أم0.05لدينا مستكل الدلالة  -1
 1.9القيمة المناظرة أفقيا ىي 

 0.06كالقيمة المناظرة عمكديا ىي 
  نقارنيا بالمحسكبة Z = 1.9 + 0.06 = 1.96كمنو فإف قيمة 



 

 فإننا نرفض الفرض الصفرم 2.27 المحسكبة التي تساكم Z أقؿ مف 1.96 الجدكلية تساكم Zكانت 
 .كنقبؿ  البديؿ أم نأكد كجكد علاقة ارتباطية بيف المتغيريف أم أف الارتباط داؿ إحصائيا

 :Spss باستخدام 𝛗حساب معامل الارتباط فاي - 3
 فتككف البيانات مشابية لمجدكؿ في المثاؿ السابؽ عمى ىذا الشكؿ (نأخذ بيانات نفس المثاؿ السابؽ) 

 
 :لحساب معامؿ الارتباط فام نتبع الخطكات التالية

تمثؿ تكرارات ىاذيف المتغيريف حتى يتعامؿ  (التكرارات)أكلا يجب تعريؼ البرنامج أف المتغير الثالث 
 :البرنامج مع ذلؾ بالخطكات التالية

Data → Weight Cases 

 

 

، كنقكـ أيضا بنقؿ by  Weight Casesخبًخفيظير مربع حكارم نقكـ فيو بالضغط عمى 
 Ok، ثـ  Frequency Variableلخانة  (التكرارات)



 

 
 :ثانيا نقكـ بحساب معامؿ الارتباط فام كالتالي

Analyze → Descriptive Statistics → Crosstabs 

 

 كنقؿ متغير التدخيف إلى  (الأعمدة) Column(s)فيظير مربع حكارم نقكـ فيو بنقؿ متغير الجنس إلى 

Row(s) (الصفكؼ)  



 

 
 ثـ Phi and Cramer V فيظير لنا مربع حكارم نختار منو Statisticsثـ نختار أيقكنة 

Continue ثـ Ok 

 
 Output لنا عدة جداكؿ في صفحة فزظِش

  ىك نفسو الجدكؿ الذم قمنا بإعداده كالمقدـ في المعطيات:الجدول الأول

 



 

 : كىك الميـ كيحتكم عمى مجمكعة مف القيـ كىي كالتالي: الجدول الثاني
Phi : 0.41كىي قيمة معامؿ فام  
Sig : 0.02 كبالتالي فيي دالة إحصائيا، 0.05 كىي قيمة الدلالة الإحصائية كىي أقؿ مف مستكل الدلالة 

إذا فإننا نرفض الفرض الصفرم كنقبؿ  البديؿ أم نؤكد كجكد علاقة ارتباطية ذات دلالة إحصائية بيف 
 .الجنس كالتدخيف أم علاقة ارتباطية طردية ضعيفة دالة إحصائيا

 
 : الحالة السابعة
  (لأحدىما عمى الأقل تقسيم أكثر من ثنائي)متغير اسمي + متغير اسمي + علاقة ارتباط 

 4أم أكثر مف )علاقة ارتباط بيف متغيريف اسمييف لأحدىما عمى الأقؿ تقسيـ أكثر مف ثنائي 
حصاء لا برامترم  (مجمكعات كا 

 Vكرامر معامل في ىذه الحالة نستخدم 
 :Vكرامر معامل - 1

 :عن فرضية الارتباط كرامر: 1مثال

 لدراسة العلاقة بيف متغيريف اسمييف لأحدىما عمى الأقؿ تقسيـ أكثر مف ثنائي

 
نلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف اسمييف، الأكؿ ممارسة كرة القدـ لو تقسيـ 

لو  (يشاىد، لا يشاىد، يشاىد أحيانا)كالثاني مشاىدة كرة القدـ  (يمارس، لا يمارس، يمارسيا أحيانا)ثلاثي 
 كفي ىذه 4أكثر مف 9= 3× 3تقسيـ ثلاثي أيضا أم كلاىما أكثر مف ثنائي كبالتالي عدد الخانات سيككف 

 . كرامرالحالة نستخدـ معامؿ الارتباط 



 

 كىك صكرة مصغرة لمعامؿ فام كىك معامؿ يستخدـ لقياس الارتباط بيف 1946 استحدث سنة كرامرمعامؿ 
متغيريف اسمييف، كىاذيف المتغيريف تقسيـ أحدىما عمى الأقؿ أكثر مف  ثنائي أم أف المتغير المستقؿ 
اسمي كالتابع اسمي كعدد المجمكعات أكثر مف أربعة، كىذا معناه أف المتغيريف منفصميف لأحدىما أك 

 خانات أم 4لكمييما انفصاؿ أكثر مف ثنائي أم عبارة بيانات اسمية منظمة في جداكؿ تكافؽ أكثر مف 
 Vكيرمز لو بالرمز .  عمى الأقؿ،  كأف البيانات مف النكع الاسمي عمى شكؿ تكرارات6 = 2×3

 :ه شروط
 اسمييف متغيريف   -
 لأحدىما عمى الأقؿ تقسيـ أكثر مف ثنائي، أم لأحدىما عمى الأقؿ أكثر مف خياريف - 
  لابرامترمإحصاء -
 (2009بوعلاق، ) (لا يككف سالبا، لا تظير العلاقة ىؿ طردية أـ عكسية) 1+ ك 0 قيمتو تتراكح بيف  -

معامل كرامر كمعامل الاتفاق إلا أن معامل الاتفاق يتأثر بحجم الجدول، فتضعف مصداقية : ملاحظة
 . ( مثلا5أكثر من )نتائجو كمما تعددت الفئات 

𝑽:          ويمكن حسابو بالمعادلة التالية =  
𝐱𝟐

𝐧 𝐟−𝟏 
 

 x2 :حيث  (بالعربية) ²كاx² =  
 fo−fe  2

fe
 

             fo (القيـ الفعمية )التكرارات المشاىدة 

             fe التكرارات المتكقعة( 
 مجمكع صؼ الخانة× مجمكع عمكد الخانة

المجمكع الكمي
 ) 

n :عدد أفراد العينة 
f : أعمدة نأخذ 4 صفكؼ كمف 5إذا كاف الجدكؿ يتككف مف : مثاؿ )عدد الصفكؼ أك عدد الأعمدة الأقؿ 

 (4رقـ 
 : يدوياVحساب معامل الارتباط كرامر - 2

 :مثال تطبيقي
ىؿ تكجد علاقة بيف الجنس كرأييـ حكؿ التعديؿ : قاـ باحث بالقياـ بدراسة مف طرح التساؤؿ التالي 

 :، فكانت النتائج كالتالي(كافؽ، معارض، غير ميتـ)الدستكرم 
 حساب القيمة معامؿ الارتباط  بيف جنس الأفراد كرأييـ حكؿ تعديؿ الدستكر؟ كتفسير النتيجة :المطموب

 المتحصؿ عمييا؟



 

 
fe إيجاد القيـ المتكقعة :أولا   fo  مف خلاؿ القيـ المشاىدة  

          fe التكرارات المتكقعة  =( 
 مجمكع صؼ الخانة×مجمكع عمكد الخانة

المجمكع الكمي
 )  

  𝟏𝟑 × 𝟒:  قيمتيا المتكقعة ىي 2 القيمة المشاىدة الأكلى ىي :مثال

𝟐𝟖
بيذه الطريقة نكمؿ .......1.85 = 

 .باقي الجدكؿ
 fe fo - fe ²(fo - fe)  fo−feالقيـ المتكقعة  foالقيـ المشاىدة 

2

fe
 

2 𝟒 × 𝟏𝟑  

𝟐𝟖
 = 1.85 0.15 0.02 0.01 

4 𝟓 × 𝟏𝟑  

𝟐𝟖
 = 2.32 1.68 2.82 1.21 

7 𝟏𝟗 × 𝟏𝟑  

𝟐𝟖
 = 8.82  -1.82 3.31 0.37 

2 𝟒 × 𝟏𝟓  

𝟐𝟖
 = 2.14  -0.14 0.01 4.67 

1 𝟓 × 𝟏𝟓  

𝟐𝟖
 = 2.67  -1.67 2.78 1.04 

12 𝟏𝟗 × 𝟏𝟓  

𝟐𝟖
 = 10.17 1.83 3.34 0.32 

∑ 7.62 
 : حساب معامؿ كرامر بتطبيؽ القانكف كتعكيض القيـ المكجكدة في الجدكؿ:ثانيا

 : حيث لدينا 

 
 = 𝐱²7.62 

n = 28 
f : نقكـ بالتعكيض في المعادلة 2= ، نأخذ الأقؿ 3=  كعدد الأعمدة 2= لدينا عدد الصفكؼ    

 



 

 .تدؿ النتيجة عمى كجكد علاقة متكسطة كيجب التأكد مف دلالتيا الإحصائية بمقارنيا بالقيمة الجدكلية
 : الجدكليةV إيجاد قيمة كرامر :ثالثا

  0.05لدينا مستكل الدلالة 
 2= 1 ×2 = (1-2 )(1-3 = )(1-عدد الصفكؼ)(1 –عدد الأعمدة )= كلدينا درجة الحرية 

 المحسكبة التي تساكم V كىي أقؿ مف قيمة كرامر 0.175 الجدكلية تساكم Vكمنو فإف قيمة كرامر 
، كبالتالي فإننا نرفض الفرض الصفرم كنقبؿ  البديؿ أم نؤكد كجكد علاقة ارتباطية متكسطة دالة 0.51

 .إحصائيا بيف المتغيريف

 :Spss باستخدام Vحساب معامل الارتباط كرامر - 3
 فتككف البيانات مشابية لمجدكؿ في المثاؿ السابؽ عمى ىذا الشكؿ (نأخذ بيانات نفس المثاؿ السابؽ)

 
 :لحساب معامؿ الارتباط كرامر نتبع الخطكات التالية

تمثؿ تكرارات ىاذيف المتغيريف حتى يتعامؿ  (التكرارات)أكلا يجب تعريؼ البرنامج أف المتغير الثالث 
 :البرنامج مع ذلؾ بالخطكات التالية

Data → Weight Cases 

 



 

 (التكرارات)، كنقكـ أيضا بنقؿ by  Weight Casesخبًخفيظير مربع حكارم نقكـ فيو بالضغط عمى 
 Ok، ثـ  Frequency Variableلخانة 

 
 :ثانيا نقكـ بحساب معامؿ الارتباط كرامر كالتالي

Analyze → Descriptive Statistics → Crosstabs 

 

كنقؿ متغير الجنس  (الأعمدة) Column(s)فيظير مربع حكارم نقكـ فيو بنقؿ متغير تعديؿ الدستكر إلى 
  (الصفكؼ) Row(s) إلى 



 

       
 ثـ Phi and Cramer V فيظير لنا مربع حكارم نختار منو Statisticsثـ نختار أيقكنة 

Continue ثـ Ok 

 
 Output لنا عدة جداكؿ في صفحة فزظِش

  ىك نفسو الجدكؿ الذم قمنا بإعداده كالمقدـ في المعطيات:الجدول الأول

 



 

 : كىك الميـ كيحتكم عمى مجمكعة مف القيـ كىي كالتالي: الجدول الثاني
Cramer : 0.51كىي قيمة معامؿ كرامر  

Sig : 0.024 كبالتالي فيي دالة 0.05 كىي قيمة الدلالة الإحصائية كىي أقؿ مف مستكل الدلالة 
إذا فإننا نرفض الفرض الصفرم كنقبؿ البديؿ أم نؤكد كجكد علاقة ارتباطية ذات دلالة إحصائية إحصائيا، 

 . أم علاقة ارتباطية طردية متكسطة دالة إحصائياالرأم حكؿ تعديؿ الدستكربيف الجنس ك

 
 : الحالة الثامنة

  (ذو تقسيم ثنائي حقيقي)متغير اسمي + متغير كمي + علاقة ارتباط 
 (ذك تقسيـ ثنائي حقيقي)أحدىما كمي كالآخر اسمي علاقة ارتباط بيف متغيريف 

 (معامل الارتباط بايسيريـال الطبيعي)(الطبيعي)الارتباط الثنائي الحقيقيمعامل في ىذه الحالة نستخدم 
  (معامل الارتباط بايسيريـال الطبيعي): (الطبيعي)الارتباط الثنائي الحقيقي معامل - 1

  Point Biserial correlationويسمى أيضا المتسمسل ذو النقطة 
:  (معامل الارتباط بايسيريـال الطبيعي) (الحقيقي)الثنائي الطبيعي عن فرضية الارتباط : مثال

 

كالثاني  (التحصيؿ)نلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف، الأكؿ متغير تابع كمي 
كىذا التقسيـ يعتبر  (داخمي ، خارجي)كالمتغير الاسمي ذك تقسيـ ثنائي  (نمط الإقامة)متغير مستقؿ اسمي 



 

كعميو نستخدـ . تقسيـ حقيقي لأف الطالب في الجامعة إما أف يككف مقيـ أك غير مقيـ لا يكجد احتماؿ آخر
 . (معامل الارتباط بايسيريـال الطبيعي)في ىذه الحالة معامؿ الارتباط الثنائي الحقيقي 

كىك معامؿ نقكـ مف خلالو بإيجاد العلاقة الارتباطية بيف متغيريف أحدىما كمي كالآخر اسمي ذك تقسيـ 
ثنائي، عمى أف يككف ىذا التقسيـ الثنائي تقسيـ حقيقي، أم لا يتدخؿ الباحث في عممية تقسيـ المتغير 

ناث كلا يحتاج أم نتائج أك اجتياد  الاسمي فتقسيمو طبيعي كبسيط كتمقائي كالجنس مثلا ينقسـ إلى ذككر كا 
كيعتبر نمكذج مصغر لمعامؿ الارتباط بيرسكف كيحسب بنفس . 𝑅𝑏𝑝كيرمز لو بالرمز . في عممية التقسيـ

 .طريقتو
 :هشروط

 أحدىما بياناتو كمية كالثاني بياناتو اسميةمتغيريف   -
 (صحيح، خطأ) (ناجح، راسب)أف يككف تقسيـ المتغير الاسمي ثنائي أم يتككف مف مجمكعتيف  - 
 (طبيعي)أف يككف تقسيـ المتغير الاسمي تقسيـ حقيقي  - 
 df = n-2درجة الحرية - 
 . متساكييف فإف الارتباط يككف منعدماإذا كاف متكسط المجمكعتيف- 

𝑅𝑏𝑝:          ويمكن حسابو بالمعادلة التالية = 𝐱 𝟏−𝐱 𝟐
𝐬  

𝐧𝟏𝐧𝟐
𝐍 𝐍−𝟏 

 

 :حيث 
 :𝐱 𝟏 المتكسط الحسابي لممجمكعة الأكلى
:𝐱 𝟐 المتكسط الحسابي لممجمكعة الثانية
:𝐧𝟏عدد أفراد عينة المجمكعة الأكلى 
:𝐧𝟐 عدد أفراد عينة المجمكعة الثانية
:𝐍 (المجمكعة الثانية+ المجمكعة الأكلى )عدد أفراد كؿ العينة 

:𝑺الانحراؼ المعيارم كالذم يمكف حسابو بالمعادلة التالية  :𝐒 =   𝐗𝟐−
  𝐗 ²

𝑵

𝐍−𝟏
 

 (المجمكعة الأكلى كالمجمكعة الثانية) العينة أفراد تمثؿ بيانات كؿ 𝐗حيث                     
 (المجمكعة الثانية+ المجمكعة الأكلى )عدد أفراد كؿ العينة  تمثؿ 𝐍:                   ك 

 



 

 (معامل الارتباط بايسيريـال الطبيعي)(الحقيقي)حساب معامل الارتباط الثنائي الطبيعي- 2
𝐑𝐛𝐩يدويا : 

 :مثال تطبيقي
عمى عينة مككنة  (داخمي ، خارجي)لدراسة العلاقة الارتباطية بيف التحصيؿ الدراسي كنمط إقامة الطالب 

 : طلاب بقسـ عؿ النفس تحصمنا عمى النتائج التالية10مف 
  درجات التحصيؿ الدراسي

 نمط
 الإقامة

 7 9 7 16 11 12 داخمي
   9 10 11 12 خارجي

  ىؿ تكجد علاقة ارتباطية بيف التحصيؿ الدراسي كنمط إقامة الطالب؟:المطموب
 :الحل

 المتغير المستقؿ ىك نمط الإقامة كىك متغير اسمي كذك تقسيـ ثنائي حقيقي: - نلاحظ أف 
 المتغير التابع ىك التحصيؿ الدراسي كىك متغير كمي     - 

معامؿ ) (الحقيقي)إذا الأسمكب الإحصائي لقياس ىذا الارتباط يككف معامؿ الارتباط الثنائي الطبيعي 
 (الارتباط بايسيريػاؿ الطبيعي

  خارجي 1 داخمي ، 2كليكف :  نقكـ بترميز متغير الإقامة:أولا
 : نقكـ بتبكيب البيانات في الجدكؿ:ثانيا

 نمط الإقامة الطمبة
التحصيل 

1x 
التحصيل 

2x  (كل القيم) X X² 
 144 12 12    2(داخمي) 1
2 2  11 11 121 
3 2  16 16 256 
4 2  7 7 49 
5 2  9 9 81 
6 2  7 7 49 
 12 (خارجي) 1 7

 
12 144 

8 1 11 
 

11 121 
9 1 10 

 
10 100 

10 1 9 
 

9 81 
∑ 

 
42 62 104 1146 

X̅ 
 

10.5 10.33 
  



 

 : نقكـ بحساب الانحراؼ المعيارم مف المعادلة التالية :ثالثا

  𝐒 =   𝐗𝟐−
  𝐗 ²

𝑵

𝐍−𝟏
=  𝟏𝟏𝟒𝟔− 

𝟏𝟎𝟒`

𝟏𝟎

𝟏𝟎−𝟏
 =   

𝟏𝟏𝟒𝟔−𝟏𝟎𝟖𝟏.𝟔

𝟗
=  𝟕. 𝟏𝟓 = 𝟐. 𝟔𝟕 

 :بالمعادلة التالية (بايسيريـال الطبيعي) حساب معامؿ الارتباط الثنائي الحقيقي :رابعا

 
تدؿ النتيجة عمى عدـ كجكد علاقة كىي شبو منعدمة كيجب التأكد مف دلالتيا الإحصائية بمقارنيا بالقيمة 

 (جدكؿ معامؿ بيرسكف)الجدكلية 
مف :  الجدكلية𝑅𝑏𝑝  (بايسيريـال الطبيعي) (الحقيقي) معامؿ الارتباط الثنائي الطبيعي  إيجاد قيمة:خامسا

 .أجؿ التأكد مف الدلالة الإحصائية
  0.05لدينا مستكل الدلالة 
 df = n - 2 = 10 -2 = 8كلدينا درجة الحرية  

كىي أكبر مف قيمة  0.63 الجدكلية تساكم 𝑅𝑏𝑝(الحقيقي)معامؿ الارتباط الثنائي الطبيعي كمنو فإف قيمة 
، كبالتالي فإننا نقبؿ الفرض 0.03 المحسكبة التي تساكم 𝑅𝑏𝑝  (الحقيقي)معامؿ الارتباط الثنائي الطبيعي 

الصفرم كنرفض البديؿ أم نؤكد عدـ كجكد علاقة ارتباطية دالة إحصائيا بيف التحصيؿ الدراسي كنكع 
 .الإقامة

 باستخدام 𝑅𝑏𝑝 (بايسيريـال الطبيعي) (الحقيقي)حساب معامل الارتباط الثنائي الطبيعي - 3
Spss: 

كىك صكرة مصغرة لمعامؿ الارتباط بيرسكف، ليذا نقكـ بحساب معامؿ بيرسكف في ىذه الحالة كيعتبر 
 معامؿ بايسيريػػاؿ الطبيعي

 ":لدينا البيانات التالية
 درجات التحصيؿ الدراسي

 نمط
 الإقامة

 7 9 7 16 11 12 داخمي
   9 10 11 12 خارجي

 نقكـ بإدخاؿ البيانات لمبرنامج بيذا الشكؿ: أكلا 



 

 

 
 :لحساب معامؿ الارتباط بيرسكف نتبع الخطكات التالية

Analyze → Correlate →Bivarite 

 
المراد حساب ارتباطيا إلى خانة  (الإقامة، الدرجة)فيظير مربع حكارم نقكـ فيو بنقؿ المتغيريف 

Variable ثـ نختار Person  ثـ Ok. 



 

 
 .Output لنا جدكؿ يكضح قيمة معامؿ الارتباط كقيمة مستكل الدلالة الإحصائية في صفحة فزظِش

 
 :فتظير مجمكعة مف القيـ أىميا

R = 0.03قيمة معامؿ الارتباط كىك ارتباط طردم ضعيؼ جدا كشبو منعدـ  
Sig = 0.93 إذا ىذا الارتباط غير داؿ 0.05 الدلالة الإحصائية لمعامؿ الارتباط كىي أكبر مف 

 كبالتالي فإننا نقبؿ الفرض الصفرم كنرفض البديؿ أم نؤكد عدـ كجكد علاقة ارتباطية دالة .إحصائيا
 .إحصائيا بيف التحصيؿ الدراسي كنكع الإقامة

 : الحالة التاسعة
  (ذو تقسيم ثنائي غير حقيقي)متغير اسمي + متغير كمي + علاقة ارتباط 

 (ذك تقسيـ ثنائي غير حقيقي)أحدىما كمي كالآخر اسمي علاقة ارتباط بيف متغيريف 
 (معامل الارتباط بايسيريـال الاعتباري)الارتباط الثنائي معامل في ىذه الحالة نستخدم 



 

  (معامل الارتباط بايسيريـال الاعتباري)الثنائي الارتباط معامل - 1
بيف الارتباطية لدراسة العلاقة  (معامل الارتباط بايسيريـال الاعتباري)الارتباط الثنائي معامل عن : مثال

 (ذك تقسيـ ثنائي غير حقيقي)أحدىما كمي كالآخر اسمي متغيريف 

 
كالثاني  (الأداء الميني)نلاحظ في ىذه الفرضية كجكد علاقة ارتباطية بيف متغيريف، الأكؿ متغير تابع كمي 

كىذا التقسيـ  (أعزب، متزكج)كالمتغير الاسمي ذك تقسيـ ثنائي  (الحالة الاجتماعية)متغير مستقؿ اسمي 
يعتبر تقسيـ غير حقيقي لأف المكظؼ ممكف أف يككف أعزب أك متزكج أك مطمؽ أك أرمؿ كلكف الباحث 

كعميو نستخدـ في . اختار مجمكعتيف فقط لتحقيؽ أىداؼ بحثو أك لعممو بعدـ كجكد الفئات الأخرل كىذا
 . (بايسيريـال الاعتباري)ىذه الحالة معامؿ الارتباط الثنائي 

كىك معامؿ نقكـ مف خلالو بإيجاد العلاقة الارتباطية بيف متغيريف أحدىما كمي كالآخر اسمي ذك تقسيـ 
ثنائي، عمى أف يككف ىذا التقسيـ الثنائي تقسيـ غير حقيقي فيك افتراضي، أم يتدخؿ الباحث في عممية 

التقسيـ لتحقيؽ أىداؼ بحثو، كالمتغير الاسمي تقسيمو قبؿ التجربة كالحالة الاجتماعية يقكـ الباحث 
. بتقسيميا إلى متزكج كأعزب فقط كيقصي الحالات الأخرل لعدـ تكفرىا أك لأنيا لا تخدـ أىداؼ البحث

 .𝑅pكيرمز لو بالرمز . فيذا التقسيـ يعتبر تقسيما اعتباريا كغير تحقيقي لأنو بتدخؿ الباحث كاجتياده
 :هشروط

 أحدىما بياناتو كمية كالثاني بياناتو اسميةمتغيريف   -
متزكج، ) (جامعي، غير جامعي)أف يككف تقسيـ المتغير الاسمي ثنائي أم يتككف مف مجمكعتيف  - 

  (أعزب
 .بتدخؿ الباحث (اعتبارم)أف يككف تقسيـ المتغير الاسمي تقسيـ غير حقيقي  - 
 أف يككف التقسيـ قبؿ التجربة أك القياس- 
 df = n-2درجة الحرية - 
 1 ك0قيمتو تتراكح بيف - 



 

𝑅p:          ويمكن حسابو بالمعادلة التالية = 𝐱 𝟏−𝐱 𝟐

 𝒏𝟏𝒏𝟐
𝑵

  𝒙𝟐− 𝑿 
𝟐

𝑵

 

 :حيث 
 :𝐱 𝟏 المتكسط الحسابي لممجمكعة الأكلى
:𝐱 𝟐 المتكسط الحسابي لممجمكعة الثانية
:𝐧𝟏عدد أفراد عينة المجمكعة الأكلى 
:𝐧𝟐 عدد أفراد عينة المجمكعة الثانية
:𝐍 (المجمكعة الثانية+ المجمكعة الأكلى )عدد أفراد كؿ العينة 

أي يكون تقسيم المتغير  (بايسيريـال الاعتباري)من بين شروط استخدام معامل الارتباط الثنائي  :ملاحظة
الاسمي غير حقيقي وأن يكون ىذا التقسيم حدث قبل التجربة أو عممية القياس، أما إذا كان ىذا التقسيم 

ويتم حسابو  (بايسيريـال الأصيل)حدث بعد عممية القياس فإننا نستخدم معامل الارتباط الثنائي الأصيل 
𝑟 :وفق المعادلة التالية =

𝑥1    −𝑥2    

𝑠
×

𝑛1𝑛2

𝑁2  𝑂
 

 :حيث
:𝐱 𝟏 المتكسط الحسابي لممجمكعة الأكلى
:𝐱 𝟐 المتكسط الحسابي لممجمكعة الثانية
:𝐧𝟏عدد أفراد عينة المجمكعة الأكلى 
:𝐧𝟐 عدد أفراد عينة المجمكعة الثانية
:𝐍 (المجمكعة الثانية+ المجمكعة الأكلى )عدد أفراد كؿ العينة 
S :الانحراؼ المعيارم 
O :الارتفاع المقابؿ في جدكؿ المساحات الصغرل كالكبرل 

n1= نقكـ بحساب المساحة الصغرل :  أكلا

N
n2= ، نقكـ بحساب المساحة الكبرل 

N
 

مف خلاؿ الجدكؿ الإحصائي لممساحات الصغرل كالكبرل نبحث عف القيمة المساكية لممساحة الكبرل : ثانيا
ذا لـ نجدىا نمجأ إلى قيمة التقريبية الكبرل لممساحة الصغرل Oكىي قيمة  ليس قيمة التقريبية )، كا 
 .Oكالتي تعتبرىا ىي قيمة  (الصغرل

 : يدويا𝑅𝑝 (بايسيريـال الاعتباري)حساب معامل الارتباط الثنائي - 2
 :مثال تطبيقي



 

 10عمى عينة مككنة مف  (أعزب ، متزكج)لدراسة العلاقة الارتباطية بيف الأداء الميني كالحالة الاجتماعية 
 :مكظفيف بكمية العمكـ الاجتماعية تحصمنا عمى النتائج التالية

 الأداء الميني
 الحالة

 الاجتماعية
     10 12 17 أعزب
 9 10 12 11 13 16 11 متزوج

 :الحل
 المتغير المستقؿ ىك الحالة الاجتماعية كىك متغير اسمي كذك تقسيـ ثنائي غير حقيقي: - نلاحظ أف 

 المتغير التابع ىك الأداء الميني كىك متغير كمي     - 
معامؿ الارتباط بايسيريػاؿ )إذا الأسمكب الإحصائي لقياس ىذا الارتباط يككف معامؿ الارتباط الثنائي 

 (الاعتبارم
  متزكج 2 أعزب، 1كليكف :  نقكـ بترميز متغير الحالة الاجتماعية :أولا
 : نقكـ بتبكيب البيانات في الجدكؿ:ثانيا

 المكظفيف
الحالة 
 الاجتماعية

أعزب  
1x 

متزكج 
 2x X X² 

 289 17   17 1(أعزب) 1

2 1 12   12 144 

3 1 10   10 100 

 2(متزوج)  4
 

11  11 121 

5 2 
 

16  16 256 

6 2 
 

13 13 169 

7 2   11 11 121 

8 2   12 12 144 

9 2   10 10 100 

10 2   9 9 81 

∑   39 82 121 1525 

X̅   13 11.71     

 :بالمعادلة التالية (بايسيريـال الاعتباري) حساب معامؿ الارتباط الثنائي :ثالثا

 
 تدؿ النتيجة عمى عدـ كجكد علاقة ضعيفة كيجب التأكد مف دلالتيا الإحصائية بمقارنيا بالقيمة الجدكلية

 (جدكؿ معامؿ بيرسكف)



 

مف أجؿ التأكد مف الدلالة :  الجدكلية𝑅𝑝  (بايسيريـال الاعتباري) معامؿ الارتباط الثنائي  إيجاد قيمة:رابعا
 .الإحصائية

  0.05لدينا مستكل الدلالة 
 df = n - 2 = 10 -2 = 8كلدينا درجة الحرية  

كىي أكبر مف  0.63 الجدكلية تساكم 𝑅𝑝(بايسيريػاؿ الاعتبارم)معامؿ الارتباط الثنائي كمنو فإف قيمة 
، كبالتالي فإننا 0.317 المحسكبة التي تساكم 𝑅𝑝  (بايسيريػاؿ الاعتبارم)معامؿ الارتباط الثنائي قيمة 

نقبؿ الفرض الصفرم كنرفض البديؿ أم نؤكد عدـ كجكد علاقة ارتباطية دالة إحصائيا بيف الأداء الميني 
 .كالحالة الاجتماعية

 :Spss باستخدام 𝑅𝑝 (بايسيريـال الاعتباري)حساب معامل الارتباط الثنائي - 3
، لكف يمكف SPSS اؿ الاعتبارم فيػللأسؼ، لا يكجد خيار مباشر لحساب معامؿ الارتباط بايسيرم

 لإيجاد مجاىيؿ المعادلة كالمتكسط الحسابي لممجمكعة الأكلى كالمتكسط  Spssالاستعانة ببرنامج 
الحسابي لممجمكعة الثانية كعدد أفراد العينة الأكلى كالعينة الثانية كالعدد الإجمالي لأفراد العينة مف خلاؿ 

 .تحميؿ الإحصاءات لتسييؿ عممية الحساب 
 :مف خلاؿ الخطكات التالية

Analyze → Descriptive Statistics → Frequecies 

 

  Variableفيظير المربع الحكارم التالي نقكـ بإدخاؿ المتغيرات إلى خانة 



 

 
 Ok ثـ Continue ثـ Mean نقكـ بالتأشير عمى statisticsثـ مف خلاؿ خانة 

 

 
 : نستخرج منو القيـ الكصفية كنعكضيا في المعادلةOutput لنا عدة جدكؿ في صفحة فزظِش

𝐱 𝟏13 = لمتكسط الحسابي لممجمكعة الأكلى  ا 
:𝐱 𝟐 11.71 = المتكسط الحسابي لممجمكعة الثانية 



 

:𝐧𝟏 3 = عدد أفراد عينة المجمكعة الأكلى 
:𝐧𝟐 7 = عدد أفراد عينة المجمكعة الثانية 
:𝐍  10 = (المجمكعة الثانية+ المجمكعة الأكلى )عدد أفراد كؿ العينة 

 نطبؽ ىذه المعطيات في المعادلة مثؿ الطريقة السابقة في الحساب اليدكم

 
:  

  أنواع 3وتحتوي بدورىا عمى : الحالة العاشرة
 متغير مستقل مكون من مجموعتين + متغير تابع كمي + فروق  
 (دراسة الفركؽ في المتغير كمي بناءا عمى عينتيف)

 T.testفي ىذه الحالة نستخدم اختبار ت 
، إذا تكفرت لمباحث (1908)ويميام جوست  لصاحبو العالـ "ستودنت"  أك اختبار "ت" كىك اختبار 

لممقارنة بيف متكسطيف تجريبيف، كىدفو التأكد مف كجكد " tت "مجمكعتيف فقط يمكنو أف يستخدـ الاختبار
ابوالنيل، ). المتكسطيف الناتجيف مف العينتيف فرقا ثابتا، أم لو دلالة إحصائيةفركؽ بيف ىاذيف

 (231،ص،1987

 :بالاضافة إلى (سابقة الذكر)لاستخداـ ىذا الاختبار يجب أف تتحقؽ شركط الاحصاء البرامترم 
 كجكد مجمكعتيف فقط -
 5حجـ العينتيف متقارب كلا يقؿ عف  -

 : كىيtت كىناؾ عدة أكنكاع مف اختبار 

 النوع الأول: الحالة العاشرة
 متغير مستقل مكون من مجموعتين مستقمتين + متغير تابع كمي + فروق  

 (دراسة الفركؽ في المتغير كمي بناءا عمى عينتيف مستقمتيف عف بعضيما)



 

  لعينتين مستقمتينT.testفي ىذه الحالة نستخدم اختبار ت 
 :  لعينتين مستقمتينT.testاختبار ت - 1

 يستخدم فييا اختبار ت لعينتين مستقمتين عن فرضية الفروق لعينتين مستقمتين: مثال

 

كمي كأف المتغير المستقؿ  (الذكاء)نلاحظ مف خلاؿ ىذه الفرضية أنيا فرضية فركؽ كأف المتغير التابع 
 يتككف مف مجمكعتيف مجمكعة الذككر كمجمكعة الإناث كانيما مستقميف عف بعضيما (ذككر،إناث)الجنس 

أم أف خصائص الذككر مستقمة عف خصائص الاناث كلا يشتركاف مع بعضميما، لذلؾ في ىذه الحالة 
 . لعينتيف مستقمتيفtت نستخدـ اختبار 

𝑇: كيمكف حسابيا مف خلاؿ القانكف التالي =
𝑋 1−𝑋 2

 
 𝑛1−1 𝑠1

2+ 𝑛2−1 𝑠2
2

 𝑛1+𝑛2 −2
× 

1

𝑛1
+

1

𝑛2
 

 

المتكسط الحسابي لمعينة الأكلى : X 1حيث 
X 2 :    المتكسط الحسابي لمعينة الثانية
s1

 تبايف العينة الاكلى: 2
s2

 تبايف العينة الثانية: 2
𝑛1 :حجـ العينة الأكلى 
𝑛2 :حجـ العينة الثانية 

 الجدكلية التي تستخرج مف tت  المحسكبة مع tت نقكـ بمقارنة tت كلمتأكد مف الدلالة الإحصائية لقيمة  
𝑛1) = الجداكؿ الإحصائية مف خلاؿ حساب درجة الحرية + 𝑛2) - 2  

 بديل اختبار ت لعينتين مستقمتين: 
 اذا لم تتوفر إحدى شروط الاحصاء البرامتري او كان المتغير التابع رتبي :01البديل
. مان ويتنياستخداـ الاختبار البديؿ كىك اختبار في ىذه الحالة يمكف 



 

معممي يُستخدـ لمقارنة مجمكعتيف  ىك اختبار لا U (Mann-Whitney U Test) ويتني-ختبار مان
يتـ المجكء إلى ىذا الاختبار عندما لا تستكفي البيانات افتراضات الاختبارات المعممية مثؿ . مستقمتيف
 :كيتني بالتفصيؿ -إليؾ الحالات التي يُستخدـ فييا اختبار ماف. لمجمكعتيف مستقمتيف t اختبار

 ويتني؟-متى نستخدم اختبار مان

 :عندما تكون البيانات غير موزعة طبيعياً  
 .t ستخدـ عندما لا تككف البيانات مكزعة طبيعيان، كلا يُفترض التكزيع الطبيعي كما ىك مطمكب في اختبار

 :عندما تكون البيانات ذات رتبة أو ترتيبية 
، أك مع البيانات الكمية التي لا يمكف (Ordinal Data) يُفضؿ استخدامو مع البيانات الترتيبية أك الرتبية

 .افتراض تجانسيا أك تكزيعيا الطبيعي
 :لمعينتين المستقمتين t عندما لا تتحقق افتراضات اختبار 

 .مثؿ عدـ تجانس التبايف أك كجكد قيـ شاذة تؤثر عمى النتائج
 :لمقارنة مجموعتين مستقمتين 

يُستخدـ لمقارنة تكزيع القيـ بيف مجمكعتيف مستقمتيف، مثؿ مقارنة درجات مجمكعتيف مف الطلاب عمى 
 .اختبار، حيث لا يمكف افتراض تكزيع طبيعي لمدرجات

 :عند التعامل مع عينات صغيرة 
ا مع العينات الصغيرة، إذ لا يتطمب شركطنا صارمة كتمؾ التي يحتاجيا اختبار  t الاختبار فعّاؿ أيضن

 اسمي اذا كان المتغير التابع :02البديل 
 ليس لمعينتين المستقمتين t اختبارذا كانت البيانات اسمية كترغب في مقارنة عينتيف مستقمتيف، فإف  

في ىذه الحالة، نستخدـ اختبارات مخصصة لمتعامؿ مع . مناسبنا، لأنو يتطمب بيانات كمية مكزعة طبيعينا
 (²كا) اختبار كاي تربيع للاستقلالية :كالبديؿ المناسب ىك. البيانات الاسمية

  ؟(χ2 Chi-Square Test of Independence)  (²كا) متى يُستخدم اختبار كاي تربيع للاستقلالية

 .(ؿالفش/مثؿ الجنس مقابؿ النجاح)يُستخدـ لمقارنة تكرارات الفئات بيف مجمكعتيف مستقمتيف 

 .البيانات الاسمية الثنائية أك متعددة الفئات :نوع البيانات 
لا يتطمب تكزيعان طبيعيان كلكنو يحتاج إلى حجـ عينة كاؼٍ بحيث تككف  :المتطمبات 

 . في معظـ الخلايا5الترددات المتكقعة أكبر مف 



 

 : لعينتين مستقمتين يدوياtت حساب اختبار - 2
 :مثال تطبيقي

مف أجؿ التأكد مف كجكد فركؽ في الذكاء بيف الذككر كالإناث لدل طمبة كمية العمكـ، قمنا باختبار لمعرفة 
 : ككانت النتائج كالتالي10 كعدد الإناث 08ذلؾ حيث كاف عدد الذككر 

  حساب اختبار ت كالتأكد مف الفركؽ في الذكاء التي تعزل لمجنس؟:المطموب
 X1 الأفراد

 الذككر
X2 
 الإناث

 
 

²(𝑥1 − 𝑥 )  ²(𝑥2 − 𝑥 ) 

01 5 7 -1 1 0.4 0.16 
02 9 8 3 9 1.4 1.96 
03 6 7 0 0 0.4 0.16 
04 8 6 2 4 -0.6 0.36 
05 2 5 -4 16 -1.6 2.56 
06 6 4 0 0 -2.6 6.76 
07 7 9 1 1 2.4 5.76 
08 5 7 -1 1 0.4 0.16 
09  9   2.4 5.76 
10  4   -2.6 6.76 
Ʃ 48 66  32  30.4 

المتوسط 

 الحسابي
6 6.6     

= 𝑥:  نقكـ بحساب المتكسط الحسابي لمعينتيف مف خلاؿ القانكف :أولا
 𝑥𝑖

𝑛
 

48:(ذككر)المتكسط الحسابي لمعينة الأكلى

8
= 6 =𝑥1   =

 𝑥1

𝑛
 

66:(ذككر)المتكسط الحسابي لمعينة الثانية

108
= 6.6 =𝑥2   =

 𝑥2

𝑛
 

𝑠²:  نقكـ بحساب التبايف لمعينتيف كفؽ القانكف التالي:ثانيا =
Ʃ(𝑥𝑖−x )²

𝑛−1
 

s1²: (ذككر)تبايف العينة الأكلى =
Ʃ(𝑥1−x )²

𝑛−1
=

32

8−1
= 4.57 

s2²: (إناث)تبايف العينة الثانية  =
Ʃ(𝑥2−x )²

𝑛−1
=

30.4

10−1
= 3.37 

 : حساب قيمة ت المحسكبة لعينتيف مستقمتيف مف خلاؿ القانكف:ثالثا



 

 =
6−6.6

 
 8−1 4.57+ 10−1 3.37

 8+10 −2 × 
1
8+ 1

10 

  𝑇 =
𝑋 1−𝑋 2

 
 𝑛1−1 𝑠1

2+ 𝑛2−1 𝑠2
2

 𝑛1+𝑛2 −2
× 

1

𝑛1
+

1

𝑛2
 

 

 

𝑛1) = درجة الحرية الجدكلية عند تيجب إيجاد  + 𝑛2)- 2 =(10+8)-2=16 0.05 كمستكل الدلالة 
الجدكلية أكبر " ت"،نلاحظ أف القيمة المطمقة لػ 0.64- المحسكبة تساكم  ت ، إذا فإف2.120كىي تساكم 

 الجدكلية فأننا نتقبؿ الفرض الصفرم كنرفض تالمحسكبة كبالتالي كىي أقؿ مف " ت"مف القيمة المطمقة لػ 
البديؿ كنقكؿ أنو لا تكجد فركؽ ذات دلالة إحصائية في الذكاء تعزل لمتغير الجنس أم تكجد فركؽ في 

 .الذكاء بيف الذككر كالإناث

 :Spss لعينتين مستقمتين باستخدام tت حساب اختبار - 3
 : لعينتيف مستقمتيف نتبع الخطكات التاليةtلحساب اختبار ت 

Analyze → Compare Means →Independent –Samples T Test 

 

: فيظير لنا المربع الحكارم التالي
 نضع المتغير المراد دراسة فركؽ فيو كليكف متغير المكاطنة  Test Variableفي خانة 
التنظيمية  
 (ذكر، أنثى) نضع في المجكعتيف مثؿ الجنس  Grouping Variableكفي خانة 



 

 :  نقكـ بتعريؼ المجمكعات كالتاليDefine Groupsثـ مف خلاؿ أيقكنة 
       1 Group  2 / (ذكر)1 بالرقـ Group  ثـ  (أنثى)2 بالرقـContinue ثـ Ok 

 

 

 Outputفتظير لنا عدة جداكؿ في صفحة 
المتكسط -  عدد العينة في كؿ مجمكعة :  ىك الجدكؿ الكصفي للاختبار يحتكم عمى:الجدول الأول

 .  الانحراؼ المعيارم–الحسابي 

 



 

 :الجدول الثاني

 
 : الأكلى إذا كانت Sigأكلا نشاىد قيمة 

Sig < 0.05 في ىذه الحالة نختار القيـ في الصؼ السفمي، أما إذا كانت  Sig > 0.05 نختار 
 .القيـ في الصؼ العمكم 
 ، إذا نختار القيـ في الصؼ 0.05 كىي أكبر مف 0.99=  الأكلى Sigفي مثالنا ىذا نجد قيمة 

 :العمكم مف الجدكؿ فتجد ما يمي 
t = 0.48 ودرجة الحرية ، df = 48 وقيمة ، Sig (2.tailed) =0.63 (وىو ما ييمنا) 
 فإننا نقبؿ الفرض الصفرم كنرفض 0.05 وىي أكبر من Sig (2.tailed) =0.63بما أف قيمة - 

البديؿ كنقكؿ لا تكجد فركؽ ذات دلالة إحصائية في المكاطنة التنظيمية تعكد لمجنس عند أفراد عينة 
 .الدراسة

 في ىذه الحالة نرفض الفرض الصفرم كنقبؿ 0.05أقل من  Sig (2.tailed)أما لك كانت - 
الفرض البديؿ كنقكؿ تكجد فركؽ ذات دلالة إحصائية في المكاطنة التنظيمية تعكد لمجنس عند أفراد 

 .عينة الدراسة
 النوع الثاني: الحالة العاشرة

 متغير مستقل مكون من مجموعتين مترابطتين + متغير تابع كمي + فروق  
 (دراسة الفركؽ في المتغير كمي بناءا عمى عينتيف مترابطتيف)

  لعينتين مترابطتينT.testفي ىذه الحالة نستخدم اختبار ت 

 : لعينتين مترابطتينtت اختبار - 1

 عن فرضية الفروق لعينتين مترابطتين يستخدم فييا اختبار ت لعينتين مترابطتين:1مثال



 

 
 يوجد تأثير لمبرنامج التدريبي المطبق عمى التحصيل الدراسي لطمبة كمية العموم الاجتماعية- 

كمي كأف المتغير  (التحصيؿ الدراسي)نلاحظ مف خلاؿ ىذه الفرضية أنيا فرضية فركؽ كأف المتغير التابع 
 يتككف مف قياسيف القياس القبمي كالقياس البعدم أم نفس مجمكعة الطمبة لكف ،(البرنامج التدريبي)المستقؿ 

، أم أف المجمكعتيف مترابطتيف بنفس الخصائص كيشتركاف مع بعضميما، (قبمي كبعدم)بقياسيف مختمفيف 
 . لعينتيف مترابطتيفtت لذلؾ في ىذه الحالة نستخدـ اختبار 

𝑇: كيمكف حسابيا مف خلاؿ القانكف التالي =
𝑑 

𝑆𝑑
 𝑛

 

 حجـ العينة: 𝑛: حيث 
𝑑  :متكسط الفرؽ بيف المشاىدات كيتـ حسابو كفؽ القانكف التالي :𝑑 =

 𝑑

𝑛
 

S𝑑 :الانحراؼ المعيارم لممشاىدات كيتـ حسابو كفؽ القانكف التالي :𝑆𝑑 =  
 𝑑²−𝑛𝑑 ²

𝑛−1
 

 الجدكلية التي تستخرج مف tت  المحسكبة مع tت نقكـ بمقارنة tت كلمتأكد مف الدلالة الإحصائية لقيمة  
 𝑛- 1= (df) الجداكؿ الإحصائية مف خلاؿ حساب درجة الحرية

 لدراسة الفركؽ بيف نفس الأفراد لكف في حالتيف مختمفتيف 
كىي الحالة التي نلاحظ فييا أفراد نفس العينة تحت حالتيف مختمفتيف، في ىذه الحالة يتـ : الحالة الأولى

 .اخضاع أفراد العينة إلى مكقفيف تجريبيف لملاحظة تأثير الحاليتف عمى نتائج أفراد العينة
نفس مجمكعة الطمبة نقكـ باجراء اختبار لقياس تحصيميـ في مادة الاحصاء ثـ نقكـ باجراء اختبار :مثال

 .لقياس تحصيميـ  في مادة الرياضيات، ثـ نقارف ىؿ تكجد فركؽ في تحصيميـ لممادتيف

 



 

 تحدث ىذه الحالة عندما نقكـ باختبار قبمي كاختبار بعدم عمى نفس العينة مف الأفراد، في :الحالة الثانية
، ثـ نعيد اختبارىـ في الكقت 1ىذه الحالة نختبر أفراد العينة قبؿ اخضاعيـ لمعامؿ التجريبي في الكقت ز

 .. بعد اخضاعيـ لمعامؿ التجريبي2ز
 ثـ نطبؽ عمييـ (قياس قبمي) 1 نفس مجمكعة الطمبة نقكـ باجراء اختبار لقياس تحصيميـ الدراسي :مثال

 بعد تطبيؽ البرنامج التدريب 2برنامج تدريبي لتحسيف تحصيميـ، ثـ نقكـ اختبار لقياس تحصيميـ الدراسي 
 .2 ك1 ، ثـ نقارف ىؿ تكجد فركؽ في تحصيميـ (قياس بعدي)

 
 (184،ص، 2011بوحفص،)

 بديل اختبار ت لعينتين مترابطتين: 

 اذا لم تتوفر إحدى شروط الاحصاء البرامتري او كان المتغير التابع رتبي :01البديل

. ويمكوكسون لمرتب الموقعة يمكف استخداـ الاختبار البديؿ كىك اختبار في ىذه الحالة 
معممي يُستخدـ  ىك اختبار لا  (Wilcoxon Signed-Rank Test) اختبار ويمكوكسون لمرتب الموقعة

لمعينات المرتبطة عندما لا  t لمقارنة القيـ المرتبطة في عينتيف متطابقتيف أك زكجيتيف، كيعد بديلان لاختبار
إليؾ الحالات التي يُستخدـ فييا اختبار كيمكككسكف لمرتب المكقعة . يتـ استيفاء افتراضات التكزيع الطبيعي

 :بالتفصيؿ
 متى نستخدم اختبار ويمكوكسون لمرتب الموقعة؟

 :عند مقارنة مجموعتين مرتبطتين 
يُستخدـ للاختبارات التي تتضمف قياسيف عمى نفس المجمكعة، مثؿ قبؿ كبعد العلاج، أك الاختبارات 

 .المتكررة عمى نفس الأشخاص
 :عندما تكون البيانات غير موزعة طبيعياً  

لمعينات المرتبطة عندما لا تككف البيانات مكزعة طبيعيان، أك تحتكم عمى قيـ شاذة  t يستخدـ كبديؿ لاختبار
 .t تؤثر عمى نتائج اختبار

 
 



 

 :مع البيانات الترتيبية أو الرتبية 
أك البيانات الكمية التي لا تمبي افتراضات التكزيع  (Ordinal Data) مثالي للاستخداـ مع البيانات الترتيبية

 .الطبيعي
 :التحقق من الفروق في الاتجاه بين القياسات المرتبطة 

 .يُستخدـ لفحص ما إذا كانت الفركؽ بيف الأزكاج تتجو في الغالب نحك الاتجاه المكجب أك السالب
 :(Pre-Post Studies) في دراسات التقييم القبمي والبعدي 

 .مثؿ تقييـ فعالية علاج ما مف خلاؿ مقارنة الأعراض قبؿ كبعد العلاج لدل نفس المرضى

 اسمي اذا كان المتغير التابع :02البديل
، (مثؿ نفس المجمكعة قبؿ كبعد التدخؿ)رغب في مقارنة عينتيف مترابطتيف فعندما تككف البيانات اسمية ك

معممية تتعامؿ مع  في ىذه الحالة، نستخدـ اختبارات لا.  ليس مناسبنالمعينتين المترابطتين t اختبارفإف 
 (McNemar’s Test)  اختبار ماكنيمار البديؿ الأنسب ىك. البيانات الاسمية

 متى يُستخدم اختبار ماكنيمار؟
 :لممقارنات بين عينتين مترابطتين أو مكررتين 

يُستخدـ لاختبار التغييرات في النسب بيف قياسيف مترابطيف، مثؿ قياس نفس الأشخاص قبؿ كبعد التدخؿ 
 .أك العلاج
 :عند التعامل مع البيانات الاسمية الثنائية 

 (الرفض/الفشؿ، المكافقة/مثؿ النجاح)مناسب لمبيانات الاسمية الثنائية 
 :دراسة التغييرات أو التحولات بين الفئات 

يُستخدـ عندما تريد معرفة ما إذا كاف ىناؾ تغيير ذك دلالة إحصائية في الردكد بيف حالتيف لنفس 
 .المجمكعة

 : لعينتين مترابطتين يدوياtت حساب اختبار - 2
: مثال تطبيقي

 مف أجؿ التأكد مف فعالية برنامج تدريبي لتنمية ميارات التحصيؿ قاـ باحث بقياس ىاتو الميارات قبؿ 
 طمبة، كثـ قاـ بتطبيؽ ىذا البرنامج كقاـ بقياس بعد تطبيؽ البرنامج  فكانت 10تطبيؽ البرنامج عمى 

 :النتائج كالتالي
 
 



 

  حساب اختبار ت كالتأكد ىؿ تكجد فركؽ في التحصيؿ الدراسي قبؿ كبعد تطبيؽ البرنامج؟:المطموب
 X1 الأفراد

قبؿ 
 التطبيؽ

X2 
بعد 
 التطبيؽ

 
d=x1-x2 

 

 
d² 

 

01 15 14 1 1 
02 19 18 1 1 
03 16 17 -1 1 
04 8 9 -1 1 
05 12 15 -3 9 
06 6 5 1 1 
07 17 19 -2 4 
08 9 12 -3 9 
09 12 14 -2 4 
10 5 10 -5 25 
Ʃ 119 133 -14 56 

 المتوسط

 الحسابي
  -1.4  

 : نقكـ بحساب المتكسط الحسابي لمفرؽ بيف المشاىدات كفؽ القانكف التالي:أولا

 
 :الانحراؼ المعيارم لممشاىدات كفؽ القانكف التالينقكـ بحساب :ثانيا

 
 :لعينتيف مترابطتيف كفؽ القانكف التالي" ت" نقكـ بحساب : ثالثا

 



 

 كىي تساكم 0.05 كمستكل الدلالة 𝑛- 1 =10-1=9= (df) درجة الحرية الجدكلية عند تيجب إيجاد 
 الجدكلية فأننا نتقبؿ الفرض الصفرم ت كىي أقؿ مف 2.22 المحسكبة تساكم  ت ، إذا فإف2.262

كنرفض البديؿ كنقكؿ أنو لا تكجد فركؽ في التحصيؿ الدراسي قبؿ كبعد تطبيؽ البرنامج أم لا يكجد أثر 
 .لفعالية البرنامج تدريبي  في تنمية ميارات التحصيؿ الدراسي 

 :Spss لعينتين مترابطتين باستخدام tت حساب اختبار - 3
 : لعينتيف مترابطتيف نتبع الخطكات التاليةtلحساب اختبار ت 

Analyze → Compare Means →Paired –Samples T Test 

 

 (قبؿ التطبيؽ، بعد التطبيؽ) نقكـ مف خلالو بنقؿ المجمكعتيف :فيظير لنا المربع الحكارم التالي
 Ok عمى الترتيب ثـ Paired Variablesإلى خانة 

 
 



 

 
 Outputفتظير لنا عدة جداكؿ في صفحة 

 عدد العينة في كؿ –المتكسط الحسابي :  ىك الجدكؿ الكصفي للاختبار يحتكم عمى:الجدول الأول
 . الانحراؼ المعيارم-  مجمكعة 

 
 أم أف الارتباط 0.90 يكضح قيمة معامؿ الارتباط بيف المجمكعتيف كىي تساكم :الجدول الثاني

  أم أنيا دالة إحصائيا0.05 كىي أقؿ مف 0.00 تساكم Sigطردم قكم جدا ، كقيمة 

 
 :يحتكم عمى عدة قيـ ميمة منيا: الجدول الثالث

 Meam = 1.4كىذا يمثؿ الفرؽ بيف المتكسطيف  
 Std.Deviation = 2.01يمثؿ الانحراؼ المعيارم لمعينتيف  
 T = 2.20تمثؿ قية الاختبار ت  
 Df = 9تمثؿ درجة الحرية  



 

 Sig = 0.055 فأننا نقبؿ الفرض الصفرم ، 0.05 تمثؿ قيمة مستكل الدلالة كىي أكبر مف
كنرفض البديؿ كنقكؿ أنو لا تكجد فركؽ في التحصيؿ الدراسي قبؿ كبعد تطبيؽ البرنامج أم لا 

 .يكجد أثر لفعالية البرنامج تدريبي  في تنمية ميارات التحصيؿ الدراسي 

 
 النوع الثالث: الحالة العاشرة

 متغير مستقل مكون من مجموعة واحدة + متغير تابع كمي + فروق  
 (دراسة الفركؽ في المتغير كمي بناءا عمى متكسط مجمكعة كاحدة)

  لعينة واحدةT.testفي ىذه الحالة نستخدم اختبار ت 
 : لعينة واحدةtت اختبار - 1

 عن فرضية الفروق لعينة واحدة:مثال

 

نلاحظ مف خلاؿ ىذه الفرضية أنيا فرضية فركؽ كأننا سكؼ نقارف بيف متكسط حسابي كىك متكسط 
، أم أف ىناؾ مجمكعة كاحدة فقط مف الطمبة نريد نقارف 10معدلات الطمبة كالمتكسط الفرضي لمنجاح كىك 

 . لعينة كاحدة "tت "، في ىذه الحالة نستخدـ اختبارمعدلاتيا بمعدؿ النجاح
 لعينة كاحدة إذا أردنا مقارنة متكسط عينة بمتكسط المجتمع أك متكسط  "tت "إذا نقكـ باستخداـ اختبار 

 .فرضي

𝑇:كيمكف حسابيا مف خلاؿ القانكف التالي =
𝑋 −𝜇

𝑆

 𝑛

 

المتكسط الحسابي لمعينة  :  𝑋:حيث
𝜇 :  مجتمعالمتكسط الحسابي لؿ 



 

𝑆 :    الانحراؼ المعيارم لمعينة 
𝑛         : حجـ العينة 

الجدكلية التي تستخرج " tت "المحسكبة مع" tت "نقكـ بمقارنة " tت " كلمتأكد مف الدلالة الإحصائية لقيمة 
 .𝑛- 1= (df) مف الجداكؿ الإحصائية مف خلاؿ حساب درجة الحرية

أما إذا كاف تبايف المجتمع معمكـ نستخدـ  " Tت " إذا كاف تبايف المجتمع مجيكؿ نستخدـ اختبار:ملاحظة
 "Z"اختبار
 بديل اختبار ت لعينة واحدة: 
 اذا لم تتوفر إحدى شروط الاحصاء البرامتري او كان المتغير التابع رتبي :01البديل

 أك كانت بيانات المتغير ، مثؿ التكزيع الطبيعيلعينة واحدة t عندما لا تستكفي البيانات افتراضات اختبار
   اختبار كيمكككسكف للإشارة:البديؿ الأكثر شيكعنا ىك. معممي كبديؿ ، يُستخدـ اختبار لاالتابع رتبية

(Wilcoxon Signed-Rank Test)  لعينة كاحدة 
 لعينة واحدة؟ t متى يُستخدم اختبار ويمكوكسون للإشارة كبديل لاختبار

 :عندما تكون البيانات غير موزعة طبيعياً  
 . عندما تككف البيانات غير مكزعة بشكؿ طبيعي، أك تحتكم عمى قيـ شاذةيسُتخذم

 :مع البيانات الترتيبية أو البيانات المستمرة غير الطبيعية 
 .مناسب لمبيانات الترتيبية أك البيانات المستمرة التي لا تُظير التكزيع الطبيعي

 :لمقارنة عينة مع قيمة معيارية أو ثابتة 
يُستخدـ عندما تريد مقارنة عينة مف البيانات مع قيمة معيارية أك متكقعة، مثؿ اختبار ما إذا كاف متكسط 

 .درجات الطلاب يختمؼ عف درجة معينة
 اسمي اذا كان المتغير التابع :02البديل

لا يناسب ىذا النكع مف  t اختبارعندما تككف البيانات اسمية كترغب في اختبار ت لعينة كاحدة، فإف 
.  البيانات لأنو يتطمب بيانات كمية

في حالة البيانات الاسمية لعينة كاحدة، يُستخدـ اختبار يتناسب مع طبيعة البيانات الاسمية، كأبرز ىذه 
 (χ2 Chi-Square Goodness of Fit Test) لحسف المطابقة اختبار كام تربيع  :الاختبارات ىك

 ة؟حسن المطابقمتى يُستخدم اختبار كاي تربيع ل
 :لمقارنة التوزيع الفعمي مع توزيع متوقع أو نظري 

 .ستخدـ لمعرفة ما إذا كانت التكزيعات الفعمية لمفئات تتطابؽ مع التكزيعات المتكقعةم



 

 :عند التعامل مع البيانات الاسمية أو الفئوية 
لمتحقؽ مما إذا كانت الفئات مكزعة  (لا/مثؿ الألكاف المفضمة، الإجابات بنعـ)طبؽ عمى البيانات الاسمية م

 .بشكؿ عشكائي أك كفقنا لتكزيع محدد
 :لمتحقق من فرضيات النسب المحددة 

يمكنؾ استخدامو لاختبار فرضيات حكؿ نسب الفئات، مثؿ اختبار ما إذا كانت نسب نجاح حممة تسكيقية 
 .متطابقة مع ىدؼ محدد

 : لعينة واحدة يدوياtت حساب اختبار - 2
 :مثال تطبيقي

 طمبة مكضح في الجدكؿ التالي، ككاف 10 مف قسـ عمـ النفس مككف مف 01لدينا نتائج معدلات الفكج 
 .12.12لدينا معدؿ طمبة قسـ عمـ النفس ككؿ ىك 

 كمتكسط معدلات 01 حساب اختبار ت كالتأكد ىؿ تكجد فركؽ بيف متكسط معدلات طمبة الفكج :المطموب
 طمبة القسـ ككؿ؟

 X الأفراد
طمبة 
 الفكج

 

 

 

 

01 15 1 1 
02 19 1 1 
03 16 -1 1 
04 8 -1 1 
05 12 -3 9 
06 6 1 1 
07 17 -2 4 
08 9 -3 9 
09 12 -2 4 
10 5 -5 25 
Ʃ 119 -14 56 

 المتوسط

 الحسابي
11.9   

 : نقكـ بحساب المتكسط الحسابي لمعينة كفؽ القانكف التالي:أولا



 

 
 :  نقكـ بحساب المتكسط الحسابي لممجتمع  كفؽ القانكف التالي:ثانيا

𝜇 =
 𝜇

𝑛
= 𝟏𝟐.  (مكجكدة في المعطيات )𝟏𝟐

 :  نقكـ بحساب الانحراؼ المعيارم لمعينة كفؽ القانكف التالي:ثالثا

 
 :لعينة كاحدة مف خلاؿ القانكف التالي " ت" نقكـ بحساب اختبار: رابعا

 
 كىي تساكم 0.05 كمستكل الدلالة 𝑛- 1 =10-1=9= (df) درجة الحرية الجدكلية عند تيجب إيجاد 

الجدكلية أكبر مف القيمة " ت" نلاحظ أف القيمة المطمقة لػ0.14-  المحسكبة تساكم  ت ، إذا فإف2.262
المحسكبة كبالتالي فإننا نقبؿ الفرض الصفرم كنرفض البديؿ كنقكؿ أنو لا تكجد فركؽ بيف " ت"المطمقة لػ 

 . كمتكسط معدلات طمبة القسـ ككؿ01متكسط معدلات طمبة الفكج 
 Spss لعينة واحدة باستخدام tت حساب اختبار - 3

 : لعينة كاحدة نتبع الخطكات التاليةtلحساب اختبار ت 
Analyze → Compare Means →Paired –One - Samples T Test 

 



 

كنضع  Test Variable  نقكـ بنقؿ المتغير المراد دراستو إلى خانة:فيظير لنا المربع الحكارم التالي
 12.12الرقـ المراد المقارنة بو، في مثالنا ىذا ىك معدؿ  Test Valueفي خانة 

 

 

 
 Exclude cases analysis by كنختار % 99 أك %95 نختار النسبة Optionsثـ مف خلاؿ أمر 

analysis ثـ Continue  ثـ Ok 



 

 
 Outputفتظير لنا عدة جداكؿ في صفحة 

المتكسط - عدد العينة المجمكعة :  ىك الجدكؿ الكصفي للاختبار يحتكم عمى:الجدول الأول
 . الانحراؼ المعيارم-  الحسابي

 
 :يحتكم عمى عدة قيـ أىميا: الجدول الثاني

 Meam Difference = 0.22كىذا يمثؿ الفرؽ بيف المتكسطيف  
 T = 0.14تمثؿ قية الاختبار ت  
 Df = 9تمثؿ درجة الحرية  
 Sig = 0.88 فإننا نقبؿ الفرض الصفرم كنرفض ، 0.05 تمثؿ قيمة مستكل الدلالة كىي أكبر مف

 كمتكسط معدلات طمبة القسـ 01البديؿ كنقكؿ أنو لا تكجد فركؽ بيف متكسط معدلات طمبة الفكج 
 .ككؿ

 



 

 : الحالة الحادي عشر
 متغير مستقل مكون من أكثر من مجموعتين + متغير تابع كمي + فروق  
 ( متكسطات فأكثر3دراسة الفركؽ في المتغير كمي بناءا عمى )

 Anova تحميل التباين الأحادي  في ىذه الحالة نستخدم اختبار

 : Anovaاختبار تحميل التباين  - 1
 : عن فرضية الفروق لتحميل التباين الأحادي:مثال

 
 كأف المتغير كمي (الأداء الميني)نلاحظ مف خلاؿ ىذه الفرضية أنيا فرضية فركؽ كأف المتغير التابع 

 ( سنة15 ك5بيف )ك ( سنكات5أقؿ مف ):  يتككف مف ثلاثة مجمكعات ىي (البرنامج التدريبي)المستقؿ 
كأف ىذه المجمكعات مستقمة عف بعضيا البعض، لذلؾ في ىذه الحالة نستخدـ ، ( سنة15أكثر مف )ك

 .Anova التحميؿ التبايف الأحادم Fاختبار 
، كىك اختبار الفركؽ بيف (1918)روتاك فيشر  لصاحبو العالـ تحميل التباين أك اختبار "F" كىك اختبار 

 متكسطات فأكثر لمتأكد مف أف الفركؽ بيف ىذه المتكسطات ذات دلالة إحصائية، كيتككف تحميؿ التبايف 3
مف التبايف بيف المجمكعات أم الاختلاؼ بيف الأفراد في كؿ المجمكعات كالتبايف داخؿ المجمكعات أم 

 (2020عبان، تحميل التباين الأحادي الاتجاه،).الاختلاؼ بيف الأفراد داخؿ كؿ مجمكعة عمى حدل

 :بالاضافة إلى (سابقة الذكر)لاستخداـ ىذا الاختبار يجب أف تتحقؽ شركط الاحصاء البرامترم 
 ( فما فكؽ3)كجكد أكثر مف مجمكعتيف  -
 المتغير التابع كمي  -
 استقلالية المجمكعات في المتغير المستقؿ -
  لديو الكثير مف الأنكاع اىميا:أنواعو
 تحميل التباين الاحادي:One way Anova 3 اذا كاف المتغير المستقؿ كاحد كيتككف مف 

 (وىو الاكثر استخداما في البحوث الاجتماعية )مجمكعات فما فكؽ كمتغير تابع كاحد كمي 



 

  تحميل التباين المتعدد: Two way Anova اذا كاف ىناؾ متغيريف مستقميف أك أكثر كمتغير 
 تابع كاحد كمي

 تحميل التباين متعدد المتغيرات التابعة:Manovaىناؾ أكثر مف متغير تابع كمي 
  :One way Anova:تحميل التباين الاحادي- أ

 :كيمكف حسابو كفؽ الطريقة التالية 
 : حساب مجمكع المربعات الكمي كفؽ القانكف التالي -1

 
 تمثؿ مجمكع مربعات جميع الدرجات لدل جميع المجمكعات𝑥² حيث

  𝑥 ²تمثؿ مربع مجمكع جميع الدرجات لدل جميع المجمكعات 
𝑛العدد الكمي للأفراد 

: نقكـ بحساب مجمكع المربعات بيف المجمكعات كفؽ القانكف التالي- 2

مجمكع المربعات بيف المجمكعات =
  𝑥1 ²

𝑛1
+

  𝑥2 ²

𝑛2
+ ⋯ +

  𝑥𝑘 ²

𝑛𝑘
−

  𝑥 2

𝑁
 

 :حيث
  𝑥1 ²تمثؿ مربع مجمكع درجات المجمكعة الأكلى  
  𝑥2 ²تمثؿ مربع مجمكع درجات المجمكعة الثانية  
  𝑥𝑘 ² تمثؿ مربع مجمكع درجات المجمكعة( k ) 
  𝑥 ²تمثؿ مربع مجمكع جميع الدرجات لدل جميع المجمكعات  

Nالعدد الكمي للأفراد  
𝑛1 عدد أفراد المجمكعة الأكلى  
𝑛2عدد أفراد المجمكعة الثانية  
𝑛𝐾 عدد أفراد المجمكعة k 
كيتـ ذلؾ مف خلاؿ القانكف : (الخطأ كالبكاقي)حساب مجمكع المربعات داخؿ المجمكعات - 3

 :التالي
 مجموع المربعات بين المجموعات- مجموع المربعات الكمي= مجموع المربعات داخل المجموعات 

 :يتـ حسابيا كما يمي: حساب درجات الحرية-4



 

 K– 1 أم 1-عدد المجمكعات= درجة الحرية بيف المجمكعات 
    (N –K) عدد المجمكعات  أم  – المجمكع الكمي للأفراد  = درجة الحرية داخؿ المجمكعات

          (N –1) أم 1-المجمكع الكمي للأفراد = درجة الحرية لمتبايف الكمي
 :كيتـ حسابيا كما يمي: حساب متكسط المربعات-5

 درجات الحرية،÷ مجمكع المربعات بيف المجمكعات= متكسط المربعات بيف المجمكعات 
𝑀𝑆𝐵أم  =

𝑆𝑆𝐵

𝐾−1
 

 درجة الحرية ÷ مجمكع المربعات بيف المجمكعات= متكسط المربعات داخؿ المجمكعات 
𝑀𝑆𝑊أم   =

𝑆𝑆𝑊

𝑁−𝐾
 

 :كيتـ حسابيا كما يمي: Fحساب النسبة الفائية -6

F =
متكسطالمجمكعات المربعات بيف المجمكعات

متكسط المربعات داخؿ 
𝐹 أم  =

𝑀𝑆𝐵

𝑀𝑆𝑊
 

 
 (df) درجة الحريةعند ك  (عدد المجمكعات) =K-1البسط  (df) درجة الحرية الجدكلية عند Fإيجاد - 7

  المحسكبةF  ك الجدكليةFثـ نقارف بيف ، 0.05 كمستكل الدلالة   N –Kالمقام 
  بديل اختبار تحميل التباين الأحادي(ANOVA):  
 اذا لم تتوفر إحدى شروط الاحصاء البرامتري او كان المتغير التابع رتبي :01البديل

 يُستخدـ عندما لا تتحقؽ افتراضات (ANOVA) تحميل التباين الأحاديالبديؿ لاختبار  :ملاحظة
ANOVAأك كانت بيانات المتغير التابع رتبية، مثؿ التكزيع الطبيعي كتجانس التبايف بيف المجمكعات  .

 اختبار كركسكاؿ كالاسك ق ANOVA البدائؿ الأكثر شيكعنا لاختبار



 

 ؟(Kruskal-Wallis H Test)  اختبار كروسكال والاس متى يُستخدم
 .عندما لا تتحقؽ افتراضات التكزيع الطبيعي لمبيانات :البيانات غير موزعة طبيعيًا 
 .إذا كانت المجمكعات لا تظير تبايننا متجانسنا :عدم تجانس التباين 
يُستخدـ مع البيانات الترتيبية أك الرتبية، أك مع البيانات الكمية التي لا تحقؽ  :البيانات الترتيبية 

 .ANOVA افتراضات
 :كيفية عممو

يُقارف رتب البيانات بيف ثلاث مجمكعات أك أكثر لتحديد ما إذا كانت ىناؾ فركؽ ذات دلالة إحصائية بيف 
 .المجمكعات

ي اسم اذا كان المتغير التابع :02البديل 
 بناءن عمى حجـ العينة اختبار فيشر الدقيق أك اختبار كاي تربيعلمبيانات الاسمية البحتة، يُفضؿ استخداـ 

 (χ2 Chi-Square Test of Independence) اختبار كاي تربيع للاستقلاليةكتكزيع البيانات، 
ىذا الاختبار يُستخدـ لفحص العلاقة بيف متغيريف . يمكف استخدامو لمتعامؿ مع أكثر مف مجمكعتيف

 ليذا يمكف .كقد يككف لو أكثر مف فئة في كؿ متغير (Contingency Table) اسمييف في جدكؿ تكرارات
 .استخدامو كبديؿ لاختبار تحميؿ التبايف الأحادم في حالة البيانات الاسمية

 : يدوياAnova تحميل التباين الأحادي Fحساب اختبار - 2
 :مثال تطبيقي

قاـ باحث بقياس الأداء الميني لمجمكعة مف المكظفيف، كأراد أف يرل ىؿ ىناؾ فركؽ في أداء ىؤلاء 
 : مجمكعات كالتالي3المكظفيف تعزل لمتغير الخبرة المينية، حيث قسـ الخبرة المينية إلى 

  سنكات5أقؿ مف  : 01 المجمكعة 
  سنة15 ك5بيف : 02                   المجمكعة 
  سنة15أكثر مف : 03                   المجمكعة 

 تكجد فركؽ في أداء المكظفيف تعزم لمخبرة المينية؟ كالتأكد ىؿ Fحساب اختبار : المطموب
 Ʃ الأداء المهنً    

 

  
الخبرة 
 المهنٌة
  
  
  
  

 x1 7 5 4 3 8 9     36 6 5اقل من 

 x2 9 4 3 2 1 4 6   29 4.1429 15 و5بٌن 

 x3 5 7 7 8 4 6 9 4 50 6.25 15 من أكثر

  x1² 49 25 16 9 64 81 0 0 244 
 

  x2² 81 16 9 4 1 16 36 0 163 
 

  x3² 25 49 49 64 16 36 81 16 336 
 



 

  نقكـ المتكسطات الحسابية لممجمكعات:أولا 
50

8
= 𝟔. 𝟐𝟓 =𝑥3   =

 𝑥3

𝑛3

29

7
= 4.14 =𝑥2   =

 𝑥2

𝑛2

36

6
= 6 =𝑥1   =

 𝑥1

𝑛1
 

 ( مجمكعات3لدينا ):  نقكـ بحساب مجمكع المربعات بيف المجمكعات كفؽ القانكف التالي:ثانيا

 
 :حساب مجمكع المربعات الكمي كفؽ القانكف التالي: ثالثا

 
كيتـ ذلؾ مف خلاؿ : (الخطأ كالبكاقي)حساب مجمكع المربعات داخؿ المجمكعات : رابعا

 :القانكف التالي
 مجموع المربعات بين المجموعات- مجموع المربعات الكمي= مجموع المربعات داخل المجموعات 

 18.88- 113.24= مجمكع المربعات داخؿ المجمكعات 
  94.35= مجمكع المربعات داخؿ المجمكعات 

 :ويتم تمخيص العمميات الحسابية في الجدول التالي
 مصدر التباين

source 
 مجموع المربعات

Sum of Squares 
 درجات الحرية

df 
 متوسط المربعات

Mean of Squares 
F 

 المحسوبة
F 

 الجدكلية
 بين المجموعات
Ss between 

groups 

 
18.88 

 
2 

 
9.44 

 
1.80 

 
3.55 

 داخل المجموعات
Ss within 
groups 

 
94.35 

 
18 

 
5.24 

  

 التباين الكمي
total 

113.24 20    

 : حساب درجات الحرية:خامسا
 2=1-3 =1 -(عدد المجمكعات) K= درجة الحرية بيف المجمكعات

 N –K = 21- 3 = 18:درجة الحرية داخؿ المجمكعات 



 

 N –1 = 21- 1 = 20:1-المجمكع الكمي للأفراد = درجة الحرية لمتبايف الكمي
 : حساب متكسط المربعات:سادسا

 9.44 = 2 ÷ 18.88= درجة الحرية ÷ مجمكع المربعات = متكسط المربعات بيف المجمكعات 
 5.24= 18 ÷ 94.35= درجة الحرية ÷ مجمكع المربعات = متكسط المربعات داخؿ المجمكعات 

= F:  المحسكبة كفؽ القانكف التاليFإيجاد قيمة : سابعا
متكسطالمجمكعات المربعات بيف المجمكعات

متكسط المربعات داخؿ 
 

F =𝟗.𝟒𝟒

𝟓.𝟐𝟒
 = 1.80 

درجة عند ، 2 =1-3 =1 -(عدد المجمكعات) =Kالبسط  (df) درجة الحرية الجدكلية عند Fيجب إيجاد 
 F ، إذا فإف3.55كنجدىا تساكم . 0.05كمستكل الدلالة N –K = 21- 3 = 18 المقام  (df) الحرية

 فإننا نتقبؿ الفرض الصفرم كنرفض البديؿ 3.55  كىي أقؿ مف القيمة الجدكلية 1.80 المحسكبة تساكم
 .كنقكؿ أنو لا تكجد فركؽ أداء المكظفيف تعزل لمخبرة المينية

 :Spss باستخدام Anova تحميل التباين الأحادي Fحساب اختبار - 3
 : نتبع الخطكات التاليةAnova تحميؿ التبايف الأحادم Fلحساب اختبار 

Analyze → Compare Means →One-Way ANOVA 

 



 

 Dependent List  نقكـ بنقؿ المتغير المراد دراستو إلى خانة:فيظير لنا المربع الحكارم التالي
المجمكعات المراد دراسة  Factorكليكف مثلا المكاطنة التنظيمية كنضع في خانة 

 . ، في مثالنا ىذا ىي الخبرة المينية(3أكثر مف )الفركؽ بينيـ 

 
 

 مف أجؿ بعض  Descriptive يظير مربع حكارم نختار منو Optionsثـ مف خلاؿ أيقكنة 
 OK  ثـ  Continueالمعمكمات الإحصائية ثـ  

 
 Outputفتظير لنا عدة جداكؿ في صفحة 



 

-  المتكسط الحسابي- عدد العينة :  ىك الجدكؿ الكصفي للاختبار يحتكم عمى:الجدول الأول
 .الانحراؼ المعيارم، لكؿ مجمكعة عمى حدل كلكؿ العينة 

 
 :يحتكم عمى عدة قيـ أىميا: الجدول الثاني

 Meam Difference = 0.22كىذا يمثؿ الفرؽ بيف المتكسطيف  
 F = 0.46تمثؿ قية اختبار التحميؿ التبايف  
 Sig = 0.62 فإننا نقبؿ الفرض الصفرم كنرفض ، 0.05 تمثؿ قيمة مستكل الدلالة كىي أكبر مف

 .البديؿ كنقكؿ أنو لا تكجد فركؽ في المكاطنة التنظيمية تعزل لمخبرة المينية لدل أفراد عينة الدراسة

 
  أنواع2وتحتوي بدورىا عمى : الحالة الثاني عشر

 متغير مستقل مكون من مجموعات + متغير نوعي + فروق  
 (دراسة الفركؽ في المتغير نكعي بناءا عمى عدة متكسطات)

 (X² )(²كا)كاف تربيع في ىذه الحالة نستخدم اختبار 
كىي مجمكعة مف معاملات الفركؽ التي نمجأ إلييا في حالة عدـ تتحقؽ شركط الإحصاء البرامترم كدكرىا 

 .دراسة الفركؽ بيف المجمكعات لمتغيرات الدراسة 



 

 كىك يعد مف أىـ اختبارات الدلالة (X² )(²كا)كمف أشير ىذه الاختبارات  نجد اختبار كاؼ تربيع 
الإحصائية كأكثرىا شيكعا لأنيا لا تعتمد عمى شكؿ التكزيع، كلذا فيي تعد مف المقاييس اللابرامترية أم 

 إلى البحث الذم نشره كارؿ بيرسكف في أكائؿ ²مقاييس التكزيعات الحرة، كترجع النشأة الأكلى لاختبار كا
 ة كالرتبيالاسمية التي تستخدـ في تحميؿ البيانات اللابرامترية حيث يعتبر مف الاختبارات .القرف العشريف

 التي تككف عمى شكؿ تكرارات النكعية البيانات ة مقياس رتبي كيصمح لمعالجأك م بمقياس اسـالمصنفة
 (271،ص،2007القصاص،) .ة معيفأصناؼ أكبمجمكعات 

 : شروطو
 تربيع دائما تككف مكجبو  ؼقيمو كا 
 كسكرا أك مئكية تككف البيانات عمى شكؿ تكرارات كليس نسبا أف 
 ا تكرار20 عف الفعمية يقؿ مجمكع التكرارات ألا 
 عف خمس تكرارات فئة في كؿ المتكقعة يقؿ مجمكع التكرارات ألا  

 : كىي²كالدينا عدة أنكاع مف اختبار 
 النوع الأول: الحالة الثاني عشر

 : (حسن المطابقة) لعينة واحدة ²كا-1
الفروق بين التكرارات المتوقعة والحقيقية لدراسة : (حسن المطابقة) لعينة واحدة ²كاعن فرضية : 1مثال

 :لنفس أفراد العينة

                 
في ىذا المثاؿ نجد نفس الطالب أم أفراد العينة لكف بتفرعيف في الإجابة عف سؤالو ىؿ أنت سعيد أك غير 
سعيد، كيتـ مقارنة التكرارات المتكقعة كىي ما نتكقعو مف رأم الطمبة حكؿ ىؿ ىـ سعداء أك لا في الجامعة 
مع التكرارات الحقيقة كىي إجابات الطمبة الحقيقية حكؿ المكضكع كنجد ىؿ ىناؾ فركؽ بيف ىذه التكرارات 

 .أك لا
الفروق بين التكرارات المتوقعة والحقيقية لدراسة : (حسن المطابقة) لعينة واحدة ²كاعن فرضية : 2مثال

 :لنفس أفراد العينة

 



 

في ىذا المثاؿ نجد نفس أفراد العينة لكف بتفرعيف في الإجابة أم استجابتيف عف سؤاليـ حكؿ رأييـ في 
، كيتـ مقارنة ىذه الاستجابات بما كنا نتكقعو حكؿ الحجر الصحي،  (مكافؽ ، غير مكافؽ)الحجر الصحي 

 .كنجد ىؿ ىناؾ فركؽ بيف ىذه التكرارات أك لا
يتـ فيو اختبار مدل تطابؽ التكرارات الحقيقية مع التكرارات المتكقعة لنفس أفراد العينة، أم كجكد متغير 

 :كاحد نكعي يحمؿ تفرعيف كيحسب بالمعادلة التالية

 
  (بالعربية) ²كا: x2 :     حيث 

             fo (القيـ الفعمية )التكرارات المشاىدة 

             fe التكرارات المتكقعة( 
 المجمكع الكمي
عدد البدائؿ

 (193،ص،2011بوحفض،) ( 

 : يدويا(حسن المطابقة)لعينة واحدة  (X² )(²كا)اختبار كاؼ تربيع حساب - 2
 :مثال تطبيقي

 :تحصمنا عمى النتائج التالية (مكافؽ، غير مكافؽ)في دراسة لسبر آراء المكاطنيف حكؿ الحجر الصحي 
 المجموع غير موافق موافق رأي المواطنين
 150 56 94 التكرارات

  ىؿ تكجد فركؽ ذات دلالة إحصائية بيف المكافقيف عف الحجر الصحي كالغير مكافقيف؟:المطموب
 :الحل
 إيجاد التكرارات المتكقعة : أولا

fe  ) التكرارات المتكقعة  
 المجمكع الكمي
عدد البدائؿ

 ) = 75 =
150

2
 

التكرارات  رأم المكاطنيف
foالمشاىدة     

التكرارات 
 المتكقعة

fe    

fe  - fo     
 

 94 مكافؽ
 

19 361 4.81 
 4.81 361   19-   56 غير كافؽ

∑ 150    9.62 
 :بالمعادلة التالية (حسف المطابقة) لعينة كاحدة ²كاحساب : ثانيا



 

 
 .مف أجؿ التأكد مف الدلالة الإحصائية:  الجدكلية²كا  إيجاد قيمة:ثالثا

  0.05لدينا مستكل الدلالة 
 1=1-2=1-(عدد البدائؿ) = dfكلدينا درجة الحرية  

، كبالتالي 9.62 المحسكبة التي تساكم ²كاكىي أقؿ مف قيمة  3.84 الجدكلية تساكم ²كاكمنو فإف قيمة 
فإننا نرفض الفرض الصفرم كنقبؿ البديؿ أم نؤكد كجكد فركؽ ذات  دلالة إحصائية بيف المكافقيف كالغير 

 .مكافقيف لمحجر الصحي
 :Spss باستخدام (حسن المطابقة)لعينة واحدة  (X² )(²كا) اختبار كاف تربيعحساب - 3

 :لدينا البيانات التالية

 المجموع غير موافق موافق رأي المواطنين
 150 56 94 التكرارات

 نقكـ بإدخاؿ البيانات لمبرنامج بيذا الشكؿ: أكلا 

 

   

المتغير الثاني في الصفحة عبارة عف تكرارات حتى يتعامؿ البرنامج نقكـ بتعريؼ البرنامج : ثانيا
 :مع ذلؾ بالخطكات التالية

Data → Weight Cases 

 



 

 

، كنقكـ أيضا بنقؿ by  Weight Casesخبًخفيظير مربع حكارم نقكـ فيو بالضغط عمى 
 Ok، ثـ  Frequency Variableلخانة  (التكرارات)

 
 :كالتالي (حسف المطابقة) لمجمكعة كاحدة ²كاثانيا نقكـ بحساب 

Analyze → Nonparametric Tests → Legacy Dialogs → Chi-square 



 

 

 Test Variableإلى خانة  (الرأم)فيظير لنا مربع حكارم نقكـ مف خلالو بنقؿ المتغير المراد دراستو 
List ثـ ، Ok 

 

 



 

 Output لنا عدة جداكؿ في صفحة فزظِش
  كفيو التكرارات لممعطيات الأكلية كالتكرارات المتكقعة:الجدول الأول

 

 كيحتكم عمى: الجدول الثاني
Chi-square :  9.62 كقيمتيا تساكم ²كاكىي 

Sig=  0.02 كبالتالي فيي دالة 0.05 كىي قيمة الدلالة الإحصائية كىي أقؿ مف مستكل الدلالة 
إذا فإننا نرفض الفرض الصفرم كنقبؿ البديؿ أم نؤكد كجكد علاقة ارتباطية ذات دلالة إحصائية إحصائيا، 

 .بيف المكافقيف كالغير مكافقيف لمحجر الصحي

 

 النوع الثاني: الحالة الثاني عشر
 : (للاستقلالية) لدلالة الفروق لعينتين مستقمتين أو أكثر²كا -1

 : لدلالة الفروق لعينتين مستقمتين أو أكثر²كاعن فرضية : 1مثال

 
في ىذا المثاؿ نجد مجمكعتيف ىما الذككر كالإناث نريد معرفة ىؿ ىناؾ فرؽ بيف رأييما حكؿ الحجر 

، كىما عينتيف مستقمتيف كذلؾ مف مقارنة التكرار المشاىد مع التكرار (مكافؽ، محايد، معارض)الصحي 
 .المتكقع 



 

يسمى اختبار الاستقلالية، يطبؽ عندما يدرس الباحث متغيريف نكعييف، كيككف مستكل القياس الاسمي أك 
الرتبي، يمكنو التعرؼ مدل استقلالية المتغيريف عف بعضيما البعض، أم معرفة إذا كاف المتغير الأكؿ 

 :يؤثر في المتغير الثاني كيحسب بالمعادلة التالية

 
  (بالعربية) ²كا: x2 :     حيث 

             fo (القيـ الفعمية )التكرارات المشاىدة 

              fe التكرارات المتكقعة( 
 مجمكع صؼ الخانة×مجمكع عمكد الخانة

المجمكع  الكمي لمعينة
 ) 

DF= درجة الحرية  = (1 − (عدد الأعمدة × (1  (197،ص،2011بوحفص،) (عدد الصفكؼ−
 : شروطو
  1أف لا يقؿ أم تكرار متكقع عف  
  مف مجكع %5 نسبة 5لا يجب أف يتعدل عدد الخانات التي يككف تكرارىا المتكقع أقؿ مف 

 .التكرارات
" ، فيجب استخدام معادلة التصحيح 5 منيا أقل من 20 خانة وكان تكرار 100إذا كان لدينا : ملاحظة

=: وىي " ياتس  
  𝒇𝒐  −𝒇𝒆 −𝟎.𝟓  𝟐

𝒇𝒆   
 𝑿∗𝟐 

 : يدويا لدلالة الفروق لعينتين مستقمتين أو أكثر²كاحساب - 2
 ( لدلالة الفروق لعينتين مستقمتين²كاحساب ): 01مثال تطبيقي 

 تعزل لمجنس (مكافؽ، محايد، غير مكافؽ)أراد باحث معرفة ىؿ تكجد فركؽ حكؿ الحجر الصحي 
مكافؽ، محايد، )فركؽ ذات دلالة إحصائية في الرأم حكؿ الحجر  لمعرفة ىؿ تكجد ²كا حساب :المطموب

 ؟(ذكر، أنثى)تعزل لمجنس  (غير مكافؽ
 :الحل

 



 

fe إيجاد القيـ المتكقعة :أولا   fo  مف خلاؿ القيـ المشاىدة  

          fe التكرارات المتكقعة  =( 
 مجمكع صؼ الخانة×مجمكع عمكد الخانة

المجمكع الكمي
 )  

  𝟑𝟑 × 𝟐𝟒:  قيمتيا المتكقعة ىي 16 القيمة المشاىدة الأكلى ىي :مثال

𝟓𝟎
بيذه الطريقة ......15.84 = 

 .نكمؿ باقي الجدكؿ
 fe fo - fe ²(fo - fe)القيـ المتكقعة  foالقيـ المشاىدة 

 
16 0.002 0.002 0.002 0.002 
5 1.08 1.08 1.08 1.08 
12 0.82 0.82 0.82 0.82 
8 0.00 0.00 0.00 0.00 
7 2.09 2.09 2.09 2.09 
2 1.60 1.60 1.60 1.60 

∑ 5.60 
 : بتطبيؽ القانكف كتعكيض القيـ المكجكدة في الجدكؿ ²كا حساب اختبار :ثانيا

 : حيث لدينا 

 
 .مف أجؿ التأكد مف الدلالة الإحصائية:  الجدكلية²كا  إيجاد قيمة:ثالثا

  0.05لدينا مستكل الدلالة 
1 كلدينا درجة الحرية  − 3 ×  1 − 2 = 𝟐  =DF = (1 − (عدد الأعمدة × (1  (عدد الصفكؼ−

، كبالتالي 5.60 المحسكبة التي تساكم ²كاكىي أكبر مف قيمة  5.99 الجدكلية تساكم ²كاكمنو فإف قيمة 
فإننا نقبؿ الفرض الصفرم كنرفض الفرض البديؿ أم نؤكد عدـ كجكد فركؽ ذات  دلالة إحصائية في الرأم 

 .حكؿ الحجر الصحي تعزل لمجنس
 ( لدلالة الفروق لأكثر من عينتين²كاحساب ): 2مثال تطبيقي 

تعزل لمحالة  (راض، محايد، غير راض)أراد باحث معرفة ىؿ تكجد فركؽ حكؿ مستكل الأداء الميني 
 .(متكسط، ثانكم، جامعي)المستكل التعميمي 



 

راض، محايد، )مستكل الأداء الميني فركؽ ذات دلالة إحصائية في  لمعرفة ىؿ تكجد ²كا حساب :المطموب
  ؟(متكسط، ثانكم، جامعي)تعزل لمحالة المستكل التعميمي  (غير راض

 :الحل

 
fe إيجاد القيـ المتكقعة :أولا  fo  مف خلاؿ القيـ المشاىدة  

          fe التكرارات المتكقعة  =( 
 مجمكع صؼ الخانة×مجمكع عمكد الخانة

المجمكع الكمي
 )  

 𝟑𝟎 × 𝟓𝟎:  قيمتيا المتكقعة ىي 15 القيمة المشاىدة الأكلى ىي :مثال

𝟏𝟐𝟎
بيذه الطريقة نكمؿ ......12.5 = 

 .باقي الجدكؿ
 fe fo - fe ²(fo - fe)القيـ المتكقعة  foالقيـ المشاىدة 

 
15 12.5 2.5 6.25 0.5 

25 25 0 0 0 

10 12.5 - 2.5 6.25 0.5 

10 11.25 - 1.25 1.56 0.13 

20 22.5 - 2.5 6.25 0.27 

15 11.25 3.75 14.06 1.24 

5 6.25 - 1.25 1.56 0.24 

15 12.5 2.5 6.25 0.5 

2 6.25 - 1.25 1.56 0.24 
∑ 3.62 

 : بتطبيؽ القانكف كتعكيض القيـ المكجكدة في الجدكؿ ²كا حساب اختبار :ثانيا
 : حيث لدينا 

 
 .مف أجؿ التأكد مف الدلالة الإحصائية:  الجدكلية²كا  إيجاد قيمة:ثالثا

  0.05لدينا مستكل الدلالة 



 

1 كلدينا درجة الحرية  − 3 ×  1 − 3 = 𝟒  =DF = (1 − (عدد الأعمدة × (1  (عدد الصفكؼ−
، كبالتالي 3.62 المحسكبة التي تساكم ²كاكىي أكبر مف قيمة  9.48 الجدكلية تساكم ²كاكمنو فإف قيمة 

فإننا نقبؿ الفرض الصفرم كنرفض الفرض البديؿ أم نؤكد عدـ كجكد فركؽ ذات  دلالة إحصائية في 
 . عف العمؿ تعكد لمستكل التعميـمستكل الأداء

 :Spss باستخدام  لدلالة الفروق لعينتين مستقمتين أو أكثر²كاحساب - 3
 ( لدلالة الفروق لعينتين مستقمتين²كاحساب ): 01مثال تطبيقي 

 :لدينا البيانات التالية

 الرأي حول الحجر الصحي
 الجنس

 المجموع غير موافق محايد موافق

 33 12 5 16 ذكر
 17 2 7 8 أنثى

 50 14 12 24 المجمكع
 نقكـ بإدخاؿ البيانات لمبرنامج بيذا الشكؿ: أكلا 

 

 
المتغير الثالث في الصفحة عبارة عف تكرارات حتى يتعامؿ البرنامج مع نقكـ بتعريؼ البرنامج أف : ثانيا

 :ذلؾ بالخطكات التالية
Data → Weight Cases 

 



 

 

 (التكرارات)، كنقكـ أيضا بنقؿ by  Weight Casesخبًخفيظير مربع حكارم نقكـ فيو بالضغط عمى 
 Ok، ثـ  Frequency Variableلخانة 

 
 : كالتالي لدلالة الفروق لعينتين مستقمتين²كاثالثا نقكـ بحساب 

Analyze → Descriptive Statistic → Crosstabs 



 

 

ثـ إدخاؿ متغير  (الأعمدة) Columnفيظير المربع الحكارم التالي نقكـ فيو بإدخاؿ متغير الرأم إلى 
 مثؿ جدكؿ المعطيات  (الصفكؼ) Rowالجنس إلى 

 

 Ok ثـ Continue ثـ Chi-square نقكـ بالتأشير عمى Statisticsكمف خلاؿ 

 



 

 Output لنا عدة جداكؿ في صفحة فزظِش
  كىك يحدد حجـ العينة:الجدول الأول

 

 ىك نفسو الجدكؿ الذم قمنا بإعداده كالمقدـ في المعطيات: الجدول الثاني

 

 كىك الميـ كيحتكم عمى: الجدول الثالث

Chi-square :  5.59 كقيمتيا تساكم ²كاكىي 
Sig=  0.06 كبالتالي فيي غير دالة 0.05 كىي قيمة الدلالة الإحصائية كىي أكبر مف مستكل الدلالة 

إذا فإننا نقبؿ الفرض الصفرم كنرفض البديؿ أم نؤكد عدـ كجكد فركؽ ذات  دلالة إحصائية في إحصائيا، 
 .الرأم حكؿ الحجر الصحي تعزل لمجنس

 
 ( لدلالة الفروق لأكثر من مجموعتين²كاحساب ): 2مثال 

 :لدينا البيانات التالية



 

 الأداء الميني
  المستكل التعميمي

 المجموع غير راض محايد راض

 30 5 10 15 متكسط
 60 15 20 25 ثانكم
 30 5 15 10 جامعي
 120 25 45 50 المجموع

 نقكـ بإدخاؿ البيانات لمبرنامج بيذا الشكؿ: أكلا 

 

  

المتغير الثالث في الصفحة عبارة عف تكرارات حتى يتعامؿ البرنامج مع نقكـ بتعريؼ البرنامج أف : ثانيا
 :ذلؾ بالخطكات التالية

Data → Weight Cases 

 



 

 

 (التكرارات)، كنقكـ أيضا بنقؿ by  Weight Casesخبًخفيظير مربع حكارم نقكـ فيو بالضغط عمى 
 Ok، ثـ  Frequency Variableلخانة 

 
 : كالتالي لدلالة الفركؽ لأكثر مف مجمكعتيف مستقمتيف ²كاثالثا نقكـ بحساب 

Analyze → Descriptive Statistic → Crosstabs 



 

 

ثـ إدخاؿ  (الأعمدة) Columnفيظير المربع الحكارم التالي نقكـ فيو بإدخاؿ متغير الأداء الميني إلى 
 .مثؿ جدكؿ المعطيات  (الصفكؼ) Rowمتغير مستكل التعميـ  إلى 

 

 Ok ثـ Continue ثـ Chi-square نقكـ بالتأشير عمى Statisticsكمف خلاؿ 



 

 

 Output لنا عدة جداكؿ في صفحة فزظِش
  كىك يحدد حجـ العينة:الجدول الأول

 

 ىك نفسو الجدكؿ الذم قمنا بإعداده كالمقدـ في المعطيات: الجدول الثاني

 

 كىك الميـ كيحتكم عمى: الجدول الثالث
Chi-square :  3.66 كقيمتيا تساكم ²كاكىي 



 

Sig=  0.45 كبالتالي فيي غير دالة 0.05 كىي قيمة الدلالة الإحصائية كىي أكبر مف مستكل الدلالة 
إذا فإننا نقبؿ الفرض الصفرم كنرفض البديؿ أم نؤكد عدـ كجكد فركؽ ذات  دلالة إحصائية في إحصائيا، 

 .أم ىناؾ استقلالية بيف المجمكعات . الأداء  تعزل لمستكل التعميـ

 
 : الحالة الثالثة عشر

المتغير  + مستوى  
 (دراسة مستكل كجكد المتغير في عينة الدراسة)

لنرى لأي مجال ينتمي المتوسط في ىذه الحالة نحسب المتوسط الحسابي ونحدد المجلات 
الحسابي، مع مقارنو بالمتوسط النظري وحساب ىل توجد فروق بينيما باستخدام اختبار ت 

لعينة واحدة 
:  اختبار المستوى- 1

  عن فرضية المستوى: مثال

 

نلاحظ مف خلاؿ ىذه الفرضية أنيا فرضية لدراسة مستكل تكاجد المتغير في عينة الدراسة، كلحساب ذلؾ 
: يجب اتباع الخطكات التالية

تحديد المجالات - أ
 حساب المتكسط الفرضي- ب
 حساب المتكسط الحسابي- ت
 (الفرضي)مقارنة المتكسط الحسابي مع المتكسط النظرم - ث



 

 
 :تحديد المجالات- أ

 ( أي ثلاثة بدائل للإجابة فً الاستبٌان)...دائما– أحيانا - نادرا - :لدٌنا ثلاثة بدائل للإجابة وهً :مثلا

:  وعلٌه تكون المجالات كالتالً

 

 هو طول المجال 0.66 لدٌنا إذا

:  كالآت1.2.3ً لعلامات المجالات  0.66 نقوم بتحدٌد طول المجالات بإضافة طول المجال

   المنخفضأو الأدنىوهو المجال :  الأول المجال 

 بدرجة منخفضة   ]1.66 ، 1] = ] 1+0.66 ، 1]

وهو المجال المتوسط : المجال الثانً

 بدرجة متوسطة   ]2.32 ، 1.66] = ] 0.66 +1.66 ، 1.66]

 المرتفع أو الأعلىوهو المجال : المجال الثالث

 بدرجة مرتفعة ]3 ، 2.32 ] =  ]2.32+0.66 ، 2.32]

 (كمثال)عبارة 29لدٌنا عدد العبارات فً استبٌان المواطنة التنظٌمٌة هً 

  فنجد مجالات الدراسةنضرب عدد العبارات فً طرفً المجالات السابقة

 

 :حساب المتوسط الفرضي- ب
 : وإذا اعتمدنا على التنقٌط التال3ًبدائل الإجابة هً 

 ولدٌنا عدد العبارات فً مثالنا هذا 2متوسط الإجابات ٌكون   فإن 3=  ، دائما 2=  ، أحٌانا 1= نادرا 

 58  =2 × 29هو  (الفرضً)إذا المتوسط النظري       29هً 

 :حساب المتوسط الحسابي- ت

= x : نحسب المتوسط الحسابً وفقا للمعادلة التالٌة  
Ʃ 𝑥𝑖

n
 (تم حسابه ٌدوٌا فٌما سبق)    



 

 ( فٌما سبقSpssتم حسابه بـ ) spssالمتوسط الحسابً لمتغٌر المواطنة التنظٌمٌة  بواسطة   نحسبأو

 𝒙  =61.02لنفترض كمثال أننا وجدنا المتوسط الحسابً 

الجدول  ٌوضح المتوسط الحسابً  

 𝐗المتوسط الحسابً  Nعدد العٌنة  
 61.02 30 المواطنة التنظٌمٌة

ننظر لأم مجاؿ ينتمي المتكسط  (كمثاؿ فقط) 61.02مف خلاؿ الجدكؿ نجد أف المتكسط الحسابي بمغ 
 أم بدرجة مرتفعة كىك ما يؤكد  بأف مستكل المكاطنة ] 87 ، 60.32 ] يقع في المجاؿ ، فنجدهالحسابي
 لدل العماؿ مرتفعة التنظيمية

 (الفرضي)مقارنة المتوسط الحسابي مع المتوسط النظري - ث
، (29عدد العبارات في استبياف المكاطنة ×2العلامة المتكسطة ) 58إذا كاف متكسط الإجابات النظرم ىك 

 فإننا نقارف المتكسط الحسابي لإجابات المفحكصيف في مستكل المكاطنة 61.02كالمتكسط الحسابي ىك 
حكؿ مستكل كجية نظرىـ ىؿ تكجد فركؽ في لمعرفة  (النظرم)مع المتكسط ، التنظيمية لدل العماؿ

 لعينة T.testكانت مرتفعة أك متكسطة أك منخفضة كذلؾ باستخداـ اختبار ت المكاطنة التنظيمية كىؿ 
 .كاحدة لمقارنة متغير كمي بمتكسط المجتمع المفحكص

 لعٌنة واحدة للمقارنة مع المتوسط النظري T.testالجدول ٌوضح نتائج اختبار ت 

 58= المتوسط النظري  
المتوسط  T المواطنة التنظٌمٌة

 الحسابً
Df Sig ًالفرق فً المتوسط الحساب 

4.84 61.02 28 0.00 3.02 

  فٌما سبقSpssيدويا وباستخدام  لعينة واحدة T.testختبار ت اتم حساب : ملاحظة

 كأف الفرؽ بيف المتكسط النظرم كالمتكسط المحسكب ىك t  =4.84نلاحظ مف خلاؿ الجدكؿ أف قيمة  

كمستكل مرتفع  فركؽ بيف المتكسطيف  مما يدؿ عمى كجكدsig = 0.00 لصالح المحسكب كقيمة 03.02

 كىذا ما ستبينو كقكع قيمة المتكسط 03.02 أكبر مف المتكسط النظرم ب  لأنيافي المكاطنة التنظيمية،

 61.02الحسابي في أحدل المجالات التي تـ تحديدىا، حيث نجد أف المتكسط الحسابي المحسكب بمغ 

كىك ما يؤكد عدـ تحقؽ الفرضية التي تقكؿ بأف .  أم بدرجة مرتفعة] 87 ، 60.32 ]كىك يقع في المجاؿ 

.  البمدية منخفضةمستكل المكاطنة التنظيمية لدل العماؿ
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